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FL0-2D Model Training Class 
Presented to Flood Control District of Maricopa County 

Phoenix, Arizona 

Dates: June 27-28, 2013 

Location: Maricopa County Public Work Operations Building Computer 
Training Room 
2919 W Durango St, Phoenix Arizona 85009 
(South side of MCDOT Traffic Operation Building; see attached map) 

Instructors: Jimmy O'Brien, Ph.D., P.E. 
Karen O'Brien, Technical Support and Instructor 

WHO SHOULD ATTEND: This training class is designed for new FL0-2D users (hydraulic and hydrologic 
engineers and floodplain managers) and previous users who need a refresher class. The free FL0-2D Basic 

model available at the website will be used in this training. 

8:00-8:15 

8:15-9:00 

9:00-10:00 

10:00 -10:15 

10:15-11:00 

11:00-12:00 

Primarily 'hands-on' computer session times are highlighted in blue. 

Thursday June 27, 2013 
Getting Started 

Check-in, introductions and review agenda. 

Overview of the FL0-2D Modeling system and Porting Data Files. 

Grid Developer System - Getting Started 

Break 

Hands-on session 1: Lesson I . Using the GDS to import and edit terrain 
elevation data, filter elevation point data, establish a grid system, work with 
aerial images, setup hydrographs and run the FL0-2D model. 

Discussion of model theory, routing algorithms and stability criteria. 

12:00 - 13:00 Lunch 

13:00-13:30 Review FL0-2D *.DAT and *.OUT files. Introduction to floodplain attributes. 

13:30-14:15 Hands-on session 2: Lesson 2. Floodplain attributes. Edit model components and 
layer attributes using shape files . 

14:15-15:00 Hydrology: rainfall and inflow hydrographs. Using Green Ampt and SCS-CN 
infiltration. 

15:00-15:15 Break 

15:15-15:45 Hands-on session 3. Rainfall Lesson 7. Enter and edit rainfall data. (Demo) 

15:45- 16:15 Introduction to Urban modeling. 

16:15-17:00 Hands-on session 4: Lesson 11. Urbanized floodplain details. Set up streets and 
buildings. 



Friday, June 28, 2013 
Channel Flood Routing, Mapping and Troubleshooting 

8:00-8:20 Channel flood routing overview. Channel/floodplain flow exchange. 

8:20 - 8:45 Overview ofGDS river channel tools. Introduction to Lessons 3, 5 and 8. 

8:45- 9:30 Hands-on session 5: Lessons 3, 4 and 5. Using GDS to create a simple 
rectangular channel. Interpolating the channel cross sections and slope and 
editing the bank elements in PROFILES 

9:30- 10:30 Channel routing problems: What to look for? NOFLOCs, channel profiles, n
values, surging. 

10:30 - 10:45 Break 

10:45- 11:30 Hands-on session 6: Lesson 8. Import a HEC-RAS project and create a natural 
channel in the GDS 

11:30-12:00 Using hydraulic structures in the urban environment: weirs, bridges and culverts 
for rivers and floodplains 

12:00 - 13:00 Lunch 

13:00-13:30 Mapper overview. Creating high resolution flood delineation maps. 

13:30-14:15 Hands-on session 7: Mapper (Demo Session) Display flow depths, velocities, 
and water surface elevation maps. Create shaded contour maps and import 
aerial photos. 

14:15- 14:30 Troubleshooting overview, tools and methods for finding data errors. 

14:30 - 15:00 Hands-on session 8: Troubleshoot a project. 

15:00 - 15:15 Break 

15:15- 16:00 Optimization: Is the flood simulation running ok? Solving common problems: 
Volume conservation, numerical surging, sticky grid elements, and limiting 
Froude numbers. 

16:00 - 17:00 Hands-on session 9: Create a project from scratch. 
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8:15-9:00 Overview of the FL0-2D Modeling system and Porting Data Files . 
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11:00- 12:00 Discussion of routing algorithms and stability criteria . 
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Channel routing problems: What to look for? NOFLOCs, channel profiles, n
values, surging. 

Break 
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Lunch 

Mapper overview. Creating high resolution flood delineation maps. 

Hands-on session 7: Mapper (Demo Session) Display flow depths, velocities, 
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Troubleshooting overview, tools and methods for finding data errors. 
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Break 

Optimization: Is the flood simulation running ok? Solving common problems: 
Volume conservation, numerical surging, sticky grid elements, and limiting 
Froude numbers. 

Hands-on session 9: Create a project from scratch. 
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INTRODUCTION 

FL0-2D Model Lessons 

This document is organized as step-by-step instructions to create and run 
a detailed FL0-2D flood routing simulation. The lessons will guide the 
user through building a spatially variable model with infiltration, channel, 
levee, building and street components. The objective is to apply the Grid 
Developer System (GDS) to create a simple overland flow model that 
will be expanded with more channel and floodplain details. A compre
hensive lesson on reviewing FL0-2D output data and creating flood maps 
using the MAPPER program completes the lessons . 

Use this Workshop lesson book to compliment the FL0-2D, GDS and 
MAPPER manuals and other supporting documentation. There are re
view questions at the end of each individual lesson. Many of the ques
tions reflect those technical support questions that FL0-2D users fre
quently pose. It is our intent to make the FL0-2D modeling system as 
user friendly as possible . 
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LESSON 1 - GDS GETTING STARTED 

Overview 

Required Data 

File Content 

This lesson will shows the steps of generating a basic overland flood 
simulation with the FL0-2D model using the Grid Developer System 
(GDS) pre-processor program. Learn how to create the grid system, im
port and interpolate terrain elevations, assign inflow and outflow ele
ments, import aerial photos as background and start a flood simulation . 

The lesson makes use of terrain elevation data, an inflow hydrograph, and 
aerial photograph provided in the installation folders . 

Location* 
dtm.pts Digital Terrain Model file 

Example Projects\Lesson I 
c136.out HEC-l hydrograph 
Goat.tif Aerial photographs 

*Typically these folders are in installed under C: I Users \Public \Documents IFL0-2D Basic Documentation 

Check these folders to ensure the data is available before starting the les
son . 
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Step-by-Step Procedure 

To run a FL0-20 flood simulation using these steps. 

• Open the Grid Developer System (GDS) program; 
• Import terrain elevation data; 
• Create the Grid; 
• Import aerial images; 
• Outline the project area boundaries "computational domain"; 
• Interpolate the digital terrain elevation data and assign the grid 

element elevations; 
• Assign hydrographs to selected inflow element; 
• Select outflow grid elements; 
• Run the FL0-2D model. 

Step 1: Open the Grid Developer System program 

41!1<>01 
Double click the GDS Basic icon from the desktop . ........,.,.__, 

Step 2: Import terrain elevation data 
The elevation data is typically in an text format where the elevation 
points are given as a table of space or comma separated x y z data. 

64I3334.59 1936112.79 81.81 
6413388.62 1936112.00 81.57 
6413500.78 1936108.47 81.29 
6413664.70 1936102.41 80.95 
6413784.88 1936094.97 80.75 

The first two columns are the x- andy- coordinates and the third column 
is elevation (ft or m). Other data formats are also supported (see the GDS 
Manual). 
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To import the file, click New Project/from DTM Elevation Points on the 
File menu . 

Open . TOP Protect ... 
Open Existing R.Q-.20 Project ... 

Save .TOP Project .. . 

Save FL0-20 Files .. . 
Run Fl0 ·20 ... 
Run Mapper 

Run PROFILES 

Roo RAIN 

Create FPiatn.Dat and CadPTS.OA T 

[mport ImtJoe 

Import Elevation Pants 
Import Shope File ... 
Import Rain Arclnfo ASCII Grid File ... 
Import t£C-RAS Channels .. . 

Import CAD GrapticEiemerts ... 

Save Elevation Ponts .. . 

Export ... 

Ext 

Demo Worl<klg R09ion ... 

from Exlstho ASCII Grid File .. . 
from Existno Shopefte 
from Fl0-20Pro)ect . . . 
hom Exist:i'lg CAD Ftle .. . 
from E>:istng HEC-RAS File ... 

The GDS searches for a default file type with *.pts extension. Select the 
file dtm.pts and click OK. Choose the English system of units and click 
OK. 

NOTE: ADTM pdn~fi le mu~h~ea 
*.pts fi le extension and an ASC II grid 
data file must have a *.ASC exten
sion. 

Lower lefl corner 

X: l36l:J98.37 

Y· l11 83603.3 

Uni • 

r (rlemalional (rl'b) 

ll.K 

X j3702947B 

y 11186511 .5 

!;oncel 

A dialog box of the number of points will appear. Click OK and the ele
vation data will be displayed with the view automatically zoomed to the 
full extent of the coordinates . 
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Step 3: Assign the grid element size and create the grid system 

RECOMMENDATION : The peak dis
charge divided by the surface area of 
1 grid element should be less than 3 
cfs/sq. ft. or 1 ems/sq. m. 

Opeak/Asurf < 3 cfs/sq. ft. 

To create a new FL0-20 grid system, click the Create Grid command on 
the Grid menu. 

Select 
AsSV'I Vak.Jes to Seled1011 

Interpolate Elevation Pocrt:s 

Green-~ 

Compute ~m!rlQ CoeffiCcents , .. 

Comr.ute SCS Curve Nunber 

Oef~ne BOll'ldacy Gnd Elements • 

Select Computational Doma~n 

Create Gnd Layer 

Input a grid element size (square grid) for the project and click OK. 

Gnd Elemerl Size Jleet) ~ 

QK £once! 

The grid element size should reflect the topographic data resolution and 
result in an acceptable number of total grid elements. A small grid ele
ment size enhances the FL0-20 model resolution but also increases the 
computer runtime and memory requirements. A balance should be sought 
between the grid element size (number of grid elements), resolution of the 
desired FL0-20 results and the computer runtime. 

Assign a Grid Position and click OK. 

SUGGESTION: Assign the upper left 
hand corner grid element coordinates 
as an even number (e.g. round to the 
nearest hundred). 

6 I Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

FL0-2D Model Lessons 

Step 4: Importing aerial images 

Importing background images will help to visualize the computational 
domain and project area with respect to the grid system. To import a 
background aerial photo use Import lmagellndividuallmage ... in the File 
menu . 

New Project 

Open . TOP Project. •• 
Open Exlstl'lQ FLo-20 Project .. . 

Save , TOP Project ... 

Save R.o-20 Ales . .. 

Run Fl0.20 •.. 
Run Mapper 

Run PROFILES 

Run RAIN 

Create FPil!fn.D& and C~PTS.DAT 

1rr1>ort Elevation Poi1ts ., Gr oup rJ Images . . . 

l fTClOrt Shape File.,, J 
•· --ne""t R~n Jlrclrlo ASCfl Gnd Fta.-. , , 

The image for this example project is located in the subdirectory Example 
Projects\Lesson 1. Images can be selected one by one or several at a time 
using the Shift-click or Ctrl-click on the files . 

Look in: I w Les.on 1 

jGoal ti ::::J I Open 

rlst-~-.-,d~~-ge-lo-,m-als---------3~• --~~el I 
r Open .,,ead·only 
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The following figure displays the Goat example project with background 
aerial photos and the elevations points. 

Step 5: Outline the project area boundaries 
The computational domain can be defined by marking or highlighting the 
boundary grid elements. The grid boundary is defmed by clicking Define 
Modeling Boundary with Polygon option of the Set-up Computational 
Domain in the Grid menu. 

Create Gt1d 

Select 

Assion P«ameters to ~ion 

Interpo~te Elevation Points 

Compote Green·Ampt Parameters • 

COOYtJUte Manning Coefficients .. . 

Compote SCS Cli'Ve Number 

Define Bollndaty Grid Elements 

Create Grid Layer 

Clcklnside MJdeli"lg Area 

Click OK on the dialog box that appears instructing the user to draw the 
boundary polygon. 

ll U 10 L11d Ueveloper System 

l. l 
(" Click OK and then draw a polygon to define compt.tational domain 

Je-gr--1 Cancel 

Draw a polygon by clicking on each polygon vertex along the desired 
boundary. The polygon is completed by double clicking on the last ver
tex. The system displays the message. 
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NOTE: The boundary elements dis
played in red are not part of the FL0-
20 computational domain and 
should not be assigned any inflow or 
outflow conditions or component at
tributes . 

FL0-2D Model Lessons 

I LU-lO Lud Developer Syst~l 

i,) Do you want this polygon to be the computabonal dom8n? 

Yes No 

A No response will erase the polygon while a Yes response will proceed 
with creating the computational domain. A dialog box will appear so that 
the grid system numbering scheme can be selected . 

Grid element numberi-lg s:~ence 

I C. 18oltom to top. left to rJS.t'i( I 
C' Left lo ri;tll. lop lo bollom 

r Lett to riJlt. bottom to top 

C' Top lobotiom.leftlo~ 

QK 

The numbering sequence can help in locating grid elements later. It is 
suggested to have the number sequence increase in the flow direction. A 
recommended numbering scheme is left to right, top to bottom if the 
drainage system runs from north to south or from top to bottom of the 
screen . 

Click OK to generate the computational domain grid system . 

The FL0-20 grid system now consists of all the grid elements within the 
computational domain . 
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Step 6: Interpolate the digital terrain elevation data & assign grid ele
ment elevations 

A set of DTM points may be randomly distributed in the flow domain and 
some grid elements may have many DTM points or none at all. The FL0-
2D model requires that each grid element be assigned a representative el
evation. 

To interpolate and assign the grid element elevations from the random 
DTM points or contour point elevations, click the Interpolate Elevation 
Points command on the Grid menu. A dialog box will display the eleva
tion interpolation parameters. 

r .rul flt •me nt Elrvdteon InterpoSe 

Mtnimum number of DTM 
points to cons1der il the r;:-----, 

vicinity of each grid elemert: 12 iJ 
Radius ol iierpolation 

(~opa=~~lz~ r--3 

Hi~ elevation filterilg scheme 

(. ~o fil er1ng 

(' ~ij::::~<•vation j5 :.:J ieet 

('" ,S.Iand«d deviation dlference 

Low elevation f~e~ilg scheme 

r. t!o lllenng 

r ~f.=e elevation J5 :.:J feet 

r ~tandard deviahon dfference 

(:' • ~ '• T• 1 • • 

(' 

.QK ~eel 

The user can adjust the interpolation criteria using the Grid Element Ele
vation Interpolation dialog box. Click OK to interpolate the DTM points 
using the default interpolation criteria. 

Using View/Grid Element Elevation Rendering, the interpolated grid ele
ment elevations are shown by color. Red/orange represents the highest 
elevation while blue the lowest elevation in the computational domain. 

Turn off the Elevation Rendering by clicking View/Grid Element Eleva
tion Rendering. Turn off the DTM points by clicking View/Elevation 
Points . 
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Step 7: Assign hydrographs to selected inflow nodes 

Use this command to define inflow and outflow grid elements. Right 
click on the grid element that was chosen to be an inflow node, and select 
the In/Out Condition for Element * * * * from the sub-menu . 

~--------------------------~ 

NOTE: Your element may not be 
#220 . ReserVOOf Water Eleval1on for Element 220 I 

The flowing dialog box allows editing the inflow conditions . 

Ir• Out f•Hulllm•~rorGndEiement 229 

r. [rilow element w~h hydr~et! 

r Outflow element [no jydrog<aph) 

(" Oi.AIIow element with hydogaph [divetSI:)fll 

r QI.AIIov.~ element rrlith stage-time relationship 

r Olitlow element with stage-time and free 
tloodpton and chonnel 

r. Floodpt.;, r J · (' • ·jp . 
n 

( khannel olAIIow elemert (wrth stage-discharge] 

r Ho ilflow/oul:llow cond~ ion 

~""· 
Edi 

YoewG1aph I r- r-
lnilral time Fi1al tine 

Click on both the Inflow element with hydrograph and the Floodplain ra
dio buttons to assign an inflow hydrograph to the selected grid element. 
Then click Read to display the following dialog box to import a hydro
graph with HEC-1, Tape21 , HYD or Text file formats . 

11 I Lesson 1 
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. Select hydiogroph file type 

I F. iliEC·lli~ I 
r !APE21 hie 

r H:l:D file 

<'!\SO! file 

Click the HEC-1 file option and search for the c13 6. OUT file in the Ex
ampleProjects \Lesson 1 folder. Then select 2 STATION C101 hydro
graph from the dropdown list. 

D.K .C•ncel 

After selecting the HEC-1 hydrograph and clicking OK, the hydrograph 
data is loaded into the data table in the dialog box. Click Save to create a 
test.hyd file. These files are text files generated by the GDS to save the 
hydrograph data and allow later recovery of hydrographs when a project 
is read from a *.TOP file. The .hyd file is not used by the FL0-2D mod
el. 

Now click View Graph to plot the hydrograph in the following window. 

500 

400 

300 

zoo 

100 

2 . 5 5 . 0 ? . 5 10.0 1 2.5 15 . 0 1 ? . 5 2 0.0 22.5 

Time 

I! \foew Tim~~ ~ ~ 
IQerv~jJ lnt!al Time Fnal Time 

Inflow grid elements with assigned hydrographs are displayed in a cross
hatched green pattern in the GDS for identification. 
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Step 8: Select outflow grid elements 

NOTE: Avoid doubling up the outflow 
nodes. Outflow nodes require at 
least one upstream grid element to 
compute a normal depth outflow 
condition . 

The FL0-2D grid system represents an impermeable border from which 
no flow will escape. The flow will pond against the boundary unless out
flow nodes are assigned. Outflow elements discharge any flow off the 
grid system without effecting the water surface elevation. The outflow el
ements approximate normal depth flow conditions from upstream ele
ments. To assign the outflow elements, first click the Select Element by 

Element icon -=J in the GDS tool bar, then click on each element (or hold 
the shift key while dragging the mouse to select multiple elements) . 

Now click the Assign Parameters to Selection/Inflow/Outflow Condition 
command in the Grid menu 

Crellte Grid 

Select 

lnter~te Elev~ion Points 

Compute ManOOg CoeffiCients ..• 

Compute scs Cl.l've twmber 

Oeme Boundary Grid Elements 

Set._., Computotioool Atea 

Create Gnd layer 

.I 
Elevl!tions 
Manning Coefficients 

Alt!4 and W1dt:h Reducbon Factors 
l evee 

Mu~leCh<Vlnels 

Infiltration 

• No DlscharQe ExchonQe 
Time-Variant Groundwater Head 
R;;;d Bed Element 
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NOTE: The outflow nodes are flow 
sinks and should be treated as non
essential elements. Do not assign 
any other component to the outflow 
nodes. It is suggested that you sep
arate the project area from the out
flow nodes by several grid elements. 

Select Outflow element/(no hydrograph) and Floodplain radio buttons 
and click OK. 

,,,,,,,w o,,,n .• wcund•t•on ~ 

r !nfbw element with hydrograph 

I r. ,0"'11ow elemenl (no £ydrograph] j 

r O"'llow elemen!wlh hyctogolil (rfrvenionl 

( .QIJ:tlow elemert with stage-time relahoruhtp 

r =:nele;:~.::~age-time cn1 tree 

('" .t;hannel oLiliOIAI element (w1th stage-discharge) 

r t!o i-llow/o<illow condtion 

r 

QK ];once! 

The outflow elements are identified with a blue cross-hatched pattern. 
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Step 9: Save project and run the FL0-20 flood simulation . 

Create a new folder in the Example Projects folder named GDS Test and 
save the FL0-2D data files to it. A void overwriting any of the Example 
Projects files . To Save the FL0-2D flood simulation, use the Run FL0-
2D ... model command in the File menu . 

NOTE: You may get a message indi
cating that the outflow nodes have 
elevation inconsistencies. The mod
el will automatically fix this for you 
during the preliminary data file 
check. 

New Project 

Open . TOP Project . •. 

Open Existing FL0-20 Project ... 

Save .TOP Project ••• 

S.C,ve FLQ-20 r1es .•• 

R"'Mappe< 

RlrlPROFILES 

RmR~lN 

Input the Simulation Time = 24hr, Output Interval 0.25 hr (or 0.10 hrs for 
more output intervals), select the Detailed Graphics option and input Up
date Time Interval = 0.10 hr (or 0.05 hr to view the flood progression 
more frequently) as shown in the following image . 

Time Corirol and Plot Va.iables 

Sim<Jo<ion Time {hrs)· rz;r--
Oltput lnterv~l [hrsl ~ 

GrapAC$ Display. Te!Cl Sq een 
lr. Detaoled Grapl!c!l 

r e r Bad<up Fie A1eaReductionFactor. ro-

SJ"fem Component Swiche< 

r Mail Channel r A.ea Reduction Factor• [ARF) 

r Streets 

I r le-veet 
r Mcliple Channel< 

lA~ ond Gu~e.s l 

PhysiCal Pmcesses Switches: 

r Aairlal 

r lnlitration 

r Evaporation 

r Mud/Debris 

r Sedimert Transport I 
r None 

r MODFL0·2D Modeling 

Convey<Y~Ce Shuch.le Sw~chef-

r HJ'(ieufic StructueJ 

r Floodwoy ~.;. 

r Oebr1s SaUl 

Nt..~T~eucal St~!~y Paramet:ets 

S~ace Oelention· rn;--
Percent Change in Flow Depth ro.r--

r Animote Flow WihU'l GDS 

Floodploi1 D•ploy Options 

Pr"t Oplions· ,..., N-o-Fioo¢--loi1_0_ut_put----,::J 

r Create S1.41ercritical Output Fi~ 

Or 
Checl< "Moil\ Chonnel" to octivote "ChemeiPMt Options" 

Tine L"flSS Outpot 

r Tine Lopoe OutPut Output Interval (hrs) ro-
- Grapt-.cs 01splay 

Select 'Ueloried Gr"'*""" in "Tine Control ond Plot 
V...able."~omo 

l l updaleTrnelnterval[hrs}. ro.;--

Dynom~ W<t<e Stobi~y Coelficienl: r;--

Close 
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Summary 

Now click Run FL02D. Monitor the floodwave progression, the inflow 
hydrograph plot, simulation time, volume conservation, and area of inun
dation. 

.. 

1\-btx tm um 
Flow Depths 

Dopeh Loaend 
2 $..: DE.PTH < l V 
2 U < DE.PTH < 2 ~ 
I S < DEPTH ..: l V 
I t) ... _ DEPTH --:. I :· 
(I ~ < DEPTH .o;; I ., 
TOl. <(,.DEPT H < C' ~ 

DEPTH c TOL 

This is the completion of a basic overland flood simulation using the 
FL0-2D model along with digital terrain elevation data and an inflow 
hydrograph. This lesson has demonstrated how to create the grid system, 
import the DTM data, interpolate the grid element elevations, assign in
flow and outflow elements, and import background aerial images. 

To add more detail and components to the project such as channels, 
streets, levees and buildings, complete the following lessons. 
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Review Questions 

1. What are the five methods to start a FL0-2D project in the GDS? 

I. 

ll . 

lll . 

IV . 

v . 

2. What is the typical DTM data format and what type of file must be used? 

3. What factors should be considered to balance simulation speed with modeling accuracy? 

4. What is the criterion for selection the grid element size? __________ _ 

5. What is the floodplain default n-value? Is this reasonable for most projects? 

6. How is the grid element elevation determined from DTM data? _ ______ _ _ 

7. Is the grid system boundary included in the FL0-2D computation domain? 

8. Which of the following can be share a node with outflow conditions? Check box . 

D Streets D Levees 

0 Buildings 0 Bridges/Culverts 

0 Channels 

9. True or False Double-up the outflow nodes the model will calculate twice the outflow 
discharge? 

I 0. What is the difference between the Outflow Interval and the Update Time Interval on the 
Control Panel? 
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LESSON 2- GDS COMPONENT EDITING 

Part 1. Floodplain Attributes 

Topography and Roughness 

Overview 

Required Data 

Content 
FL0-2D Data Files 

This lesson will use the GDS to graphically edit FL0-2D grid element at
tributes such as n-values and elevations. It will also show how to compute 
n-values attributes by interpolation from shape file . 

The lesson requires the use of FL0-2D data files, n-value shape files and 
aerial photographs provided in the installation folders as follows . 

Location* 
Example Projects\Lesson 2 1 

Goat.tif Aerial photographs Example Projects\Lesson 1 
n value.shp N-value shape file Example Projects\Lesson 2 1 

*Typically these folders are in installed under C: \Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

Graphically edit floodplain attributes for the FL0-20 model using the 
GDS by following these steps . 

• Open the Grid Developer System (GDS) program; 
• Load the Lesson 2 _1 project; 
• Import aerial images; 
• Select and deselect grid elements; 
• Graphically edit floodplain elevation; 
• Import n-value shape file; 
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• Graphically edit n-values; 
• Compute and view Manning' s coefficients; 
• Save the FL0-2D data files . 

Step 1: Open the Grid Developer System program 

·~ Double click the GDS Basic icon from the desktop . ....._,""'"'--__. 

Step 2: Load the model Lesson 2_1 

Click the File menu in the GDS and select the Open Existing FL0-2D 
Project command. 

New Project 

Open , TOP Project ,. , 

~ve .TOPPto)ect .. . 

Save Fl(F2D Res .. . 
R<n FLQ-20 ... 

R<n Mopper 

R<n PROFILES 
RLnQ.AIN 

Browse the folder C:\Users \Public\Documents \FL0-2D Basic Documen
tation \Example Projects\Lesson 2 I and double click the file 
FPLAIN.DAT. 

(• Select a rPlAIJUlA T file to OIM'f1 

J • -Projects • Lesson Z_l • llJ I Search Lesson 2_1 

FPLAIN.OAT l i Z9{Z009 :0:19AM OAT Fi'e 

~------~========~~~===-~~ 
FileNme: jFPLAIN.o.:n ::J I<FPLAIN.DAT) 3 

Open •I C•nc~ I 
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The following dialog box will be displayed. Click OK to load the model 
and display the grid system. 

f 1 u 20 Components "' 

The follo~ng compone/"i$ wil 1M! lo.5ded: 

r r "' 
r r ' " 

r r . ' 
r.l Ol.ltlow elements r · II 

r.; lrllow elements r ' 

r . 

r ~ r . 
r 

.QK .cancet I 

The display of the grid system should look like the following image . 

Step 3: Importing aerial images (see Lesson 1- Step 4) 

Step 4: Select and deselect grid elements for editing 

There are several ways to select grid elements for component editing. To 
select a single element, double click it and load the following dialog box . 
Click Cancel to close the box . 

21 I Lesson 2_1 



FL0-2D Model Lessons 

1\tlnbutc-. of ( ,rid l:.lesnent Number 493 

Aoodpleun elevctJon (leeQ 141697.72 

M~nn1ng coeffioent 10.04 

um•ng Froude ""jo.o;----

Element s1ze (feet) 
DeHo X poo 
DeHo Y i""''o"'"o --

Beduellon Fee1ors I Mulbple Chennel 

levee I ------' 
lnfiltretlon 1 r 

MODFlD-20 I 
QK !;onc:el 

Click the Select Element by Element ..:J button on the toolbar. Click on 
several grid elements and notice selected elements have green cross 
hatches. Select multiple grid elements by holding down the shift key 
while dragging the mouse over the grid elements. Deselect single ele
ments by clicking the element again. Deselect multiple elements by 
holding down the Ctrl key while dragging the mouse over undesired el
ements. 

Select an area of grid elements by clicking the Select Element Defined by 

Polygon I2!J button on the tool bar. Click the Unselect Element ~~ but
ton on the toolbar to deselect all grid elements. 

Step 5: Graphically edit floodplain elevations 
To edit the elevation of a single grid element, just double click the ele
ment. Change the elevation parameter in the dialog box and click OK. 

Zoom in on the area ofbare ground south of the highway. To edit the el

evation of several grid elements, click the Select Element by Element ...=J 
button and select several grid elements. Click the Grid! Assign Value to 
Selection/Elevations. 
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Enter a 3 in the dialog box, check the Add to Existing Elevation check 
box and click OK. 

Note: Assign a single elevation to a group 
of grid element. This will facilitate the 
design of a graded surface such as a park
ing lot. 

Step 6: Import n-value shape file 

From the file menu, click Import Shape File ... 

New Project 

Open .TOP Project ... 

Open Existilg FLQ-20 Project .• . 

Save . TOP Project . . . 

~ve FLQ-20 Fies .. . 
Rt.n FlQ-20 ... 

R<» Mopper 

R<» PROFILES 

Rt.n RAIN 

Create FPian.Oat and CadPTS.DAT 

Import Image 
Import Elevation Points 

Import Ra~n Arcirlo ASCD Gnd Fde .. , 
Import HEC-RAS Channels .. • 
lmpC'ft C' ""' ..-. "'phrc ElJ'If"''f" ~< • ., 

In the Lesson 2.1 folder, open the n value.shp file . 
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Sele<t fil e for new layer · 4 

)n value.shp 

jESRI Shapemes (".sl-j>) 

r Open as1ead-only 

Open 

Cancel 

Click OK on the following dialog box to load the shape file. 

<,h.tp t- f 1le Colour and Va.lue 

Shope File Nome; 

n v~~e.shp 

Ntmenc F1eld: I ::J 
Ma>< VakJe: jo 

M1n. VakJe· jo 

Numbe• o1 Color.: j1o 

Q.K kancel 

Step 7: Compute and view Manning's coefficients 
From the Grid menu, click Compute Manning's Coefficients ... 

Cre~te Gril 

Select 
Assigl Values to Selection 

Interpdate ElevatiOn Poirts 

Green-Ampt 

Comp!.t.e SCS Curve NLmber 

Defile Boll'ldary Gt'id Elements • 

Select Computational Domail 

Cre~te Gnd Layer 

Change the Manning Coefficient from VAR to N-VALUE and click OK. 
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'\t•lt•t I M.uumuJ shupe life 

Manning shape file: j N VAWE.SHP 

-----~-

.QK .C•ncel 

Turn off the shape file by clicking View/Layers List . 

View AI 
Zoom Out Previous View 
Zoom Out 10% 
Pan 

OTM Pont Elevations Rendenng .. . 
Tracl · Elev,..liln Point"'> 

Select the N Value.SHP and click the Visible checkbox. Click OK or 
Apply to hide the shape file. The arrow buttons are used to specify the 
top layer. 

~~ ~ r~j r q.~ • 

DO ~ I ~nce1! 

To see the n-value changes, click Grid Element Manning's n-Values 
from the View menu . 

V1ewAII 

Zoom o..t Prevk>us lftew 
Zoom o..t 100/o 
Pan 

layers _us_t .. _. __ 

OTM Pomt Elevations Rende!ing ... 
Track. Eievatkln Points 

Gncl Element N...-bers 

Grid Element Elevatlon Values 

Grid Elemert. Cu ve !'bnbefs 

Gnd .. . 
Components 

Zoom in on a portion of the highway and pan around the grid to view the 
different n-values. Repeat the procedure to turn off the grid element n 
values . 
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Step 8: Graphically edit n-va/ues 

Note: Other floodplain attributes can 
be accessed from this dialog box. 
The grid element elevation can also 
be edited. 

~· u .. .,...,. .£!!_1 TM"~< ""tr 

To represent a street without curbs, the floodplain n-values can be ad
justed. Double click a grid element on the highway shown in the aerial 
photograph. Adjust the Manning's n-value to reflect the highway rough
ness. 

Levee I ___ ___, 
lnfilll'etton 1 r 

MODFLD-20 I 
.QK Qcncel 

Use the Select Element by Element ...::J Button to select the grid elements 
along the highway. Then click Grid/A ssign Values to Selection/Manning 
Coefficients. 

Q gfl lijl · "\, .'Q~~ i P~!m ll !MI 

......... , ............ , ... . ~ .... 

c ... .......... """"" :.~ ...... 
c~ .... scs:... .• r.o.....,.. 

- --- --

~,,.- ...... 
~··- --·'-~"'oct~· 

Enter an n-value that represents the roughness of the highway into the 
Assign Manning Coefficient dialog box and click OK. 
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lotami'lg coefficient: lo.o~ 

QK .C•ncel 

Step 9: Save project 

To save the project click the Save FL0-2D Files .. . command in the File 
menu . 

New Project 

Open , TOP Project ... 

Open Exfstilg Fl0·2D Project ... 

SaYe .TOP Project ... 

RcnFL0-20 ... 

Rcn Mapper 

RlllPROF!LES 
Rt.nRAIN 

Create a new folder in the Example Projects folder named Test 1 (or any 
folder name) and save the data files to it. Avoid overwriting any of the 
Example Projects files. If a file is overwritten inadvertently, the files can 
be recovered from the installation files . 
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Review Questions 

1. Name three methods to revise grid element elevations? 

2. Overland flow details are attributes that are assigned to all grid elements spatially. 
Which ofthe following are overland flow attributes? Check all that apply. 

D 
D 

Elevation 

N-value 

D Floodplain cross sections 

0 Infiltration 

3. Name three methods to select and deselect grid elements? 

4. Identify the following buttons? 

~ ------------------------

~ ------------------------

~ ------------------------

~ ------------------------

--=-1 -------------------------

-=.1 
-------------------------

~ --------
~ -------------------------

5. The following technical support files are found in the FL0-2D folder under c: \Program 
Files\FL0-2D? Check all that apply. 

D 
D 
D 

Example Projects 

Tutorials 

PowerPoint Presentations 

0 User's Manuals 

D Pocket Guide 

D License Documentation 

6. Which data file is the grid element elevation and n-value attributes written to? 

D CONT.DAT D TOLER.DAT 

D CADPTS.DAT D INFIL.DAT 

D FPLAIN.DAT D CHAN.DAT 

7. How can a FL0-2D data file (*DAT) be viewed? 
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Part 2. Urban Floodplain Attributes 

Buildings, Streets, Levees and Infiltration 

Overview 

Required Data 

Content 
FL0-2D Data Files 

In Part 2 of this lesson shows how to add urban features to the model. 
These include buildings represented by area reduction factors (ARF) and 
width reduction factors (WRF) attributes, streets, levees and infiltration 
parameters. Save the FL0-20 data files after each editing step to avoid 
the significant loss of data . 

The lesson requires the use of FL0-20 data files and aerial photographs 
provided in the installation folders as follows . 

Location* 
Example Projects\Lesson 2 2 

Goat.tif Aerial photographs Example Projects \Lesson 1 
*Typically these folders are in installed under C: \Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

To graphically edit FL0-20 urban attributes using the GDS follow these 
steps . 

• Open the Grid Developer System (GDS) program; 
• Load the Lesson 2 _ 2 project; 
• Import aerial images; 
• Graphically edit area reduction factors (ARF) and width reduc

tion factors (WRF); 
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• Add a street segment; 
• Create a levee; 
• Graphically edit infiltration parameters ; 
• Save the FL0-2D data files and run the model. 

Step 1: Open the Grid Developer System program 

Double click the GDS Basic icon from the desktop. 

Step 2: Load the model Lesson 2.2 
Click the File menu in the GDS and select the Open Existing FL0-2D 
Project command. 

N~Project 

~en .TOP Project ... 

~ve , TOP ProJect . .. 

Save Flo-20 Fies .. . 

Rll'l FLO·ZO ... 

Rli1M~pet 

R«~PROALES 

RlnQ.AJN 

Browse to the folder C: \Users\Public \Documents\FL0-2D Basic Docu
mentation \Example Projects \Lesson 2 2 and double click the file 
FPLAIN.DAT. 

(' Select a FPIADt.OAT 6Je to 

~ !I I 

.,...,. . I ~ 
Test 5/7(lDIJ !0:26PM F!e fo:der 

. f.PI_ AINDAf Ji.,."'l/.!fJ9lQ4;AM LJA T t-ik 

~--------~========~======~--~ File name: jFPLA!N.OAT 3 j(FPLA!N. DAT) 3 

The following dialog box will be displayed. Click OK to load the model 
and display the grid system. 
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II II LO Cv111ponents ~ 

The loloM!g cof11J()Ilenls wil be loaded . 

r .. t r . ,,~ . 

r " 
r ,, J~·-· erj 

1': ,er, " " 

W Outflow element1 r 

,;; lrtiow elements r l • ~ 

r 

r 

£..-eel I 

The display of the grid system should look like the following image . 

Step 3: Importing aerial images (see Lesson 1- Step 4) 

Step 4: Graphically edit Area Reduction Factor (AFR) and Width Re
duction Factor (WRF) values 

Single building assignment ... 

This assignment will simulate the loss of floodplain storage or flow ob
struction due to buildings or other floodplain features . Zoom in on the 
populated area north of the highway and see several large rectangles . 
These features are buildings and a gas station. The thin rectangle at the 
bottom of the red box on the following image is a pump station and does 
not impact flood storage or flow. The buildings partially cover grid ele
ments and will block the flow. Represent these features by editing ARF 
and WRF values of the coinciding elements . 
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Note: The model automatically recog
nizes any WRF values from the opposite 
flow direction. For example, assign a 
WRF value for the east direction and it 
will be also be assigned as the west direc
tion WRF of the grid element to the east. 

Click Tools/Floating Variable Editor and click the Reduction Factors 
tab. Use this variable editor to assign reduction factors for the buildings . 

"''oft.~l.liltW 

.:] I ;!.>< 

r.., .:.. ( 
,~,.. 

In this dialog box, it's possible to completely block the grid element 
(cell) from receiving any flow by checking the Completely Blocked Cell 
box. To simulate a partial loss of storage on the grid element due to 
buildings or other features , assign an Area Reduction Factor (ARF) from 
5% (0.05) to 95% (0.95). If an ARF value less than 5% is assigned, the 
FL0-20 model will automatically set the ARF = 0.0. Similarly, if an 
ARF value greater than 95%, the FL0-20 model will automatically set 
the ARF = 1.0. 

The Width reduction factor (WRF) can be assigned in four directions 
(north, northeast, east and southeast). The other four directions are 
automatically assigned by the FL0-20 model from the contiguous 
grid element. The WRF values also vary from 0.0 to 1.0 (100% ob
struction to flow) . When assigning the WRF values, remember that 
the grid element is represented as an octagon for the eight flow direc
tions. 
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MULTIPLE building assignment. . . 

Zoom in on the neighborhood north of the highway. Use the Select Ele

ment Defined by Polygon ~ button to select the grid elements that coin
cide with the neighborhood . 

Click Grid/Assign Value to Selection/Area and Width Reduction factors 
to load the following dialog box. Enter a . 35 into the box and click OK. 
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Ar t'<'l c~ r u J Wrdlh Reduct1on factors 

r Complet~ Blocked Grid Element 

Ar .. Aedt.dm FactO< IAAFl 
L70% sulface ace~ km:: ARF=O 71 

Width reduction foetor ('WAF) 

Note: Do not assign WRF values us
ing the multiple grid element option. 

N NE 
[0"3[0"3 

[0"3 E 

103 
SE 

.Q.K J;ancel 

Save the FL0-2D files. 

Step 5: Add a street segment 

In this case the highway will be assumed to have a curb and gutter and 
will function as a flood conveyance feature. Zoom in on the highway and 
note that this is a two lane high-way but the 100 ft grid element will en
compass both lanes and thus we will consider it to be a single street with 
the assumption that it has a width of 40 ft. Click on the Create Street 
Segment with Polyline option on the Tools menu. 

Options 

Measure Distance along l ne 

Compute Average Pori Rarial Depth 

Irterpolate Variable. R.ffifall 

Levee Express Editor 

Floatirq "f'ar~bles EJCptess E~or 

O eote Chemel SeiJrlent w>th • Polytne 

Create a Cross Set:bon 

Assi~ a HEC-RAS Cross Section to a Channel Element 
Convert t-£C-RAS Xsec to FL0-20 

Convert t-£C -RAS ChMnek to FlQ-20 Ch.!mel Segnent:s 

Create street Segment 

I Create street Ser;iment wrth a Poiyhne I 
Create Detention Basi'! 

The cursor changes from an arrow to a cross. Click grid element where 
the highway starts on the left side of the grid system and drag the cursor 
along the street. Follow the street as closely as possible. In this case try 
and avoid street elements that meet at right angles. Double click the last 
street element to finish the street. 
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Once the street segment is created, define the street parameters by left 
clicking anywhere along the street. Click the Edit Street Parameters . 

Edit the global parameters in the top area of the dialog box as shown be
low. Assign a global n-value = 0.02, street width, limiting street Froude 
number and curb height. These values will be assigned to all the streets 
unless they area superseded by individual grid element street assign
ments in the lower box area . 

Assign a street name Street name. Street intersections can be modeled 
adding by additional directions within the grid element. 

Streetglobcipa.-amete~a: ---

Global n-value fOf tlieel tlow. ~ MaKirrurnstreetFrouderll.ITbef·~ 

Globol streetoidth: ~ Globolcurbheight rs-
r l nfl~ ~r~~ph will enter street ilstead ol lloo~in element 

Sheet local paramelen 

Sheet name !Highway 260 

Flow d11ection hom certer of elemert <Yld ;treet wid:h 

r Northweot r North r Northeast 

r wev. 

w Soottwiest r Sooth r Sootheaot 

21 
22 
23 
24 
25 
26 
27 
28 
29 -

Element Ct.~bheiglt n-vakJe E~vation 

646 
GGG 0 0 
687 0 0 
708 0 0 
731 0 0 
753 0 0 
776 0 0 
799 0 0 
824 0 0 
" "" " " 

~ 
0 
0 
0 
0 
0 _j 
0 
0 
0 l:J ""'-~ ------' Aemerrber to add the street flow directions bv checkm the d1recbon boxes to the ieft 

If the Weel width 11 ~ 2ei'O Yalue the global 
~h'eet width is. used as a detd 

QK Cancel 
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Note: Validating the table does not 
save the STREET.DAT file. It only 
saves the table in the GDS. You 
must still save the FL0-2D Files to 
create the STREET.DAT file. 

...-......... .. _ ·- ---~.--- ·-
'~-' OQI'I!Miian 
~~~'CI~TJinSCIO!t 

£V,IW!'~ ......., , _ 
""""" """"' 

........ 

Click the Edit button to assign individual grid element street attributes 
(curb height, n-value and elevation) that will supersede the global as
signment parameters. 

Ass1g1 ttls ~ak.Je to 
Selection: 

Cut and Paste 

.COOY C<.rrent 
Row 

.QK £once! 

faste to Selecled 
Rows-

Click OK to exit the Street Element Parameters and click OK again to 
exit the Street Parameters dialog box. Click Yes to validate the table for 
the GDS. 

• I • • 

Would you like to validate the street va-iables now? 

Yes No cancel 

Save FL0-2D files. 

To view a profile of the street, click Tools/Street Profile. Edit the eleva
tion of grid elements that cause severe dips or mounds in the street pro
file unless the dip or mound accurately reflects the situation. 

-
3Lrt•£-L C t ·e::sl ..tnd Cit"llUild ~. 1 ..-va•~tu n:s 

-' . 
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Step 6: Create a levee 

Note: Levees are assumed to have 
negl igible width. If the storage loss 
due to levees was considered to be 
important, use ARF values in the lev
ee node . 

Levees can represent berms, roadways or railroad embankments, or 
floodwalls. Any linear feature that can obstruct the flow and yet still be 
overtopped can be modeled using a levee function . 

Click View/Components/Reduction Factors to turn off the ARF's . 

Zoom in on the neighborhood to the southeast of the highway and see 
that a brick wall is built between the homes and the highway. The task is 
to create a levee to represent this floodwall. 

Click Tools/Create Levee Segment with a Polyline . 

Options 

Meaue Dist.nr along li1e 

~te A-.erogo - t Ranfoi D<s>1i> 

lnb!rpoiate Vanoble Ranf.OI 

levee~Editor 

Aoamo vonables Ex!nss Edmr 

Create Chamei Segnont - a Polylne 
Create a Cross Sedan 
Assgl a HEC <lAS ero.. 5ect>on tD a 01amel Bemer>t 
Auto "-TT HEC<!AS Crass Secb<r.; to 01amel Bements 
COO\'e"l HEC~ Xsec 1D R.O·lD 
Conv.,.t HEC «AS Ch8r.e:s tD R.O·lD 01amel ~ 

Delete HEC RAS Chamois 
Delete HEC RAS Cross Sed>ons 

Create Street Segnont 
~tr: Streer Seg'rle1t w11h " Po'ytioe 

Create Ootootion s...n 
M..d Mld SecftentTr,.nnort 

Ev~abon 

MOOR.0·2D Sd!o.iai>Jn 
Hv<hu\c Strud!ns 

Bread> 
NOFI.OCS 

l evee Profie 
Street Prolie 

Draw a polyline along the wall to create a levee. Double Click the last 
.----------------.lCF"·rtex to finisth the line. 

Warning: Do not put levees perpen- \. 
dicular to street elements . 

Warning: Do not create redundant 
levee elements. For example, do not 
place a levee in the north direction of 
one grid element and then in the 
south direction of the grid element 
above it. 
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Enter a value of 4670.00 ft to set a Uniform crest elevation and click OK. 

, Elevation Algorithm 

r. Untlorm 

, r Interpolate 
I 
, r Use OTM ponts 

114670.011 I Elevatoon 1 

Ok CllnCel 

Step 7: Examine the profile of the levee 

Note: Use the levee profile plot to veri
fy that the levee elevation and grid 
element elevation make sense. If the 
levee is only slightly above the grid 
element, you may want to make ad
justments to one or the other. 

Select Levee Profile from the Tools menu to view the levee profile. Then 
click on the eastern most levee element. 

Crt.o.:e .x.fl.et =er;Jllert 

Cre~e Street Set;Jnert Yl'lth a Polyl1ne 
Create Detention Belstn 
MJd and Sedtment: T r MSport 

Ev~Mion 

MODFLo-20 Siml,jMion 

HydraiJic structiJes 

Breach 
NOFLOCS 

Fnd Watershed 

Crovert HEC-RAS Xsec to Flo-20 
Convert HEC-RAS CMmels to FL0-20 Chamel Seonents 

street Profile 

The levee profile plot shows the levee elevation compared to the coincid
ing grid element elevation. The window shows that the levee has a con
stant elevation. Use the Levee Express Editor to define the levee crest 
elevation in the next step. 

-. lt'Vt't' .uul c;urldlt• fl£>vatmns · '! ,;t~;. 

Reri-aw Formatting 

N N N "' "' "' 'lsl!:v ee:rCz:e.-t 8ItH G!Oune)llE:levat.i '*s ., ., ., 
"' 

Levee ., 
~ ~ ~ ~ ~ ~~ ~ ~ ~ ~ ~~ ~ ~ ~ "' "' 

~ ~ ...... .-4 ...... rl .... .-4 ........ ~ ~ ~ Gr:ound 

4670.0 

4667 . 5 

-~ 4665 . 0 

~ 4662 .5 

~ 4660 . 0 

jj 4657 . 5 

4655 . 0 

4652. s 
4650 . 0 

100 200 300 400 500 600 700 

Aproximete Levee Distanc e ( tt l 

Step 8: Use DTM point data to determine levee crest elevation 
Start by importing the dtm.pts file from Lesson 1. Click the Levee Ex

press Editor _Qj button. Double click on any grid element that contains 
a levee. Query individual DTM points using the Track Elevation Points 
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~ button. The elevation of the highest DTM point elevation and the 
average of the 5 highest points in the grid element is available on the dia
log box. Use this data judiciously to define the levee crest elevation . 

Note: It is only recommended that 
this feature is used when the DTM 
data is dense and accurate. Do not 
use this feature for walls. 

Levee O ~ta --
; I Grid element elevationt in colofed bo)(eJ 

-~~~~-1 ( M"" PL Elev .. f4688. 00 l 
Conent Grd E k!meri:~ Ave. High 151 1'1<. f468S.OO ":/ 

f46Si05 f468U1 f4S82.29 j 

1;1 NorthWe•t P N01th P N01tt£ost 
~~ ~ 

! 467628 
rw .... 

14667 98 
r East 

14665.36 : 

I r SouthW.,t r South r Soutt£0$1 : 

1 14665 36 14664 03 14666 36 . 

Assf!ln levee crest elevation · ~ Selecl liecli:lns 

~ Se~t ~ j 
AHign to a1 I Assign to selected I 
dJiecbons _ diections Unselect ~ 

{l" ign to Element I !;lose 

Step 9: Graphically edit infiltration parameters 

FL0-2D can simulate infiltration using either the Green-Ampt or SCS 
curve number methods. In this simple example, set up global infiltration 
and create several impervious zones. An advanced infiltration tutorial is 
provided in Lesson 7 . 

In this step add an impervious surface to populated neighborhoods, park
ing lots and the highway. First, assign the uniform Green-Ampt infiltra
tion parameters for the project area . 

Zoom in on the west portion of the grid system from where the highway 

enters it. Using the Select Elements Defined by Polygon ~ button, se
lect the grid elements that correspond to impervious areas. These grid 
elements have a high percentage of impervious surfaces. From the Grid 
menu, click Assign Values to Selection/Infiltration. 
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~ .· ..... """"" ~1 ,_'4t\'" 

O.liJi.j iiil '\ -"~-

t • .,. ... .... _... ; . - -

c ...... x~ ;:: .... . < .. -

'·1 

Note that the global infiltration parameters are already set to default val
ues and the default infiltration method is Green Ampt Adjust the global 
infiltration parameters at this time. 

To assign the individually selected impervious grid elements, enter 1 m 
the Impervious Area dialog box for the Floodplain Element. 

l nl~"mnMetl-od 

w Gteen Ampt r SCS Colve NulliJet 

The selected i-lfllration methoclls) wiU be the :arne Ia all gud elements 

Global pzwameters 

lnitia!Abslraction ro.o--- ln itia!Saturatiorr~ 

SOli Porody· ~ F11al Satutatiort r;:o-
Fiood~~~J~~ ro:;--- Soil Suction ~ 

ch~~:~t ro:;--- r 

W Gnd element ftjtration 

r Channel Element 

Hy<t.Uic Conducl [11/h!) ~ 

Capi.,iy Suction [In) ro-
SoHocis!UieDeliat ~ 

Aainf!IAI»iraction[n): r-
1-viousAiea: ~ 

,, 

.....,.,, rr--

!)_K l;anoel 
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Click OK and notice that the local infiltration areas are symbolized by 
red cross-hatched grid elements. Hide the local infiltration grids by 
clicking View/Components/Infiltration . 

Step 10: Save the data files and run the model 

Save the FL0-2D data files. To run the FL0-2D flood simulation, use 
the Run FL0-2D ... command in the File menu . 

New Project 

Open .TOP ProJect .. . 
Open Exfsti"tg Fl0·2D Protect ... 

Save .TOP ProJect .. . 

Save FLo-20 F•es .. , 

Rll1 Mappet 

RLn PROFILES 
Rtn RAIN 

Make sure all the correct component switches are turned on (Streets, 
Levees, ARF and Infiltration) . 

Input the Simulation Time = 24 hr, Output Interval 0.25 hr (or 0.10 hrs 
for more output intervals), select the Detailed Graphics option and input 
Update Time Interval = 0.10 hr (or 0.05 hr to view the flood progression 
more frequently) as shown . 
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H 0 20 l uutrul Ydtldlll~s !\ 

TmeControlaodPiot:Variables - -~ 

Sm\Jotion Time(hrst. ~ 

Outpt.t lntervol (hr•t ro:;--
Graphtcs Display r Text Screen 

(o Det,.led Gra~ 

r r Backupfile 

Sydem ~nent Swtches 

r Main Chamel P Area AedJclion Factors {AAFI 

f;i Sheets 

W Levee.$ 

r M<itiple Channels 
fAil and Gules I 

r Physic~l Processes S~dches 

r Rainlan r Mud/Debrit 

P hlio r Secinent TrM$p01t j 
r None r E vap01ation 

r MODFL0·20 Modeling 

Conveya'lce Struct!A"e SWitches 

r HydraiJic Structues 

r FJoOO.Yay Anaiym 

r OebrisBasin 

NliOer~ Stabi!~y P~r<Ynete~; 

Surface Detention. ro:;---
Percent Change rn Flow Depth: ro:;---

r Ammale Flow within GDS 

Floodpla111 Display Options 

Punt Opbons· l No Floodp~in Output 

r Create Supe~aitical O<Jput File 

Check ''Main Chamel' to activote ''Chamel Pmt Options" 

Time L~se Output 

r Trme Lap<o O<.tput 

GrapllicoDisplay 

O<.tput lnte<Val ]hlf]: ro--

Select ''Detailed Graphics"" "Time Control and Plot 
Vonables" frame 

Update Time lnterval ]hrs) ro:;---

Dyn.,mic Wave S tabi~ Coefficient ~ 

.S.ave FL020 
inpttfies 

Now click Run FL0-2D (Save Files) and monitor the floodwave progres
sion over the project area. The inflow hydrograph will be plotted and the 
volume conservation is reported during the simulation. 
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_/ 

Iv!axmn• 
Flow D~ th;, 

epth .. ,send 
j ~ '"~ DE. r H ..:: .3 •) 
2 ·) ~ E..f' H ~ J. S 
I ~ .. ·c.ll:.? H ..:: l..) 
I •) ~ D :E·P'T H ..._ I : 
('• ~ ... DEt?t'H ~ I •) 
T Ol. ... _ DEPTH .. _ ("• : 

C.rE.~rH -r or.. 

In this lesson, the GDS was used to create and edit graphical features . 
When building a detailed urban flood model, each grid element can be 
modified to represent a specific floodplain feature such as a building, 
street, obstruction, infiltration or levee. Each feature can affect the flood 
distribution on the grid system. For large flood events, a lot of floodplain 
detail may not be necessary as the flooding will cover the much of the 
available floodplain anyway. For small flood events, more detail can en
hance the flood map resolution . 
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Review Questions 

1. When it is necessary to revise grid element elevations? 

2. Streets can perform in the model as which of the following? Check all that apply. 

D 
D 

Conveyance channels 

Obstructions 

D Embankments 

D Storage loss features 

3. Levees can function as which ofthe following? Check all that apply. 

D 
D 
D 

Berms 

Floodwalls 

Conveyance channels 

D Railroad embankments 

D Storage loss features 

D Detention basin dams 

4. Which of the following are most likely to be assigned ARF values? 

D 
D 
D 

Warehouse 

Beach houses on piles 

Levees 

D Mobile homes 

D Parking garage 

D Baseball stadiums 

5. What methods are provided to compute spatially variable infiltration? 

6. Street global parameter assignments such as curb height will override the individual grid 
element street parameters? (True or False) 

7. Which of the following will directly affect grid element flood storage? 

D 
D 

Streets 

Buildings 

D Infiltration 

D Levees 

8. Floodplain details such as streets and buildings are more important to defme the area of 
inundation for shallow flow or deep flooding? 
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LESSON 3- GDS CHANNEL FROM SCRATCH 

Overview 

Required Data 

Content 
Grid System Data File 

Channel routing is an essential tool in a FL0-2D project. The channel 
component should be used when the defined channel geometry will con
vey a significant portion of the flood volume. Channel flow is simulated 
as 1-D with defined cross sections. The channel component is used to 
simulate channel-floodplain exchange including return flow to the chan
nel. This lesson will demonstrate how to create a channel from scratch 
using the GDS by generating a channel segment, editing channel parame
ters and modifying a channel segment. 

The six basic data files for FL0-2D floodplain model are provided for 
this lesson. The files required to create a new channel are . 

• CONT.DAT 

• TOLER.DAT 

• FPLAIN.DAT 
• CADPTS.DAT 

• INFLOW.DAT (optional) 

• OUTFLOW.DAT (optional) 

Aerial imagery is an important tool to locate the channel with respect to 
the grid system . 

Location* 
Example Projects\Lesson 3 

Goat.tif Aerial photographs Example Projects \Lesson 1 
*Typically these folders are in installed under C: \Users\Public\Documents\FL0-2D Basic Documentation 
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Step-by-Step Procedure 

To build a channel in the GDS these steps should be followed. 

• Open the Grid Developer System (GDS) program; 
• Load the model Lesson 3; 
• Import aerial images; 
• Create a channel segment; 
• Realign the channel; 
• Edit channel segment parameters; 
• View and edit bed slope; 
• Input a channel inflow and outflow node; 
• Save project and run the FL0-2D model; 
• Confluence and NOFLOC's. 

Step 1: Open the Grid Developer System program 

Double click the GDS Basic icon from the desktop. 

Step 2: Load the model Lesson 3 

Click the File menu in the GDS and select the Open Existing FL0-2D 
Project command on the File menu. 

New Project 

Open . TOP Pto;ect ... 

Save .TOP Project .•• 

Run FLO·ZO .. . 

Rlll Mapper 
Run P!lOFILES 
Rllrl RAT~• 

Browse to the folder C: \Users\Public \Documents \FL0-2D Basic Docu
mentation Example Projects\Lesson 3 and double click the file 
FPLAJN.DAT. 

. • J u 
1.,.....,.._.,. 1- I• 

·- ~-OAT 
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The following dialog box will be displayed. Click OK to load the model 
and display the grid system . 

tl 0 ZD Components -~-

The following componert.t. wil be.loeded . 

r ~ lnfillraiJOn 

r . r r ,, . 

W Sheets r ': .. :l 

w OLillow element< r · 

~ lrllow element• r ' 

rv levee.; 

r · r 

r 

I! QK J;ancel 

The grid system should look like this . 

Turn off the infiltration graphics by clicking View/Components 
/Infiltration . 

Step 3: Import aerial images (see Lesson 1 - Step 4) 
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Step 4: Create channel segment 

Note: The floodplain inflow node may 
not correspond to the channel. You 
can reassign the inflow node to the 
channel later. 

Start by zooming-in on the upper left hand quadrant of the grid 
system. 

Locate the natural channel on the aerial photo by zooming in on 
the floodplain inflow node that is in the upper left quadrant. The 
dotted line in the following figure shows the location of Goat 
Camp Creek. 

Select Create Channel Segment with a Polyline from the Tools 
menu. 
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Opbons 

MeMUre. Oist~nce ~ l ile 

Compute Average Pott Rainfall Depth 

Interpolate Varfable Ramfal 

levee Express Edler 
Floating VaMbles Express Editor 

Create a Ooss Section j 
Assk71 a t-EC -RAS Cross Section to a Chamel Element 
Convert HEC-RAS Xsec to Flo-20 
Convert HEC-RAS Olamels to Flo-20 ChameiSeQments .. . ~--.--- -

Start the channel by clicking on the inflow node and then clicking 
along the channel in the image. The channel elements are automat
ically filled as click along the path of the polyline . 

Double click the last channel element to accept the channel. As 
the cursor moves to the edge of the screen, the grid system will au
tomatically scroll in the direction ofthe cursor . 

Step 5: Realign the channel 

In order to realign the channel, click on the channel and click Rea
lign Channel . 

Note: Realign the channel before 
editing the geometry data. 

Edit Cl'wY!el Segment Parameters 

Modty Ch5lllei SeiJ!!Ont 

Delete Channel Segmert 

Invert Charnel~ Drectlon 

Reahll'l Extensions 
Plot Ctoss Section 

Assii;Jl Cross Section Nl..wnber 
Plot :J) Ch5lllei 
CleM "'oblematk Right Banks 
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The channel feature will show dots in the middle of each channel 
grid element. Click and drag the dot to the new channel element. 
Click Apply to accept changes. 

Step 6: Edit channel geometry parameters 
Once the channel delineation is complete, define the channel geometry 
parameters. Click on any channel element within the segment to access 
the editor dialog box. 

Modly Chomel 5e!Jil<nt 
Delete Olann~ Seoment 
Real1g"~C~el 

Plot Cross Secbon 

Assign CJ oss Sectioo Number 
Plot 3D Olannel 

Select Edit Channel Segment Parameters to display the Channel Seg
ment dialog box. Please note that there are data dependencies and the 
grayed data will be turned on with the appropriate data selection. Refer 
to the data Input manual for channel variable definitions. 
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Segment control 

Meoomum Froude number~ Roughness a:~~~=~~ro-- Com~=~:u~:e~~S:~~~~~ ro--
lnrtJo.l flow depth 

lnitiolflowdeptb for e.ll channel elements "o ---
- r lmtia!Aow 

Channel geometry 

Interpolate Cross Sedlons 

Ce!a.~le.te Right Bonks 

& om me Rrght Banks 

Left bonk elavetion. r--
Right benkelevetton r--

Average che.nnei Width ~ 

Tho.tweg chormel depth· rs--

Rtght8M k Cell ro---

304 
319 R 
335 R 
350 R 
366 R 
381 
395 R 

409 R 

"' R 

Al;s1gn rh •s Shape 
to Selection· 

QK ,Cancel I 

.04 

.04 

.04 

.04 

.04 

.04 

.04 

.04 

r·-

lB Ele-.• RB Elev. W.dlh . 
120.71 

120.71 
120.71 

120.71 
120.71 
120.71 
100.0 
100.0 

s~o~~~~;~ 

~ 

r--- r-
r- r-
p- r-

20 
20 
20 
20 
20 
20 
20 

2~ 

For this project, the channel geometry will be defined as a rectangle. En
ter a channel width and depth for each channel element. Click the Edit 
button ~ in the Channel Geometry group of the dialog box . 

Use the Channel Geometry dialog box to enter the channel parameters . 
For example, enter a rectangular channel depth of 5 ft and a width of 20 
ft. To enter multiple values, simply highlight all of the channel element 
boxes, and assign a value to the data input box to the left of the Assign 

Assign this ~ alue to 

this Value to Selection Selection: button and click on the button . 
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Note: The channel element number 
can only appear once in the 
CHAN.DAT file. To create a channel 
confluence with a tributary channel it 
is necessary to locate the last tribu
tary channel element contiguous to a 
main channel in one of the 8 flow 
directions. 

Element Shope Aouohness 
1 304 A .041 
2 319 A .04 
3 335 A .04 
4 350 A .04 
5 366 A .04 
6 381 A .04 
7 396 A .04 
B 409 A .04 
9 424 A .04 

10 439 A .04 
11 453 A .04 

:.iLJ 

L~ LB Elev AB Elev. Wdh 
100.0 

120.71 
120.71 
120.71 
120.71 
100.0 

120.71 
120.71 
100.0 
100.0 

120.71 

20 
20 
20 
20 
20 
20 
20 
20 
20 
20 
20 

. Cut and Paste 

Cow Ccnenl 
Row 

. ... '.. 

Deolh X Sect. Loll Slooe ~ 
5 
5 
5 
5 
5 
5 
5 
5 
5 
5 
5 

f aste to Selected 
Rows 

_j 

£ 

Click OK to close the Channel Geometry dialog box and click Yes to val
idate the channel data entries and close the Channel Segment dialog box. 

t l u to t.r~d Developer Sy~tem 

Would you I~ to validate the chamel segnent: v~rlables now? 

Ves No Cancel 

Step 7: View and edit bed slope 
Click File/Save FL0-2D Files... Save the files in a test folder. Click 
File/Run PROFILES. 

- Project 

Open . TOP Pro)ect. .. 
open Ex!s1ilg FlQ-20 Project ... 

save .TOP Pro)ect. .. 

save Fl0·2D Aes. •. 
RUn FLQ-20 ... 

Run Mapper 

Run RAIN 

create R'laln.DAT and cadPTS.DAT 

Import"'-
Import Elevatbn Poots 
Import Shape Fie ... 
Import RailArdnlo ASOI Grlf Fie ... 
Import HEC·RAS Channels ... 
Import CN> Graph<: Elemerts. .. 

Save EEv~ PoCnts. •• 

Export .. 

Ext 

Click Yes to run PROFILES. 
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II() Jl) C.rvt lk'vf'Joper ' 

PROFD..ES requres dlannel segments. 
save FL0· 2D fles f channel segments have been modlied (i'l 'Fte . 
Save FL0-20 lies') 
Wouk:t you ~e to run PROFD..ES I)()I.V? 

Yes No 

On the PROFILES window, click View Segment Bed Slope . 

The bedslope is shown in the following figure. The image shows that the 
bedslope is not always positive and becomes fairly steep. The spikes in 
elevation are caused by the higher elevation of the grid element associat
ed with the channel. The red arrows show areas of concern that can be 
edited in the PROFILES program The arrows are graphics and will not 
show up in PROFILES . 

Channel Bed Profile FL0- 20 Channel Bed--

i i 
Click View Local Reach and see that the cursor has changed to a vertical 
arrow. Align the arrow with the first spike and click the left mouse but
ton . 
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II I 1 

. ' 
l ... ~ t' 

' 1 

Click View/Edit Xsection Data to bring up the following dialog box. The 
white boxes are values that can be edited in the PROFILES program. 
Editing the Bed Elevation of the channel in this box will result in edited 
grid element elevation in the fplain.dat file for grid element 335. 

~ .. ' .. ~ 
! Nadel 3351 Upstrm Bed Elev 4708 60 

Node 
~ ! Bed Eleva!Jon ~ 

30< r_J Dwnslrm Bed Elev ~ -170430 

319 Leti.BankEle\1'" IOOQ 
335 RlohtB011kEiev r---o:Oo 
310 I Ch011nei Oeplh ~ 
366 n-volue r-o.o:ro 
381 Chcnnellength ~ 

395 ~ Reech Length J 2811 

View/Edrt aoss s-ection dete. ~ 

Interpolate slope ~ 
[§!!] ~ 

Manually edit the slope by entering a value in the Bed Elevation box and 
clicking Edit or linearly interpolate the slope between 2 grid elements by 
clicking the Slope button. 

In the interpolation dialog box Enter the Upstream element and the 
Downstream element and click interpolate. 

ln1erpolt\le betweton upstreGm end 
dowt~stream dianne! elements. 

UpMree.m j"319G) 
Downneom j35ii'G} 
C.ncall ~ 
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::lick ... n the v:...ew Lo...::41 l'eilct. 
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Repeat this procedure until the channel bed slope profile has no more 
spikes or steep elevations. Pan along the zoomed channel using the UP 
and DOWN arrows on the keyboard . 

The finished channel bedslope has no spikes or steep slopes and the final 
channel element is lower than the contiguous upstream element. 

I; 

Channel Be d Pro f ile FL0- 20 Channel Bed--

Click the Save button and select the Replace the files radio button to save 
the data changes and save over the existing chan.dat and jlplain.dat files . 
Click Exit to close the PROFILES program. 

It the channel bed stope wos modified, 
remember to teploce the a-iAN OAT ond 
FPlAIN OAT wrth the modtfied files 
CHAN NEW and FP\.AJN NEW 

(i Replocethe fl les 

The data files were edited outside the GDS so it is necessary to reload the 
project in the GDS. On the GDS window, click File/Open Existing FL0-
2D Project ... 

4-·---------·--
New ProJect • 

Open .TOP Project. .. 
• ' ! ~ ! v -.. ' ~ 1 I I 1 >' ~ • • 

save .TOP Project... 

save FL0·2D Fles.. . 
Run FLQ-20 •.• 

Run ""'PP"f 
Run PROFILES 

...R.uo.RAIN.. ........... ....- ~ 
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Do not save the project. Click No 

save changes to project? 

Yes No 

Navigate to the project folder and click Open . 

~ St•tl"'fi ,JI PIJ\IN .OI\I fiSc too ~ 
J , • R.0·2D • Example Projects • L<=lf1 3 • TEST • .,, Jr:sea,..---,rm-=TEST==----

OrganiZe • New fokje( 

FL0·2D v20..:.l_Name-=:--· -----------'-~ Date::..:.:::...cmodlll:..:....::.led:.___Lil'ype.:.= ___ 
1 

l...tlrares 

Documents 
Fl0·2D 

• Musi: 

.. Pttures 

Vdeos 

•'!. Homegroup 

' Computer 
HP (c:) 

C 11'•,\Jt, Llll.l l .' I Ill I \~1 P.\1 •• 

FACTORY_!.' _:j_,<...._-;==========:::;-;:::::=== 
Filename: IFPLAIN.OAT 3 

Open •J Cancel I 
,t 

Step 8: Input a channel inflow 

NOTE: Your element may not be 
#304. 

The channels can have multiple inflow hydrographs at various locations. 
For this project, re-assign the floodplain inflow hydrograph to a channel 
node. Right click on the first channel element of the segment and click 
In/Out Condition for Element****. 

Reservoir Wi!l.e< Elevation for Element 30~ I 
Change the inflow node from a floodplain node to a channel node by 
clicking the Channel radio button and click OK. 
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r --
1 r. ~nflow element with hyd!ogr 

I (" Outflow elemont(no !Jydogroph) 

("' Outflow element .......th hydtograph (liYersiOfl) 

I 
( Q.utflow element with stage-tine relatio~ 

r ~~~~en~~ltage-ti'ne ¥ld free 

f" l:honnel 0\Jflow element [w<h stq .O.chorge) 

r tfo 1nlt01.Y/OltRow cond~ion 

I 

'I 

Step 9: Save proj ect and run the FL0 -2D flood simulation 

To Save the project click the Save FL0-2D Files ... command in the File 
menu . 

New Project 

Open • TOP Project ... 

Open Existing FL0-20 Project ... 

Save . TOP Project .. . 

-; .... FL •- [ :: -· 

Run FL0-20 ... 

Run Mapper 

Run PROFILES 

Run RAIN 

Create a new folder in the Example Projects subdirectory called Channel 
Test (or any name) and save the data files. Avoid overwriting the data 
files of other Example Projects in order to use them later. 

To run the FL0-2D flood simulation, use the Run FL0-2D ... command 
in the File menu. 

New Project 

Open . TOP Project ... 

Open Existing FL0-20 Project •. . 

Save . TOP Project. .. 

Save FL0-20 Files ... 

Run Mapper 

Run PROFILES 
R•·~ 'l.AI~t 

The main control dialog box will. Note the Main Channel box has been 
checked in the System Component Switches Group. This switch enables 
the channel flow to be simulated. Input a Simulation Time = 24 hr, Out
put Interval 0.25 hr (or 0.10 hrs for more output intervals), select the De-

57 1 Lesson 3 



FL0-2D Model Lessons 

tailed Graphics option and input Update Time Interval = 0.25 hr (or 0.05 
hr to view the flood progression more frequently) as shown. 

II 0 / 0 { Ulllrol YdtldiJic ~ ' , lJ,W.. 

TmeConbolandPiotV5iables ---, Globe/ Dele Modlication · 

Srntlolion Time(hss) ~ ! n·valueAd'-"tmerl. ro- Ftoodprr,'~'~: ro-
Outputlntervollh"): ro:;-

Grapi'Wcs Display. r Text Screen 
r. De!'"'-1 Gtephic> 

Dur~ionAn~ys~ 10 ShallowfbN rz-
1 

Flow Depth !Of Depth r;;---

Bulkiio Concerl.ration: ro- n-value.: 0.2 

r '• r Backup Fie 
Area Reduction Facta ~ r-

Sydem Component SWitches 4 
W Mail Channel r Alea Reduction Fact01s [ARFJ 

r;; Sheeh r t.Uiple Chamois 

Flo~il Dtsploy Optia>s 

P11nt Options: jNo Floodpleil Output 

r Qeate Supetaijcol Outpt.t File r Lev.e: IRhnd Gules! 

Channel Display Options 
Check 'lo!oin Chomel' to activate 'Ownel Pmt Options" 

PhysiCal PTocesses Swltd1es -

a.a=·INoCharneiOutpt.t ::J , r Reirlal r Mud/Debris 

r;; lrlloation r Sedoment Trensport : 
r Tine L!fll<e Outpt.t 

r Evaporation 
r None 

, r Tinel!fllseOt.tput Outpt.tl ntetvai(I1!S) ro--r MODFL0·20 Modeing 

Conve.Yance Structue Sw•ches -

r Hy<laurrc Sttuctures 

r Floodwoy AnolysiS 

r Debro Ba•n 

Nl.lnerical Slabil~y P.!lrameters 

SlJ'f.ece Detention ~ 

PercentehcngeinFiowDepl:h ~ 

r Ammate Flow with1n GDS 

Grapt-Ocs D~tpley 

Select ''Deleiled Gtll(lhtcs"" "Tine Conttolend Plol 
V~''lr&me 

Update Time lrierval (hrs) ro.;---

Dl')OI!lic Wove Steboliy Coelf<:tent: ~ 

.S.eve FL02D 
WlpUI.fdes t tose 

Now click Run FL02D and observe the flood progressing down the 
channel and overtopping the banks. The volume conservation and inflow 
hydrograph can also be monitored. 

Step 10: Create a channel confluence and define NOFLOC's 

Channel confluences (or split flow channel) require channel elements as 
neighbors in three or more flow directions. The model searches all eight 
flow directions for potential contiguous channel elements. 

Before creating the new channel, delete all outflow nodes on the north
west half of the grid system. Zoom-in on the top right comer of the grid 
system. There is a creek running north to south. Create a channel for 
this creek that has a confluence near the highway. Assign the channel 
geometry similar to the method used in Step 6. Once the new segment is 
created, the last channel element of the original channel will be a neigh
bor to one or more of the new channel elements. 

A careful examination of the channel elements will reveal that there are 
some channel elements that are neighbors but should not share discharge. 
These channel elements must be identified as ' no flow sharing channel 
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Note: Each channel grid element 
should only be listed once in the 
CHAN.DAT file . 

FL0-2D Model Lessons 

elements' or NOFLOCs. NOFLOCs are defined as channel element that 
are contiguous but will not share discharge during the flood simulation . 

The GDS wi ll automatically identify all the potential NOFLOC pairs that 
may be required . 

The red lines in the following image indicate that two pairs of channel 
elements (one channel element is common to both pairs) that should not 
share discharge and need a NOFLOC assigned . 

Note: The red lines connecting the 
noflocs will not be seen in the GDS . 
They are added to the image graph
ically . 
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To make adjustments to the NOFLOC assignment, click 
Tools/NOFLOCS/ Unassign . 

F'e View Qes91 Grid , Tools ~ 

[)1'""11111 <ll.I E'l_ lr Opt;ons 

MeasueOistence~l.he 

C~eAverage Poii:RadaiiDepth 

tnterpolal:eV~ReWall 

levee Express Editor 
f1oatno Variables Express Edtor 

Cre.!!te Ch.Y'nl!ll5eo'flentwth a Potylne 
Createa CtossSertlcn 
AS$91 a 1-EC-RAS Ctoss Secbon to a Chemol Eiement 
Convert t£C·RAS XSec to A.Q-20 

Convert t£C-RAS Owroeb to R.Q-20 Ownel Segnerts 

Create street:Set;Jnent 
Create Sb eet Seonent With a Potytle 

Create Detention Bam 

f!kJd and Sedment Transport 

Ev.,araoon 
MODFLQ-205rr'Ulbln 
Hyci&M:Struct\J"es . .., 
~·"" 

1 t.la7.144 75 reet 

Click OK on the following dialog box and then click the unnecessary 
NO FLOC channel element to remove it. 

Note: The NOFLOC list is found at 
the end of the CHAN.DAT file. Re
view this list if you need to make 
sure that the NOFLOC pairs have 
been correctly assigned. 

' ,. 

i. l ~ CLck a NOFlOC grid elemert to \Slassign it 

The green line shows the two channel elements that can now share dis
charge. The green line is not shown in the GDS. It was graphically add
ed to the image. 
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Step 11: Create a channel outflow node 

NOTE: Your element may not be 
#4759 . 

Note: By assigning a channel outflow 
node with no hydrograph, it is as
sumed that the channel outflow dis
charge will be computed as normal 
depth. The inflow to the channel out
flow will be discharged off the grid 
system using an estimate of normal 
flow depth . 

For the channel outflow node, right click on the last channel element of 
the 2nd channel segment. Click the In/Out Condition for Element **** 
button . 

Fill in the dialog box as shown below and click OK. 

lu Out fund1lmu rot Gnd Element t 187 

r !rllow element wth hydrograph 

r. Ol111ow element (no !Jydiog~apll) 

("" OIJfkw-1 element wllh hyd'ogaph (diversaonJ 

r Ql1tlow elemerl with ~age-time relallomhrp 

r Dl111ow elemerl with <!age-time and free 
lloodpion ond chomel 

r Floodplon r Chllrl<IOI r. FlOOdPLion and' 
Channel 

r !;hanneiO<JIIow elemerl (wdh stage<lscharge) I 

r Mo n llow/ot.i!low condlion 

The elevation of the channel thalweg associated with a channel outflow 
node must be lower than that of the upstream node. When the channel 
geometry is set to rectangular or trapezoidal, the GDS assigned the thal
weg elevation relative to the grid element elevation. In order to ensure 
the thalweg elevation of the outflow node is lower than the upstream 
node, it may be necessary to lower the grid element elevation of the out
flow node . 
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Step 12: Save and run the model 

Summary 

i Ivlax u u 
I Flow Depth5; 

i! 
, I 

r-
1 

il 

I. epth --~~nd 
~ •J ... DL H ..- .; ! 
4 $ ~ . , • )-{ ... - $ o.i 

This example project covered the steps to build a simple rectangular 
channel. It demonstrates the ease of creating channels with the GDS. 
There are additional channel defining tools available in the GDS. For 
Example, the GDS can also import and interpolate natural channel ge
ometry. It is possible to import channel profiles and cross sections from 
HEC-RAS and define bank elements elevations and locations. 
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Review Questions 

1. Describe 2 ways to set the bank element elevation for a rectangular channel. Which is 
default? 

2. Two-dimensional channel flow in FL0-2D is simulated in an algorithm similar to the 
HEC-RAS unsteady flow model? (True or False) ________ _ 

3. Describe 3 methods to edit the bedslope of a channel? ___________ _ 

4. What are the four types of channel cross section used in the FL0-2D model? 

5. The XLEN variable in the CHAN.DAT file represents which ofthe following? 

D Channel length between cross sections 

D Channel top width 

D Channel length inside the grid element 

D Distance between the centers of channel nodes 

6. Each channel must have an inflow and outflow node? (True or False) ______ _ 

7. A description ofNOFLOC assignment can be found where? Check all that apply . 

D Data Input Manual Chapter 2 

D Basic Channel webinar video 

D Channel PowerPoint presentation in the FL0-2D Help folder. 

8. The channel default n-value 0.04 is reasonable? (True or False) _______ _ 

9. What are NOFLOC's? ______________________ _ 

10. When is it necessary to unassign a NOFLOC? 
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LESSON 4- HEC-RAS CROSS SECTION CONVERSION 

Overview 

Required Data 

File Content 

Many FL0-2D projects require improving existing flood hazard maps by 
using an integrated channel and floodplain flood routing analysis. For 
some of these projects, the HEC-RAS cross sections will be used to con
struct the channel data base. This lesson will show how to automatically 
create a FL0-2D cross section file (XSEC.DAT) from an existing HEC
RAS file. This is straightforward process that involves locating the origi
nal HEC-RAS geometry data file and converting it to the XSEC.DAT 
file . 

A HEC-RAS cross section file will also be needed for this lesson . 

Location* 
Houston.g06 HEC-RAS Cross Section File Example Projects \Lesson 4 

*Typically these folders are in installed under C:\ Users\Public\Docurnents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

To convert HEC-RAS cross section data to an XSEC.DAT file using the 
GDS, follow these steps: 

• Open the Grid Developer System (GDS) program; 
• Access the cross section conversion application; 
• Load the HEC-RAS cross section file; 
• Save the XSEC.DAT file; 
• Verify the new cross section data . 
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Step 1: Open the Grid Developer System program 

Double click the GDS Basic icon from the desktop. 

Step 2: Convert HEC-RAS Cross Section 

The CHAN.DAT file does not have to exist to create the XSEC.DAT file 
from HEC-RAS file using the conversion tool. Click on 'Convert HEC
RAS Xsec to FL0-2D ' command under the 'Tools' menu. 

Create :~Cr~:oc :~et;,.nel'll. 
Create street Se~ent With I!! Poly\1ne 

Create DetentiOn ~s!n 

f.'\Jd and Sediment Tr¥\SI)OI't 

Evaporation 
MOOFL0.20 SrmAatoo 
HycltatJc striXtt..res 

Breach 
NOFLOCS 
Find Watershed 

Convert HEC -RAS Chomels to FL0-20 Charnel Segnerts 

leeve Profile 
Street Profile 

A dialog box to initiate the conversion will appear. Click on the type of 
HEC-RAS file that is to be converted. In this case it is a typical HEC
RAS file with a *.g?? extension. 

r Coove~t GEO-RAS File 

r. Conve~t HEC·RAS Fie 

Click on the 'Convert' button to locate the HEC-RAS file (Houston.g06) 
to be converted. This file located in the Lesson 4 subdirectory along 
with the other project data files. 
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WARNING: The HEC-RAS 
cross sections are probably or
ganized from downstream to up
steam. If this is the case, it will 
be necessary to rewrite the 
XSEC.DAT from upstream to 
downstream. 

lmporiii[C RAS cross sect1ons / ~ 

jhous!on.g~ 

jAocfivo HEC·RAS (". g??) 

r Open a: read·oNy 

FL0-2D Model Lessons 

Open 

Cancel 

Click on the 'Open ' button to display a second dialog box to select the 
FL0-2D data file name to be saved . 

No items match yot.'f search . 

Fie nome: I !1111iE1J 
s- OS !VIM!: IArcnvo FL0·2D (•.dot) 

Save Cancel 

I ~ 

3 
3 

Enter the File Name: 'XSEC.DAT' and click the 'Save ' button and the 
following dialog appears confirming the conversion to the FL0-2D data 
file format is completed . 

This completes the HEC-RAS cross section data file. conversion process . 

Step 3: Validate Cross Section Data 
Open the XSEC.DAT file with any text editor such as WordPad© or Ul
traEdit©. The cross section data will look something like the following: 

X 19 
1000.00 4670.00 
1200.00 4666.00 
1300.00 4664.00 
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NOTE: The program may 
not need all the HEC-RAS 
cross sections that were writ
ten to the XSEC.DAT. Re
view the XSEC.DAT and de
lete any unnecessary cross 
sections. 

Summary 

155.04 664.00 
1590.00 4660.00 
1600.00 4659.00 
1610.00 4660.00 
1635 .00 4668 .00 
1665.00 4670.00 

Each cross section begins with an identification character 'X' and a cross 
section number ' 19' on the first line. Subsequent lines contain station and 
elevation data. Some of the cross sections are missing a cross section 
name. The conversion program did not print the name on all cross sec
tions because it was missing from the HEC-RAS data. The GDS Pro uses 
the Rivermile instead of the description so all cross sections get a name. 

Check that each cross section for the appropriate data. For example, the 
HEC-RAS data may not be spaced uniformly because it is missing a dec
imal place. This can cause the conversion to shift a decimal place. Make 
sure the station data in column 1 is always increasing. In the following 
corrected data file, see that the name was added in line 1 and the station 
(1550) and elevation data was corrected as underlined below: 

X 19 Goatl9 
1000.00 4670.00 
1200.00 4666.00 
1300.00 4664.00 
1550.00 4664.00 
1590.00 4660.00 
1600.00 4659.00 
1610.00 4660.00 
1635.00 4668.00 
1665.00 4670.00 

This lesson demonstrated how to extract and convert HEC-RAS cross 
sections to the FL0-20 XSEC.DAT file. Once this process is complete 
review the XSEC.DAT file, remove any unnecessary cross sections and 
proceed to locate the cross sections in the GDS with respect to the pro
ject channel. Then in the GDS outline the channel and perform the cross 
section interpolation. It may also be necessary to review the cross sec
tions to ensure that they have appropriate top of bank elevations. 
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Review Questions 

1. True or False? Each channel element must have a surveyed cross section? ____ _ 

2. True or False? FL0-2D will use all the HEC-RAS cross sections? -------

3. Which portion of the HEC-RAS cross section does the FL0-2D model use? 

4. True or false? FL0-2D requires a name for each cross section? ________ _ 

5. True or false? HEC-RAS cross sections may be spaced closer together than the FL0-2D 
grid element spacing? 

6. True or false? HEC-RAS cross sections may be spaced farther apart than the FL0-2D 
grid element spacing? _____ _ 

7. The HEC-RAS cross sections are primarily important in the FL0-2D model for which of 
the following? 

0 Channel length inside the grid element 

0 Channel cross section flow area 

D Channel n-value 

0 Channel energy slope 

0 Channel surface area 

8. Complete this statement: "The HEC-RAS cross section data must be edited if the flood-
plain elevations are . .. " ____________ _____ ____ _ 

9. True or False? If the HEC-RAS cross sections are separated by more than one grid ele-
ment, the cross section data must be interpolated? ______ _ 
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File 
*.dat 
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LESSON 5- PROFILES CROSS SECTION INTERPOLATION 

Overview 

Required Data 

Content 

Note: In GDS 2009 the cross section interpolation is automated. It is no longer 
necessary to perform the initial interpolation as described in this work
shop. It is still possible to perform those steps and that is why they are 
presented here. It is also possible to perform interpolations between one 
or more cross sections and that is described in below the automatic inter
polation steps . 

In most river-reach data bases, there is only one surveyed cross section 
for every five to ten channel elements. It is necessary therefore to inter
polate cross section elevation and geometry for those channel elements 
between the surveyed cross sections. Between two surveyed cross sec
tions, the channel geometry is variable and thus interpolating between 
the surveyed cross sections enables the channel elements to have a 
unique cross section shape. This lesson shows how to use the PROFILES 
program to interpolate cross section data and link it to the channel ele
ment data . 

The profiles program requires the six basic data files plus two channel 
fi les. These files already exist and are found in the folder Lesson 5 . 

• CONT.DAT • CHAN.DAT 
• CADPTS.DAT • XSEC.DAT 

• FPLAIN.DAT 

• TOLER.DAT 

• INFLOW.DAT (optional) 

• OUTFLOW.DAT (optional) 

Location* 
Grid System Data Files \Example Projects\Lesson 5 

*Typically these folders are in installed under C:\Users\Public\Documents \FL0-2D Basic Documentation 

Step-by-Step Procedure 
To interpolate cross section data using the PROFILES program follow 
these steps . 
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• Create a new project folder 
• Open the FL0-20 GDS and load the Lesson 5 project; 
• Examine pre-interpolation channel data files ; 
• Open the PROFILES program; 
• Automatically interpolate all cross section data; 
• Examine the post-interpolation channel data files; 
• Edit a cross section; 
• Manually interpolate between two cross sections. 

Step 1: Create a new project folder 

In Explorer, copy the folder C: \Users \Pub/ic\Documents\FL0-2D Basic 
Documentation Example Projects\Lesson 5 and rename it to Lesson 5.1 . 
If irreparable mistakes are made, start over with the Lesson 5. 1 folder. 

Step 2: Open the data files in NotePad 
Browse to the folder Lesson 5 and open CHAN.DAT and XSEC.DAT in 
NotePad. 

ales~~ __ -, 

) • • FLo-lDs-:-....,tatioo • El<4ml>oPI"oje<:ts • Leson 5 

~ • ~Ope> Share With • Pmt E...,.. Blrn New fulde- rJ 

ls.z.. I I 
:! cA[)P'T'5.o.n 4/B[lJJOJ 12: 19 PM DATF1e 61KB 

· - CH.\N:!A.'~JC OAT S{27/7SYJ9 11:38 A'1 OAT R!e 1KB 

~ CO~IT . OAT llf l/ L009 4: 38 ~ 0'-T Fie 1KB 

• . FPLAIN.DAT 5/6/<DfYl1:07PM OAT Fie 871(8 

. +!f'fl.OW.DAT ll/l/L009 4:41 PM OAT Fle 1KB 

'!_ CX}""'l=lQY/ .0.\T ll/1/WOCJ 4:42PM OAT Fie 1KB 

• TOURDAT !0/28{2JJ07 1:26 PM OAT Fie 1KB 
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Step 3: Examine the pre-interpolation channel data files 

IJ CHAt' OAT rlotepad ' • 

1 o.oo o. 7o o. oo 
N 1477 0. 040 100.00 
N 1444 0. 040 100. 00 
N 1408 0 . 04 0 100 . 00 
N 1369 0. 040 100 .00 

lllO 0. 040 100. 0 0 

1 
0 
0 
0 
0 

IJ XSEC.OAT flotepad ::t 

Fie Edit Format VIew ~ 
I X SS-10 

1 . 3 7 1 2. 3 2 

"' · 1 2 1 1. 1 1 
11. 75 9 . 2 4 
26 . 3 9• 7. 24 
2 7. 4 7 6 . 5 8 
30 ~ 4 7 6. 41 
31. 49· 7. 2 8 Note: The use WordPad, NotePad or 
4 6 . 42 7. 4 3 
54 . 9 & 7. 38 any text editor to view and edit the 

FL0-20 data files . 
N 91l 0 . 040 100.00 
N 86l 0.040 100.00 
N 815 0.040 100. 00 
N 768 0 . 040 100. 00 
N 721 0.040 100 . 00 
N 6 75 0 . 040 100.00 
N 6 30 0 .040 100. 00 
N 586 0 . 040 10 0 .00 
N 54 2 0 . 040 100 . 00 
N 500 0.040 10 0 .00 
N 458 0.040 100. 00 
N 41 7 0.040 100 .00 
N 377 0.040 100. 0 0 
N 33 8 0. 040 100 . 00 

298 0 . 040 100 . 0 0 
26 0 0 . 040 100 . 00 
224 0 . 04 0 100 . 00 
189 0 . 040 100 . 00 
154 0. 040 100. 00 
119 0.040 100 . 00 

8 5 0 . 040 100. 00 

Warning: Natural river cross sec
tions should have at least 10 points 
to define the channel geometry. If 
there are less than 6 points, the in
terpolation will fail. 

8 2. 80 11.19 

4 
lx 3: . :~ 55 - ~~ . ~: 

0 1. 37 11.63 
0 4 . 1 2 10 . 42 
5 11. 7 5 8. 5 5 
0 2 6 . 39 6 . 5 5 
6 2 7. 4 7 5 . 89 
0 30 . 4 7 5. 7 2 
0 31. 4 91 6 . 59 
0 46 . 42 6 . 7 4 

7 54. 9£, &. 69 
82 . 8 [) 10 . 5 0 

l x g: . ~~ 55- ~~ .r: 
1. 0 0 1 1 . 4 8 

18 . 00 6 . 91 
2 4 . 00 6 . 4 0 
46 . 00 6 . 3 2 
49 .00 4 . 86 
5 3. 00 4 . 6 5 
5 6 . 00 4 . 9 3 
5 9 . 00 5 . 38 

0 
0 
8 
0 
0 
9 
0 
0 
0 
0 

10 

~ 
81.00 6 . 0 5 

~ 

The O's in the last column of the CHAN.DAT file represent channel 
elements that do not have an assigned surveyed cross section. In 
the following steps, an interpolated cross section is created for each 
channel element and replace the O's. 

In the XSEC.DAT file, there are only 10 surveyed cross sections. 
These are assigned to the CHAN.DAT in the last column. Assign
ments are based on the geographical location of the cross section 
coordinates in proximity to the channel element coordinates. The 
first and last channel elements in a segment should have a surveyed 
or cut cross section . 

Step 4: Load the Project in the GDS and run the PROFILES program 

Double click the GDS Basic icon from the desktop . 

New Project 

Open . TOP Project .. . 

Save , TOP Project ... 

Save Fl0·2D Foles ... 

Run Fl0 ·20 .. . 

RunMawer 

RL<l PROFilES 
Rlii"I RAT• • 

Click the File menu in the GDS and select the 
Open Existing FL0-2D Project command on 
the File menu . 
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Browse to the folder C:\Users \Public\Documents \FL0-2D Basic Docu
mentation Example Projects \Lesson 5 and double click the file 
FPLAIN.DAT. 

(~ Select a fPt.AINJ>A T file to open :( , 1 

_!. FPt.AIN .OAT S/7/ 20 13 1:08 P\''>1 OAT F·'e 

~----·~~==~====~~~==~~~ 
f; lo ... .,., IFPLAIN.DAT 3 I<FP LAJN.OAT) 3 

Open •J Cane.! I 

From the GDS, click the File menu and click Run PROFILES. 

New P<oject 

O!>en .TOP Project. .. 

O!>en Exislrg R.O·l!> Project. .. 

Save .TOP Project. .. 

RlJn A.O·l!> ... 

RIJnMopoer 

Initially, the PROFILES program will display a blank screen with a 
toolbar showing options to View Segment Bed Slope or Interpolate 
Segment Slope/Shape. 

Click the View Segment Bed Slope View Segment Bed Slope I button to 
display the initial bed profile. Notice the stair step pattern. This is 
the bed slope of the channel. It indicates that there are no cross 
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sections between the surveyed cross sections resulting m a flat 
slope . 

Channel Bed Profile FL0-20 Channe l Bed - -

"' ~ " " 0 ';! "' 0 ~ ~ ~ N ~ " ~ 0 m ~ ~ " ~ GRID 
rl ~ 

ELE~IEllT 

Step 5: Automatically interpolate cross section data 

Click the Jnte1polate Segment Slope/Shape Interpolate Segment Slope/Shape I 
button and the following dialog box will appear. This states that 
the original cross section names will begin with an X- to help iden
tify surveyed cross sections. Click OK. 

Ctoss Section Name -

The original [surveyed) cross sections are now 
ident~ied with a ''I<·" preceding the name. 

I OK I 

PROFILES will automatically locate the surveyed cross section 
data and interpolate the cross section geometry and elevation 
(thalweg slope) to all those channel elements between the surveyed 
cross sections within the segment. Notice the bed slope of the 
channel has been smoothed out compared to the previous staircase 
pattern . 
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--Cl1.ck on the Vl.f' Lc :al Reacl, 
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Click the Save button and the following dialog box will appear. 
This box states that the original data file was preserved. Click OK 
and the second box appears. Click the Replace the files radio 
button and click OK. 

Note: The original cross sections may 
extend beyond the channel banks 
across the floodplain. If floodplain 
cross section stations have elevations 
beyond the top of bank elevations, 
those stations should be deleted 

Note: Do not replace the CHAN.DAT 
and FPLAIN.-DAT files unless backup 
files have been created. 
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'iave Cross Section Oata 

The cross section data will be saved in the file 
XSEC.DAT. Each grid element will be assigned 
a cross section and the cross section number 
will be the grid element number. The XSEC.BAC 
file wil contain the original cross section data. 

Cancel 

Select OK to save all the 
channel slope adjustments. 

OK 

If the channel bed slope was mod~ied. 
remember to replace the CHAN.DAT 
and FPLAIN.DAT w~h the modified files 
CHAN.NEW ~nd FPLAIN.NEW. 

r. Replace the files 

OK 
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Step 6: Examine the post-interpolation channel data files 

~~ 01AU OAT - tlotepad '! 

0 .00 0. 70 0.00 
N 14 77 0.040 100.00 1 

1444 0. 040 100.00 2 
1408 0. 040 100.00 3 
1369 0. 040 100.00 4 
1330 o. 040 100.00 5 
1289 0. 040 100 . 00 6 

N 124 5 0. 040 100 . 00 7 
N 1200 0.040 100 . 00 8 
N 1154 0 . 040 100.00 9 
N 1108 0. 040 100.00 10 
N 1060 0 . 040 100. 00 11 
N 1011 0. 040 100.00 1 2 
N 963 0. 040 100.00 13 
N 91 3 0.040 100.00 14 
N 8 63 0.040 100.00 15 
N 815 0 . 040 100.00 16 

768 0. 040 100.00 1 7 
721 0.040 100.00 18 

N 67 5 0.040 100.00 19 
N 630 0. 040 100 . 00 20 
N 586 0. 04 0 100.00 21 
N 542 0 . 040 100.00 22 
N 500 0.040 100.00 23 
N 456 0.040 100 . 00 24 
N 41 7 0.040 100.00 25 
N 377 0. 040 100.00 26 
N 338 0 . 040 100 . 00 27 
N 298 0. 040 100.00 28 
N 260 0. 040 100 . 00 29 
N 224 0 . 040 100.00 30 
N 189 0. 040 100 . 00 31 
N 1 54 0. 040 100 . 00 32 
N 11 9 0 . 040 100.00 33 
N 85 0 . 040 100.00 34 

Reopen both files in NotePad. Notice that the cross section data is 
filled in the last column ofthe CHAN.DAT file and there are now 
34 cross sections in the XSEC.DA T file. The cross sections with 
an X- in the name are surveyed and the others are interpolated . 

I) •· ... ..Jgj~ 
Fie Ed~ Fom>ai Vim Keb 
IX 1 x-s s - 10 

J 1:4 12:32 
4.1 11.11 

11. 8 9. 24 
26.4 7 . 24 
27. s 6. 58 
30. s 6. 41 
31.5 7 . 28 
46.4 7 . 43 
55.0 7. 38 

~~ · ~ 11.~; 
X 2 ss-10 I 

1:4 12: 2o 
4.1 10.23 

11. 8 8 . 36 
26.4 6 . 37 
27 . 5 6. 40 
30. 5 6 . 29 
31. 5 6.41 
46.4 6. 56 

~~· ~ , ~·~3 
X 3 ss- LO I 

1.4 i2:o9 
4. 1 10. 1 2 

11.8 8. 2 5 
26.4 6. 25 
27 .5 6. 29 
30. 5 6.18 
31. 5 6. 29 
46.4 6 . 44 
55 . 0 B. 32 

~ <j 

Step 7: Edit cross section data 

Click on the Pre-Processor pull down menu and click on 
PROFILES . 

On the PROFILES window, click View Segment Beds/ope button 
and then click the View Local Reach View Local Reach J button on the 
Too/bar. Notice the cursor changes from a standard arrow to a thin 
vertical arrow. Click the location shown on the screen to zoom in 
on a reach of 10 channel elements (5 upstream and 5 downstream 
ofthe cursor location) . 
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~Segro-ttBedSiope 

Cll.clc on the Vl.e Lt> ol Peach 
button ond u:~e the rP.OUse. a r rc 
to loc11.te a ceoch to nc;..dify. 

0 .• 
~ 

m ,, 0 
0 ,., 

Channel Bed Profile 

·-· " ~ 
0 

"' .. ,, .. 
" "' ~ 

,_ 
M 

FL0-20 Channel Bed---

~ .. 
N 

"' m 
CIU CI 

!;LEHENT 

' Click on View/Edit Xsection Data View/Edit Xsection Data button to 
view the following dialog box. 

td1l lhannel Bed Elevation 

Node:I106Q Upstrm Bed Elev: 4.92 

Bed Elevation: I 4.65 

1--~~-Dwnstrm Bed Elev: I 4.72 

Left Bank Elev: I 11 .57 

Right Bank Elev: I 8.92 

Channel Depth: I 4.27 

n-value: I 0.040 
Channel length: I 100.00 

Reach Length: j 1150.0 

View/Edit c1oss section Xsec I 
Interpolate 

Next, click on the Xsec Xsec I button in the dialog box to view the 
cross section data and plot. 
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Usc: the: UP or DOWU d.l.eloq buttons 
to rr.ove to • r.ew C[ O:!Ia sectt on . 

ChanneJ~ 

"' 0 ... ... 
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6 49. 4.86 

7 5l (.65 -=1 
fdt Uon51do1 
....!2L] o ... l 

St~ Elevamn 
~ 1000 1000 
R_,_,.......,.,jro:iii • 
Stoe.-.dXMc::lorl~ 

lrYe!POWe dope01 Xrecoon 

~~.:a;~~a 
Up.sb~m~ D~e.!lfTI 

~~· 
PlotXtt!OSCCI'.IIOepoct: __j 

Edtn-YM.Je I 0.040 

~ CEJ o 
EIIT 

At this point review some of the other cross sections by clicking on 
the "Up" and "Down" buttons in the dialog . 

Use the list to edit the individual cross section station data or add 
and delete stations. As an example of editing the cross section, we 
are going to raise the elevation of this cross section and then 
manually interpolate between it and its neighboring cross sections . 

Enter a 0. 5 in the text box next to the Raise/Lower xsection 
Raise/lower xseclion l button and click the button. One half foot has just 
been added to each station elevation point in this particular cross 
section . 
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. •• 0 

Node:rTii60 Xsec r--rr 
Xsec Name: IX·ss·8 

-.J:I.£J Return I Down I 

Sta. Elev. I ~ 

1 0.00 11 .57 

2 1.00 11 .48 

3 18.00 6.91 

4 24.00 6.40 1-

5 46.00 6.32 

6 49.00 4.86 

7 53.00 4.65 ..:.J 
Edit Cross Section I 
~ Delete! ' 

Station Elevation 

~ 1"0]0 1"0]0 
~ower xsection:l rlJ.5o' I 

Slope and Xsection lnterpolalion 
' Interpolate slope or Xsection 

shooe between two nodes: 

,f166o'8) 1'1"660 8:1 I 
Upstream Downstream 

SI!!J!e On~ I Sh!J!!!ISioe!l 

Plot Xsec Scour/Deposit .!..!:!2:!..1 
Edit n·value: ~ 

Close I []L) 

Now see that there is a spike in channel bed slope. 

00 
0 
rl 
rl 

' 0 

' (J ( 

Step 8: Manually interpolate between two cross sections 

To adjust the slope and shape for the revised cross section, it is 
necessary to interpolate between the cross section that was 
modified and its upstream and downsstream neighbors. 

In this case, notice that the changes were made to a surveyed cross 
section X-ss-8 (Node 1 060) . Click the Up button 4 times to reach 
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cross section X-ss-9. Now enter 1060 in the right interpolation box 
and click the Shape/Slope button . 

1 Slope and Xsection Interpolation 

! Interpolate slope or Xsection 
; shaoe between two nodes: 

112458:1 r;asoa 
II Upstream Downstream 

,_ Slope Only! Shape/Slope! 

Now click the Down button 7 times to cross section X-xx-7. Enter a 
1060 in left interpolation box and click the Shape/Slope button. To 
retain the cross section shape and only edit the bed slope, click the 
Slope Only button. 

I 
Slope andXsection ln.te.rpolation 
I nterpola!e slope or Xsection 
shaoe between two nodes: 

11060!:3 19i3[3 
Upstream Downstream I SlopeOnly! Shape/Sioeelj 

Click Close on the Edit Xsection Data dialog box and click Close 
on the Edit Bed Elevation dialog box. Notice the bed slope no 
longer dips at channel element 1060. Once editing is completed 
save and exit the PROFILES program . 

Channel Bed Profile 

Note: Adverse bed slope does not 
necessarily warrant cross section 
modification. If the bed slope appears 
to substantial deviate from the aver
age bed slope, it may be necessary to 
review the original surveyed cross 
section data base. 
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Summary 

Review Questions 

The PROFILES lesson was designed to show how to edit cross sec
tion and bed slope data. This program is a crucial tool when devel
oping a natural channel model. PROFILES can be used to interpo
late the channel data between cross sections and to edit the station 
elevation cross section data. 

1. Rectangular or trapezoidal cross section can be assigned with the natural shape cross sec-
tion option? (True or False) _____ _ 

2. When it is necessary to interpolate the channel cross sections? 

3. If a cross section has a levee that is higher than the channel top of bank, how far does the 
cross section extend? 

4. Channel flood routing primarily depends on which one of the following? 

D Channel length inside the grid element 

D Channel cross section flow area 

D Channel n-value 

D Channel energy slope 

D Channel surface area 

5. The channel geometry is measured to the lowest top of bank? (True or False) 

6. The last channel element in a segment must be a channel outflow node? (True or False) 

7. The automated cross section interpolation when building the channel data files only af
fects the channel geometry? (True or False) 
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LESSON 6- CREATING FLOOD MAPS WITH MAPPER 

Part 1. General Mapping 

Flood Maps, Layers and Exclusion Polygons 

Overview 

Required Data 

Content 

The MAPPER program generates numerous high resolution flood routing 
plots ranging from maximum flow depths and velocities to damage as
sessment. In this lesson, use the MAPPER program to graphically display 
model results, generate flood mapping, and modify layer attributes . 

For this lesson, the FL0-2D data files *.DAT and output files *.OUT 
found in the Lesson 6 subdirectory and the elevation data *.PTS in the 
Lesson 1 subdirectory are needed . 

Location* 
Fplain.dat Digital Terrain Model file Example Projects\Lesson 6 
dtm.pts Digital elevation points file Example Projects\Lesson 1 

*Typically these folders are in installed under C:\Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

Analyzing output data and creating flood maps with MAPPER will re
quire the following steps . 

• Open the MAPPER program and load project; 
• Display the grid system; 
• Plot maximum flow depth data; 
• Plot and customize shaded contours; 
• Modify layer attributes and legend properties; 
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• Add aerial images; 
• Create DTM shaded contour layer and export GIS data; 
• Create an exclusion polygon. 

Step 1: Open MAPPER and load the Lesson 6 project 
In the GDS, select the File menu from the toolbar and click Run 
MAPPER. 

Now Pro)<ct 

()pot> • TOP Pro)<ct ••• 

()pot> E>ostr1g R.Q-20 Project. .• 

s.noe .TOP Pro )<ct . •• 

S.V. R0·2D Fios .. . 
Rl.n A.0-20 •.• 

er..t.. - .OAT ond Cadl'ls.OAT 

""""' ""
~Sev·--ts 
~~Re . .• 
~Roo> Arclnfo ASCII Grd Flo .•. 
~.t£<:-RASo..m.ls ... 

'"-l CADGr~s.-nts .•. 

Salle e:evam Pallts ... 

f>Dort .. . 

On the Mapper Toolbar, open the project output files by clicking on File 
and Read FL0-2D Results ... as shown below. 

841 Workshop Lessons 
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Locate the project file folder and click on the Open button . 

I j j ~ Q] f Se.,.ch Lesson 6 

.!_ FPLA!l'J.OAT 5/2/2009 2:05PM OAT "le 386kB 

~----~~==~========~~~==~~ 
File nome: IFPLAIN.DAT :.:J f<FPLAIN.DAT) :::J 

I Open ~I C•ncel I 

The grid element topography will be displayed . 

"'e V-Took fieb 

ll.l"<lrll 21 Z.:l !:..:l .!!.:l ~.:J .:!!..:l ...!..:l ~.:J ~.:J .ftl 

Note: Every MAPPER generated plot 
is also saved as a shape file in the 
project folder. These shape files can 
be used with other GIS programs for 
further mapping opportunities . 

Grid Element Ground Surface Elevation 
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4,7ri/3.7 

4,779.6 
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4,741 .5 
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Step 2: Display the grid system 

:&,IE400 I 1 19561600 I.e! 

The grid system can be displayed with all MAPPER graphics. Click 
View/Display Grid System . 

View Tools Help 

100% 

Zoom Out 

Pan 

Layers List 
rl . ,ath·m~ R~:-- jFo ("' 

Grid Element f\Unbers 

Display Boundary Cells 

>1 Display Title 

Display Exclusion Polygons 

"' Display Legend and Scale 
., Display All eel Groups 

"' Display All Slices 
Display Area of Inundation 

Table of Variables 

Highlight Grid Element Nunber ..• 

Redraw 

Grid Element Ground Surface Elevation 

1.332 4.7152& H1 5..2G 000 000 

Tum off the grid system using the same procedure. 

4,817 .8 

4,7!e.7 

l ,n9.6 

4,760.6 

4,7415 

4,722.A 

4}03.3 

4,684.3 ..... , 
<= 4,6.46.1 

Step 3: Plot maximum flow depth at cell 
It is necessary to plot the grid element maximum flow depth to ini
tiate other mapping options such as animation. Click on the icon 

Max Flow Depth at Cell :I! .:J pull down menu and clicking Max 
Flow Depth . 
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Max Flow Depth (Coni:OLI's) 

Max Flow Depth (Shaded Contours) 

Final Floodplain Flow Depths 

Final Floodplain Flow Depths (ContOLI's) 

Final Floodplain Flow Depths (Shaded ContolJ's) 

Max Chamel Flow Depths 

Max Channel Flow Depths (Contours) 
Max Chamel Flow Depths (Shaded Contours) 

Max Combined Channel and Floodplain Flow Depths 

Max Combined Channel and Floodplain Flow Depths (Contours) 

Max Combined Channel and Floodplain Flow Depths (Shaded Contours) 

Max Street Flow Depths 

Max Street Flow Depths (ContOLI's) 

Max Street Flow Depths (Shaded Contours) 

The grid element maximum flow depths are displayed . 

Grid Element Maximum Flow Depth 

'"' 5.6 

5.0 

0 

3.7 

3.1 

2.5 

1.9 

1.2 

0.6 

<=0.0 

1~ 

Plot the many grid element maps using the icon tool bar at the top of the 
screen. This includes . 

• Ground surface elevation 
• Maximum water surface elevation 
• Final floodplain depths 
• Maximum channel flow depths 
• Maximum combined channel and floodplain depths 
• Maximum street depths 
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• Maximum floodplain velocity 
• Maximum street velocity 
• Maximum channel velocity 
• Final floodplain velocity 
• Duration of inundation 
• Maximum impact force 
• Maximum static pressure 
• Maximum specific energy 
• Levee freeboard deficiency 

The plots are saved as shape files as soon as they are loaded and are 
found in the project folder. 

• te-;.son 6 ~- _ _ ___ .' :..._" 

• CiJ J Se¥ch l esson 6 

.J f) 

~~~------------------------~~~~~~~~~~~~~~lr~~~- ------L~ ~~---L------~~ 
STREET .RGH Sj S/1fXJ9 12:25 PM RGH R.~ lOI<B 

~vabon at Cel.st:p S/ !2/201] 9: 56AM Slf' Fie 6571<B 
.-

Fnal Flow Deo'ih "t c ·'"" S/ 12/20!3 9:57AM St9 Fie DI<B 

Flo"" Depth at Ce!!. shp 5!12/LOlJ 9:56 A."'1 5H' Fie 2081<B 

__ , !rfl.ax Charnel Flow Depttl at C .sho St12{20 13 9:57 I\J"V1 5H' F~e l41<B 

Max O.arnel Pow 't'elooty at cea.~ 5/ 12jW13 9: 57AM St9 Fie !41(B 

Max Cor"':b:ned Chamel and Fbodola:n Flo·:.• Depth at C .sho 5/ 12/ all3 9:57AM 5><' F<e 214KB 

_, f'e!ootv a t Cei (Vectofs).sho 

•'e'octy at C .sho 

Are" ofltu'ldabon.shx 

Sevabon at Ce~.shx 

5/ t2/'Z0 139:57AM SHP Fie 

5/ !2/2013 9:57 AM Slf' File 

5.'7/'XHJ 2:42PM ShX R!e 

Sfl2_iW139:56AM SI-'XR'e 

7721(8 

2081<B 

l i<B 

39 1<B 

J 

Step 4: Plot and customize max flow depth (shaded contours) 
The maximum grid element flow depths can be plotted as shaded con
tours. 

Max Flow Depth 
Max Flow Depth (Contours) 

Final Floodplain Flow Depths 
Final Floodplain Flow Depths (Contours) 
Final Floodplain Flow Depths (Shaded Contours) 

The flow depths are the maximum depths that were computed regardless 
of the time of occurrence. The maximum depth plots therefore display 
the maximum area of inundation. 
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Note: The scale and legend can be 
moved around by mouse click and 
drag. 

Grid Element Maximum Flow Depth 

FL0-2D Model Lessons 

0.6 

The shaded contour plot can now be customized by selecting more con
tours, identifying a prescribed contour interval or by specifying the indi
vidual contour intervals as shown in the following dialog box . 

To display this dialog box, right click anywhere on the contour plot. In 
this instance, the Add button was selected and contour intervals every 0. 5 
ft were added to the list of contour values along with an initial contour of 
0.1 ft . 

Contcx.rs desa4>6on 

Nurrbelolcontcx.rs r ~ 

lncremenl r r-- M .. vakJe r.l5.-;:;57 __ _ r
5

tou vaiu"'i r. j ~ Min. value: lo 
fles-tore Oefds ( Q*t•l ~--~ . 

5 
~ ~ 

Contcx.r smoothn= (0 to 10) ro--
r FMer cells wih zero flow de<Jih 

W OrM.Iowet contour 

r Closed coniDI's ony 

L¥1s. I r Show label; 

QK Cancel 

Click OK to display the shaded contour. The area of inundation is smaller 
because the lower contour was omitted . 
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Grid Element Maximum FIO'N Depth 

Note: Use the Contour Values to con
trol the number of contours in the 
shape file. 

12 

0.6 

<"-0.0 

1JJD 
5lll 

Step 5: Modify layer attributes and legend properties 
To enhance the shaded contour plots create transparent shaded contours. 
To make the shaded contours transparent, open the layer 's list. Click 
View/Layers List . 

View Tools Help 

IOOo/o 

Zoom Out 

Pan 

Gnd Element Nt.nlbers 

" Display Grid System 
Display eoo.n:t .. y eel~ 

~· '" ''P.~ "'1tJ~~: _ _ , , , .... ..... . , ... ......... . 

Next double click on the Flow Depth at Cell (Shaded Contour) layer as 
shown below. 
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Flow Depth at Cell 
Elevation at Cell 
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Select the Gray fill or Light gray fill in the Style list of Symbol Properties 
dialog box. To accept changes, click Apply and Close . 

-. Syn1bol propert1e c;. fo r ttw FLOW (IEPitl AI Cfll !dyer . 

Loyer nome row Depth ct Cell 

Shape Fila Type folygon 

Number of Record s 1 BJ 

The Closs Bresks cte.ssrticotion appli es symbols to a set of d1saete veJue£ 

S1ngle 

Numencfield 

jvor 

FLOW DEPTH AT CELL-Ve< 

Less then 0 00 
0.00 - 0.07 
007 -0 13 
013-020 
020 - 027 
0.27-033 
0.33- 040 
0.40 -0.47 
0.<7 -0.53 
0.53-060 
0.60 -0 67 
067-0 73 
073-080 

Oose 

Color romp. 

Start 

End· 

r Or ow outlines? 

Reset Legend I 

Also close the Layer List dialog box and the following shaded contour 
plot is generated . 

Grid Element Maximum Flow Depth 

'"' 5.6 

5.0 

4.3 

3.7 

3.1 

2.5 

1.9 

1.2 

0.6 

<=0.0 

The legend and scale properties and location can be adjusted. This fimc
tion works well if while capturing a screen shot of the MAPPER window . 
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Click and drag the legend and scale to a new location on the window. 
Right click the legend and click Legend Properties . 

DTM Points Ground Surface Elevation 

Change the number of decimal places, color and size of the font as well 
as other legend properties with this dialog box. 

lcyend Properties • 

Number of calms in legend: j 1 0 

Number ol v.-lues in legend: j1 0 

Nl.llber of decimals: 11 

Round to integer w 

font .. 

8pply !;lose 

Step 6: Add aerial image to background 
Import the aerial background images . Click File/Import Image/Import In
dividual Image to load the Goat.tif image in the Lesson I Folder. 
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~ View Tools Help 

Re~d FL0-2D Results ... 

Import Elevation Points 
Import Sh~pe File ... 
Import ASCII Grid Fie .. , 
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Image Cat~og ... 

Click View/Layers List and highlight the Goat image. Move it to the bot

tom of the list using the arrow Ill button . 

Flow Depth at Cell [Shaded Contour) 
Flow Depth at Cell 
Elevation at CeO 

~ Ill p ~isible r Qelete 

Click Apply and OK. 
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Step 7: Create depth to DTM point plot 

Warning: This step can be time con
suming. 

Enhance the resolution of flood hazard maps by plotting shaded contours 
of the DTM point flow depths. First the DTM points will have to be im
ported. Then MAPPER will subtract the DTM ground elevation points 
from the grid element predicted water surface elevations. Finally, the 
shaded contour plots can be created. 

Click Import Elevation Points/Import DTM Points ... in the File menu. 
The dtm.pts file is located in the Lesson I folder. 

Read FL0-20 Results .. . 

Import Image 

Import Shape File ... 

Import ASCII Grid File ... 

Save Elevatl,.m Po1nt~ .. 

DTM Points Ground Surface Elevat ion 

~ I 
Arcinfo ASCII Grid File ~ 

'"' 

4.7 127 ,...,. 
4,666.9 

~ 4,6« .0 

l70.26820 1185.71'500 feet 4822 4.65400 4.B'i4 10 010 002 

Now interpolate the flow depth to the DTM points and subtract the DTM 
point ground elevation from the grid element predicted maximum water 
surface elevation. Click Tools/Interpolate to DTM Points . 
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Options 

Create Elevation Points Layer 
Delete Elevations from Selected Area 

Create Area of Inundation Layer 

Exclusion Polygons 

Plot Flow Depth Profile 
------1 

Map Template 

Flooding Damage 

FL0-2D Model Lessons 

lnterpolatron Options .~ 

Minimum number of DTM 
points to consider in the l r.::h---

vicinity of each grid element: I< 

A adius ol interpolation 
[proportional to grid ..,.11---

efement si2e~ 

Resolution [2 to 5): p 

Use DTM points el<tent only. P 

QK .[;ancel 

The Interpolation may take several minutes. Do you want to continue? 

Yes No 

Click OK and Yes and wait for the interpolation process to complete . 

To plot a shaded contour representation of the maximum interpolated 
flow depth over the DTM points, click the DTM Points Max Flow Depth 

.EJ..:J button. Note that some of the DTM points were based on topo
graphic contour lines . 

The DTM point maximum flow depths can be saved to file by clicking on 
the FL02DGIS command in the File pull down menu. The 
FL02DGJS.OUT file will contain the grid element number, the x- andy-
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coordinates and the maximum flow depth over the DTM point. This file 
can be imported to ARCGIS to utilize additional mapping tools . 

• •• 
Include variable values coming from: 

Pg~~I~~ 
P Q. T M points 

Click OK and Save to create the FL02DGIS. OUT file. 

Step 8: Create an exclusion polygon 
Exclusion polygons can be used to edit shaded contour plots. Construct
ing shaded contours can result in the mapped area exceeding physical fea
tures on the map . This occurs when the contour plots are not controlled 
by break-lines or by the contour interval. To improve the appearance of 
the shaded contours, delete a portion of a contour shapes. An example 
where the use of exclusion polygons is appropriate is when a shaded con
tour spills over a levee, bluff or raised highway. 

Load the Max Flow Depth at Cell (Shaded Contour) layer by clicking 

Max Flow Depth at Cell l" .:J pull down menu and clicking Max Flow 
Depth (Shaded Contour) . 

Click the Exclusion Polygons/Create Exclusion Polygons command on 
the Tools menu. 

r Tools ~ 
Options 

Creal!! /ll:ea of rrundation layer 

Plot Flow Depth Profie 

MapTemplal!! 

Aoodng Damage 

*'*!§§i!Q$!.1' i§$1: 
Apply Exdusion Polygons to c~t Graph 

Click OK and draw one or more polygons on the flow depth shaded con
tour plot. 

II 0 20 '1apper · -

i. ) ~ Click OK and then draw polygons to define exch.Jsions areas 

OK Cancel 
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Assume for this step that the highway is raised and that water cannot 
overtop it. In the following image, all of the flow depth that coincides 
with the highway is a contour spill. Remove the contour spill by deleting 
the portion of the plot that coincides with the highway. The exclusion 
polygons define the area that is erased from the shaded contour plot. The 
image below shows a polygon that will edit the highway portion of the 
shaded contour. 

4.695 66 000 000 

Click Tools/Exclusion Polygons/Apply Exclusion Polygons to Current 
Graph . 

Options 

Interpolate to DTM Points .,-,-----
Create Elevation Points Layer 

Delete Elevations from Selected Area 

Create Area of InLndation Layer 

Create Exclusion Polygons 

Plot Flow Depth Profile 
,:.._,~I c. · ~ t .. •r1 t,, _ _ • r1t -.:::· J_ • 

Map Template 

Flooding Damage 

Click View/Display Exclusion Polygon . The portion of the shade contour 
within the polygon was deleted . 
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368.1116.60 1,195,01000 Jed 2.712 .. ,67874 4.'7874 000 000 

The exclusion polygons can be used multiple times. Just load a shaded 
contour and click Tools/Exclusion Polygons/Apply Exclusion Polygons to 
Current Graph . 

To control the polygon click its border. Click the Use/Not Use for Cur
rent Graph to select or deselect the polygon that was clicked. It's also 
possible to delete the polygons with this tool. 

Delete This Exclusion Polygon 

Delete AH Exclusion Polygons 

The following image shows the shaded contour with the highway portion 
removed. The Flow Depth at Cell (Shaded Contour) shape file was au
tomatically saved and will also reflect these changes. 
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2.93' 4.67'390 • .S7990 000 000 

To revert back to the original shaded contour plot, close and reopen 
MAPPER and start fresh . 
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Part 2. Advanced FL0-20 Results Analysis and Mapping 

2a. Flood Animation 

Overview 

Required Data 

Content 

The MAPPER program can be used to create the model flood animations . 
This lesson will show how to view the FL0-2D simulation as an anima
tion of the floodwave progression . 

Use the FL0-2D data fi les *.DAT and output files *.OUT including the 
animation *.OUT files found in the Lesson 6 subdirectory . 

Location* 
FPLAJN.DAT Digital Terrain Model file \Example Projects\Lesson 6 
TIMEDEP. OUT Animation file \Example Projects\Lesson 6 

*Typically these folders are in installed under C:\Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

The following steps are necessary to run the flood animation in MAPPER 
and view temporal results . 

• Set the animations controls in the CONT.DAT prior to the flood 
simulation . 

• Open MAPPER and load Lesson 6; 
• Run a flood animation; 
• Run a velocity animation; 
• Create time plots; 
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Step 1: Set Animation Controls GDS - Run FL0-2D Simulation 
Set ITIMDEP = 1 and TIMDEP = 0.5 in GDS Control Panel. This gen
erates the temporal output files. during the FL0-2D simulation 

Run FL0-2D to completion. 

fl0- 20 Coutrol Var•ablet.. ·.s·"'.: 

Time Conhol and Plot Variables Global Dolo Modlicaion 

j Sirualionlome (tu). ~ 
...-------------___:._....._.........,.,val[hs): ro:;--

NQTE: Step 1 has been com- r To>ctsaeen 

6 f ld ~ Delaied Groprico pleted in the Lesson o er. 
r Back~.~> Fie 

This step is to show the user 

n·volue A~nl ro--- Floodploin Limilrog ro--Froude No: 
Flow Depth f01 Deplh ro--- Shalow Flow DurationAnalytif· ~ ro--- n·vaUr 
Br.l<i-.g Concenlrolion· 

Alea Ae<i.Jcbon FaciOf ro--- t. r--

how to set up the animation. Swlches 

P ~ea Reduction Foclors (I>.AF) 

Floodpio;n Disploy Option• 

~~Oplion~ lrN~o~Fio-oo~p~lai-nO~u-1~----~~ 

P Streets 

r Levees- r~~~= 

, PI'IYsical Proceu es Svn:chas: 

r Aal"llal l r Mud/Debris 

w lnfllration I r Sediment Tr~nspat 

r Ev_.alion 
r None 

r MOO FL0·2D Mooeli-lg 

Convey~e StructUie Switches· 

r Hydrauic Shuclwes 

r Flooowoy Anolys" 

r Debr~ Basrn 

Numerical Stabily Paramele~• 

Slllface Dete~ion ro.;--
Percenl ~e l'l Fkrw Depth· ro.;---

r Create Sl4)ettr~ical Outp..i Fie 

1 ChMnet Display Oplions 
' Check '"M.., Ch.lmol'lo adrvole 'Own.!~..,. Opbonl" 

Chan~:.;!) No Chamel Output 

r Time L~pte Output · 

P Time l"!= Oulpul 0~ ln!e<Vol{t .. ~ ro:s-
--------

GraphiCS D1splay 

Select ''O"aled Graphc&"" ''T me Control ord Plol 
Vanolrln" h..,. 

Up&le Time lnterv.!!l(hrd ~ 

Dynorric Wove S!obolily Coefficienl ~ 

Ru...£1.0·20 
(Savefle.s) 

Ru...£1.0 ·20 ~ave FLD·2D 
i-lpul tie$ 

!;kite {Do ntt Save Fiesl 
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Step 2: Open MAPPER and load the Lesson 6 project 
In the GDS, select the File menu from the toolbar and click Run 
MAPPER . 

New Pn>Ject _____ _ 

Open .TCJ'Project. •• 

Open Existhg RO·:<D Project. .• 

Save .TO!' Project. •• 

S..."e R.O·<D Fies •.• 
RlllR.O·l!J ... 

Create FPian.IJAT .nl Cad!TS.DAT 

~Imago 

rn-t Sevation POOls 

~ 51\ope Fie .. . 

~Ran A<dnfo ASCII Gnd Fie ... 
ln1lort tt:CAAS Olarrles ..• 
~CAD Gr~ &rem:> ..• 

Sen-e Eleva !!On Poilts .. . 

E>qxrl ••• 

Exlt 

In Mapper Open the project output files by clicking on File and Read 
FL0-2D Results ... as shown below . 

E >rt 

Ext 

Locate the project file folder and click on the Open button . 

.~ FPi.A!N.DAT S/2/ Z009 Z:OS P:-1 OAT Ft'~ Jil61<5 

=-----~~==========~~~==~~ 
Fie....., I••LAIN.o•r :::J I(FPLAIN.o•n :::J 

I Open ·I CJn<:d I 
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Step 3: Run a flood animation 

The FL0-2D simulation can viewed as an animation of the floodwave 
progression using this tool. First it is necessary to plot the Max Flow 
Depth. 

Max Flow Depth (Contours) 

Max Flow Depth (Shaded Contours) 

Final Floodplan Flow Depths 

F111al Floodplain Flow Depths (Contours) 

Final Floodplain Flow Depths (Shaded Contours) 

Max Charnel Flow Depths 

The maximum flow depth for the grid element plot activates the flood an
imation controls on the tool bar. 

The animation controls from left to right are. 
Previous View Play Stop Next View 

The Previous View and Next View buttons can be used to manually con
trol the speed of the animation. Click on the Play button to begin the 
flood animation. Click on Stop then Previous View or Next View to view 
a specific time interval of the flood simulation. The drop down list on the 
right enables the user to select a specific time step to display in the flood 
simulation. 

Hl•J•JH 0.5 _.;.. 

1 
1.5 
2 -
2.5 
3 
3.5 
4 
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Step 4: Run a velocity animation 
The flow velocity animation can also be run in the same sequence by 
clicking on the Grid Element Max Velocity and starting the animation 
with the Play button . 

Max Velocity (Contotxs) 

Max Velocity (Shaded Contours) 

Max Velocity (Vectors) 

o. · -. . - ... . ,F , 

Follow the same procedure for running the flow depth animation . 

Step 5: Create time plots 
Following the animation, it is possible to view a plot of the flow depth 
versus time or velocity versus time (output interval) for a specific grid el
ement, select Tools/Time Plots . 

Options ~ 

IntHpo'e~e r-oOT 1 Po:nt~ 

<reate FJev .. t:on POtnts Lay~ 

DeJ-?t.e EfeYat/ons frc~m Sele~ted A! ea 

Create Grid Layer 

Create Area ri Inundation Layer 

Exclusion Polygons ~ 

Plot Flow Depth Profile 

Map Template ~ 

Flooding Damaqe ~ 

Show Tree ri Graphs 
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A cursor cross ( +) is displayed that can be used to select individual grid 
elements as shown below. Multiple elements can be selected. 

II 

Click on any grid element to select it and then right click to show the fol
lowing dialog box. Click either the Flow Depth vs. Time or Velocity vs. 
Time plot. 

Velocty vs Time 

Hide An Plots 

Delete Cell Group 

The resultant flow depth plot as a function of time (output interval) for 
grid element number 2107 is shown below . 

.. tlowOepthvs1'1meGraph(lceU) - /" ~ 

flotJ Depth v::~ Time 

Tiae (hour~n 

10 

Gt:id Element. NWJ.ber 

2107 

Plotting several grid elements at once is possible. Click Tools/Time Plots 
and click several grid elements. Right click on one of the selected ele
ments and click Flow Depth vs. Time. 
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~low DE"pth v~ ltme Ltaph ( 3 cells) __ _- _· ~:- _ 

o. a 

Z' 0. 7 . 
; 0.6 

o. s 

0 . 4 

o. 3 

0. 2 

0.1 

Tim.e (hour:3) 
Gri% Eletaetfl Nwlher 

1999 
- ---2000 

2001 

Deselect the grid elements by clicking the selected cell and click Delete 
Cell Group . 

Flow Depth vs Time 

Velocity vs Time 

Hide All Plots 
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2b. Flood Damage Assessment Tool 

Overview 

Required Data 

Content 

Total flood damages or individual structure flood damage costs can be 
automatically computed in the MAPPER program. Computing flood 
damage costs is a direct means of evaluating flood risk. The flood dam
age assessment method is similar in approach to that applied by the U.S. 
Army Corps of Engineers . It requires a table of individual structure dam
ages as a function of flow depth. The structure data has to be collected 
from field inspection and the structure footprint has to be outline in GIS 
software. This lesson shows how to perform a flood cost assessment 
based on the FL0-2D predicted maximum flow depths and the structure 
damage field data. 

The FL0-2D data files *.DAT and output files *.OUT including the 
housing shape and damage code table found in the Damage Assessment 
Example subdirectory are used for this lesson. 

Location* 
FPLAIN.DAT Digital Terrain Model file \Example Projects \Damage Assessment Example 
Damage Code 08. tbl Table file \Example Projects \Damage Assessment Example 
Houses.shp Shape file \Example Projects\Damage Assessment Example 

*Typically these folders are in installed under C:\Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 
The following steps are necessary to conduct the flood damage assess
ment. 

• Open MAPPER and load Damage Assessment Example; 
• Damage assessment structure data discussion; 
• Plot the FL0-2D predicted maximum flow depths; 
• Import the building polygon shape file 
• Compute the flood damage costs 
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Step 1: Open MAPPER and load the Damage Assessment Example 
In the GDS, select the File menu from the toolbar and click Run 
MAPPER . 

t~ Pr'O)OCI ____ _ 

Open ;rep Projoct . .. 

Open E><is1r9 A.Q.l!J Project ••• 

S.V. R.O·lD Files ... 
R<olR.O·lD ... 

lWn PROflU'S 

lWnRAIN 

Creot2 Fl'lan.OAT and c.d>T'S.OAT 

ln1>ort !moge 

lfl't)Ort E'.evatton Points 
-Shape Fie .. . 
rn,ort Rat> Arc!nfo ASCII Gnd Flo ... 
lfrl>ort 1«-AAS C1lamo!s .•• 
ln1>orte>DGr..,tlocSements •• • 

E>port ... 

Open the project output files by clicking on File and Read FL0-2D Re
sults .. . as shown below . 

Ext 

Locate the project file folder and click on the Open button . 

2!J 
_) __ ....,.,. ___ _ 

,.,,,.-• .,.,.,.,.,_-.:'........_--= ... -.. --

, ... 
'""' 

Fit twnej FPL.AIN.OAT il I~PIAIN.OAT) il 
~~ 
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Step 2: Damage assessment structure data discussion 

NOTE: The damage table 
file (DamageCode_08.tbl) 
is hypothetical. The user 
should prepare an appro
priate file adapted to each 
particular site. 

A table file (*.TBL) must be developed that contains the structure dam
age ($) as function of flood depth for each building type in the polygon 
shape file (DamageCode_08.tbl). This table is the result of intensive field 
inventory of the buildings in the potential area of inundation for the de
sign flood event. The table file is organized as follows . This table is gen
erated for a typical Corps of Engineers damage assessment. 

Column 1: A damage code or number that corresponds to the polygon 
ID's in the shape file. 

Columns 2 to 11 : Cost associated with the maximum flow depth list in 
row 1 (depths in the following example range from 1 to 10 feet. 

DamageCode, 1 ,2,3,4,5,6,7,8,9, 10 
1,5000,10000,15000,20000,25900,30500,35000,40000,45000,50000 
2,3000,10000,15500,20500,25000,30300,35000,40000,45000,50000 
3,4000, 10500,15000,20300,25000,28000,35000,40000,45000,50000 
4,5 500, 12000,15000,20000,25600,30000,35000,40000,45000,50000 
5,5000,10000,15000,20000,25000,30000,35000,40000,45000,50000 

Line 1 indicates the name of each column. In this case it is depth in ft. 
Line 2 indicates that for polygon #1 , 1 ft of flood depth will have a dam
age cost of $5000, 2 ft of flood depth will have a damage cost of $10,000, 
3ft depth will have a damage cost of$15000, and so on. 

Another example damage table that used for agricultural field damages is 
show below. For this case, the damage flow depths are non-uniform. 

DamageCode,0.2,0.3,0.4,0.5,0.6, 1.0, 1.1, 1.5, 1.6, 10. 
1,0,2908,5884,8838,14700,14700,16926,16926,17926,17926 
2,0,755,1528,2295,3817,3817,4395,4395 ,4655 ,4655 
3,0, 1360,1360,1360,1360,1360,1360,1360,1360,1360 

Step 3: Plot the FL0-2D predicted maximum flow depths 

Click the Max Flow Depth command. 

flJ h• L• ~,tt 

Max Flow Depth (Contours) 

Max Flow Depth (Shaded Contours) 

Final Floodplain Flow Depths 
F10al Floodplain Flow Depths (Contours) 
Final Floodplain Flow Depths (Shaded Contours) 

Max Channel Flow Depths 
.. ., ... . r• · .... lr- .. .... ' ·· -· · .. - ' 
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Grid Element Maximum Flow Depth 

41DJ 

Step 4: Import the building polygon shape file 

FL0-2D Model Lessons 

mtters 

221 

19.6 

172 

14.7 

12-3 

9.8 

7.4 

4.9 ,. 
<=0.0 

Import the building polygon shape file (houses.shp) using the Import 
Shape file command in the File menu. The housing shape file is simply a 
file of polygons of each house in a neighborhood. Each house polygon 
has ID, area, perimeter and damage code attributes . 

Grid Element Maximum Flow Depth 

111 I Lesson 6 
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The following figure is a zoom view of the building shape file displayed 
over the grid element maximum flow depth plot in MAPPER. 

Step 5: Compute the flood damage costs 
Select the Estimate Flood Damage command in the Tools menu. 

OpHons 

·, d;.J 

CreMe Gr1d layer 

Create Area of InLndatlon layer 

Exclvslon Polygons 

Plot Flow Depth Prof~e 

Mop Teq>lote 

nne Plots 
Show Tree of Grephs 

The buildings shape file is named Houses.shp. The following dialog ap
pears. 
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.. II H "Iii I([[) 11111•1'' I .. hill ti!OII -: ~ 

Import Oamoge Tobie j 

Buildings sh e.pe l1le I HOUSES.SHP 

Bu•ld•ng ld ~eld 

' 

I ComputeQomoge I --~~ 

Select HOUSES.SHP from the Buildings shape file list and HOUSES_ID 
from the Building Id field. Import the damage table file Damage
Code_08.tbl using the button Import Damage Table. The table will be 
fi lled as shown bellow . 

Buildings shape f1le j HOUSES.SHP 

Buildmg ld field IHOUSES_ID 

1Rmpor1 Oomoge Tobie. J C \Tracks\tests\MonropoU\Oomoge\OamogeCode_06 tbl 

NOTE: This computation make 
take several minutes depend
ing on the number of buildings, 
the number of grid elements 
and computer speed . 

Compute O.amoge ,Ccncel 

Click on Compute Damage button to calculate the total flood damage and 
to compute a damage cost estimate for each building. MAPPER will cre
ate a layer containing the building cost for each building intercepted by 
the flooding area. 

There may be buildings for which there IS no damage value associated 
and the following message will appear. 
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Damage($) 

11 .800 

10 .114 

8.429 

6.743 

5,057 

3,371 

1,686 

fL0 -20 Mapper ••• 

WaminQ: building id=1539 not found in damage table 
Do you want this mess~ to be shown again? 

Yes No Cancel - · I 

Click No so the message will not appear for other buildings and continue 
the calculation. The total damage cost estimate for all the buildings will 
be displayed. 

I • . I . - 2SJ 

Total damage cost: 894,926 

OK 

A color will be assigned for each building as function of the damage cost. 

Grid Element Maximum Flow Depth 

r~ ~".;. 

.Its meters 

221 , .... 196 

•;, 172 

~ ~ ,; ·~; 10 

t~j;'i!4 '• .. ~ 123 

.~~' 9.8 

7A 

·--~ ll"Mi 
• . 9 

.-s 25 

-~ - '~ 
<=0.0 

11 - . ~ . .:. 't;~ 

·~ 
' 

··: ·: .. , . 
.: ·, 

B,OCXl 

•.cm 

1.995 1.3221;8 1.3'22.15 007 008 

The building damage detail by color can be seen by 'zooming in' as 
shown. 
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mBIBIS 

22.1 

19.6 

172 

'" 
12.3 

9.8 

'·' 
4.9 

2.5 

<'= 0.0 

To view the individual building damage cost estimates click on the 
View/Layers List and double click on the Building Damage layer. 

luycrs. ..._' 

HOUSES.SHP 
Flow Depth at Cell 
Elevation at Cell 

Ill~ P" ~isible r Q.elete 

The Symbol Properties for the BUILDINGS DAMAGE Layer dialog box 
will appear. Select the Adv label option and adjust the font size by mov
.ing the Label height in map units control and clicking on the Apply button 
until the desired font size is achieved . 
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1 
550,00300 973,111531 

~yr11bul propertres for the BUILDINGS DAMAGE layer. 

Layer Mme: fuildings Damage 

Shape File Type: 1Po1)19011 

Number o1 Records: 14821 

The No Overlapping Labels classication draws te><t for a specifred field and 
attempts to resolve overlapping and crowding ollabels. 

Single 

Te•t field: P Draw features 
lDamage 3 r Allow duplicates 

Font r Mask labels 

jMS Sans Serif JJ Mask color:r-

I 
Label Placement [ LAabel height V1 map un1ls 

r. Place on 

lr Place::Jve 
r Place below · 1 ~ ~ A ...... _______ -L:..i 

1 c::~p£1~ .J .close 

Click on the Close button when finished adjusting the building damage 
number text size. The fo llowing figure displays the damage cost layer 
indicating the damage estimate in$ (currency) for each building. 

-t-t .r: n 
• .52.t 1.'31B:Ii 1 11 8 74 038 2 03 
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2c. Flood Hazard Mapping Tool 

Overview 

Required Data 

Content 

Hazard maps are a function of both flood intensity and probability. Flood 
intensity is defined by the flow depth and velocity. Flood probability is 
inversely related to flood magnitude. Flood hazard is then defined s a 
discrete combined function of the event intensity and return period. This 
lesson describes how to create a flood hazard map using the MAPPER 
program . 

This lesson requires the FL0-2D data files *.DAT and output files *.OUT 
found in the Lesson 6 subdirectory 

Location* 
FPLAINDAT Digital Terrain Model file \Example Projects\Lesson 6 

*Typically these folders are in installed under C: \Users\Public\Documents \FL0-2D Basic Documentation 

Step-by-Step Procedure 

The following steps are necessary to conduct the flood damage assess
ment. 

• Open MAPPER and load Lesson 6; 
• Import aeria l image; 
• Plot hazard map; 
• Plot hazard map (shaded contour) . 

Step 1: Open MAPPER and load the Lesson 6 
In the GDS, select the File menu from the toolbar and click Run 
MAPPER . 
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Open .TOP Pn>JOCL .. 
Open Exlsll'l!l R.0-21> Project ... 

Save .TOP Project. .. 

Save R.O-l!l Fios ... 
Ru!R.Q-21)., , 

0...~ -.OAT and Caci>TS.DAT 

~lmoge 

~EievatJanPonts 

ln1>0rt Shape Ffe ... 
~ RM1 Ardnfo ASCil Gnd Fde •.. 

~ t£<:-RAS o..nn.!s ... 
1n1>0rt CAD GrO!lhc Sements ..• 

E>cport ... 

E>ot 

Open the project output files by clicking on File and Read FL0-2D Re
sults .. . as shown below. 

mport-Im<::t1e 
Import Ele•..-atJon ·o to 

Impor~ Shape~,"· 

lrr ,lOti. ASCII Gnt.l F1!e 

Exit 

Step 2: Load aerial image (See Lesson 1, Step 4) 

Step 3: Plot hazard map 
Click the Hazard Map ~.:J button and click Hazard Map . 

The Hazard Map Intensities dialog box appears. This box has two map
ping options. Use the default intensity, depth and velocity parameters for 
water flooding on the current data. Click Compute to generate the hazard 
map. 
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r. Use current d~~ 

r Read from these directoriet 

:]:. _j G C:\ 
"::j Program Files 
t) FL0-20 
~-' Example Projects 

~ _j .. iiiiiiii ... 

r Type ol Event 

I r. Water llooding r Mud and debriS ffov... 

- -
Ma>irrun deplh h (feet) Logcal Product ol Jlla:)Cjmt.m velocity (v} times 

oper~tion mo><imum depth (h) (leet":21s) 

h >= f4:918 OR vh >= f4:918 I 

11:639 ( :: h < 4.918 OR ~ <=vh < 4.918 

fOT28 <· h < 1.639 AND jo.328 <= vh < 1.639 

FHtyle: I Solid iJ 

.Use Previous j Ca'lcel 

' .n4 4.'52.00 U>5247 Cl 47 oJ& 

Step 4: Plot hazard map (Shaded Contour) 

Click the Hazard Map .....!..:J button and click Hazard Map . 

119 1 Lesson 6 



FL0-2D Model Lessons 

J.4 &1203 11870'16 38 1(181 

Summary 
In this Lesson, the MAPPER program has been used to graphically dis
play and analyze the FL0-20 output data. MAPPER is a versatile map
ping tool that can be used to create high resolution flood hazard maps. 
MAPPER automatically generates shape files of each flood plot that can 
imported into another GIS or CADD mapping program. Also use 
MAPPER for more advanced applications such as making movies of a 
flood simulation and conducting flood damage assessments. The movies 
can be helpful tools for project flood presentations to view predicted 
floodwave progression. The flood damage assessments provide a valid 
estimate of flood risk. 
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Review Questions 

1. When are the MAPPER shape files created? 

2. How are aerial images geo-referenced with the grid system coordinates? _____ _ 

3. To work with the DTM points in MAPPER, what must be created first? 

4. Contour plots can be created for these six flow depth results . 

l. 

2 . 

3 . 

4 . 

5 . 

6 . 

5. What is the difference between maximum flow depth and fmal flow depth results? __ 

6. Outflow grid elements are included in the flow depth results? (True or False) ___ _ 

7. DTM ground surface points are subtracted from the predicted maximum water surface el-
evation for what purpose? ____________________ _ 

8. Why are grid element elements used instead ofDTM points to compute flood hydraulics? 

9. Exclusion polygons are used for what purpose? _____________ _ 

10. What tools are used to improve shaded contour plots? 

1. 

2 . 

3 . 

4 . 
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5. 

11 . MAPPER flood animation requires what controls to be set prior to the flood simulation? 

12. For the flood damage assessment, how are the building damage tables and polygon shape 
files developed? _________________________ _ 

13 . The total damage cost for a design flood event is a measure of flood risk? (True or 
False)?----~-

14. Flood hazard maps represent an assessment ofwhat two flood factors? _____ _ 

15. In MAPPER, flood hazard maps are based on maximum depth and maximum product of 
depth times velocity squared? (True or False) _____ _ 
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LESSON 7- RAINFALL AND INFILTRATION 

Overview 

Rainfall and infiltration parameters can be entered and edited using the 
GDS. The object of this tutorial is to use the GDS to create spatially var
iable rainfall parameters for the RAIN.DAT file and to work through the 
various methods to assign infiltration data. The project data presented is 
all that is necessary is to build the two data files. A rainfall distribution 
will be selected for rainfall model and the infiltration data will be entered 
both as global and spatially variable parameters . 

Required Data 

File 
*.dat 

LandUse.shp 
Soil.shp 
Land Use. tlb 
Soil.tlb 
*.dat 
Land.shp 
Soil.shp 
lmperv.shp 

The profiles program requires five basic data files plus the infiltration 
file and the rainfall file. The five basic files are provided. These files 
are found in the folder Lesson 7 . 

• CONT.DAT • OUTFLOW.DAT 
• CADPTS.DAT • RAIN.DAT (user made) 
• FPLAIN.DAT • INFIL.DAT (user made) 
• TOLER.DAT 

Content Location* 
Grid system data files \Example Projects\Lesson 7/GreenAmpt 
Rainfall distribution data Built In 
Green-Ampt shape file \Example Projects\Lesson 7/GreenAmpt 
Green-Ampt shape file \Example Projects\Lesson 7/GreenAmpt 
Green-Ampt table file \Example Projects \Lesson 7 /GreenAmpt 
Green-Ampt table file \Example Projects\Lesson 7/GreenAmpt 
Grid system data files \Example Projects\Lesson 7/SCS 
SCS shape file \Example Projects\Lesson 7/SCS 
SCS shape file \Example Projects\Lesson 7/SCS 
SCS shape file \Example Projects\Lesson 7/SCS 

*Typically these fo lders are in installed under C:\Users\Public\Documents\FL0-2D Basic Documentation 
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Step-by-Step Procedure 

INPUT RAIN 

To assign rainfall infiltration data with the GDS program follow these 
steps. 

Input Rain 

• Create a new project folder; 
• Open the GDS and load the Lesson 7 project; 
• Create a rainfall distribution and data file; 
• Save and run the model; 

Set-up Default Green-Ampt Global Infiltration 

• Set-up global Green-Ampt infiltration parameters; 
• Save and run the model; 

Green-Ampt Spatially Variable Infiltration 

• Load infiltrations shape files ; 
• Load landuse and soil tables; 
• Compute infiltration data file; 
• Manually edit the INFIL.DAT file; 
• Save and run the model; 

SCS Curve Number Spatially Variable Infiltration 

• Open project; 
• Load infiltration shape files ; 
• compute infiltration; 
• Save and run the model; 

Step 1: Create a new project folder 

Several different project data sets are created in this lesson. It is advisa
ble to setup a project folder when saving new project data so that a com
parison with previous infiltration model is available. In an explorer 
window, copy the folder C:\Users \Public\Documents\FL0-2D Basic 
Documentation \Example Projects \Lesson \Green Ampt and rename it to 
Test. 

Step 2: Open the Grid Developer System program 
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New Project 

Open . TOP Project ... 

~ve . TOP ProJect ... 

Save FLQ-20 Fies .. , 
Rll"l FLQ.-20 ... 

R~.e~Mapper 

Rln PROFILES 
RlnQAIN 

FL0-2D Model Lessons 

Browse the folder C:\Users\Public\Documents\FL0-2D Basic Documen
tation \Example Projects\Lesson 7\Green Ampt and double click the file 
FPLAIN.DAT. 

("' Select a fPlADt.DAT file to open - !'.:. 
-- - ----- - ------~ --

) • l""""'7 . Gn!enAmot. 

rest 

8 FPlAIN.DAT 

--~~~~===-- ~~ I SeMen Green Arnot 

·I 0.\Jo mo<ifiod I Type -

5/ !2/l.fJ13!2:42PM F 'efo!der 

!,125/201!1!:!4AM DATFie 

~------~========~~====~~~ 
File"''""' jFPLAIN.OAT :::J I<FPlAJN.OAl) 3 

Open •J C•ncol I 

The following dialog box will be displayed. Click OK to load the model 
and display the grid system . 

fl 0 70 Components ,! . 

The following componerb Wll be loaded: 

r J. r '" 
r eo T. "'"' r r •;J " 
r :Jt~ 

w O~low elemem r < ~"' 

r "y r 

r 

r ., .. r 

r P.,, ~ 

lboK=t J;ancel 

The display of the grid system should look like the following image . 
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Step 3: Set-up total rainfall and a rainfall distribution 

To create a rainfall distribution, click the Rain command on the Tools 
Menu. 

Options 

Measure Distance along l.i"le 

Compute Avf!f(age Pont RaWal Depth 

Interpolate Vari«lle Rairlall 

Levee Express Editor 
Floatng Var1ables Express Editor 

Create Channel Segnent: with a Polyline 

Create a Qoss section 
Assign a t£C-RAS Cross Section to a Channel Element 

Convert HEC·RAS Xsec to FL0-20 
Convert HEC-RAS Chamois to Ro-20 Chonnel Segnonts 

Create street SeCJflleol: 

Cre«e Street Seoment with ~ P~ 

Create Detention &lsn 
Mud and Sediment Transport 

Ev~atoo 

MOORo-20 5m.Jiotion 
Hyctdc structures 

Initially the Rainfall Distribution button will be grayed I. 
To activate the button enter a value of 3.1 inches in the Total Storm 

Rainfall box ro~oist"'mR.n .. ~ . The Rainfall Distribution button is 
now active. Click it to open the Rain Editor dialog box. 

126 1 Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

FL0-2D Model Lessons 

R.unf.ill Varwb~ '¥ . 

r Real· Tine Rainfall r Deplh·Area Reruclion Vatue. r Movrng St01m 

l ratafStormAainlafl:~ I R•irlaiAbdracton ro--
Awgn distri>uten. moving sl01m and spatiaiFarrable ''"rl•~ l A.rlofl Distrib<Aen II 

Rain Tine ~nd Distribution 

Add Chonge Delete 

Tine Pe<cA~Jolaf 

r-r-

r' ·~' rr 

' ' ,. \ 

r ' '~ r. ·,, 

l (' 
' r 

\ (' I• 

OK CMCel 

Click the Distribution button lll!tctr • ..,., and select the Maricopa County 
2-Hour Storm option and click the Plot and Edit Rainfall Distribution 
radio button and click OK. 
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f..l.-tllll.tll D•strtbution 0 

r Use the Entered Oi$tribution 

r Use SCS Nondmensionol D i~rib<Jion 

I P Maricopa C01111}1 2-Hcu Storm I 
r MariCOpa Court~ 6-Hour Poltem 1 

r Marc opa Cour~y6-Hour Poltem 2 

r M01icooo Cour-zy 6-Hour P•ttem 3 

r Maricopa Court~ 6-Hour PoltO<n 4 

r Morcopo Couroty 6-Hou Poltem 5 

r SCS24-HouTypell 

r SCS 24-Hou TypeiiA 

r NRCS TYPE 11-60 

r NRCS TYPE 11 -65 

r NRCS TYPE 11 -70 

r NRCS TYPE 11 -75 

r NRCS TYPE 11 -45 

r. Plot ~nd Edit AMllall Di;trbution 

The Storm Distribution plot and Edit Rainfall Distribution dialog box 
appear. Click Close and then click the Save button ~ on the Rain 
Editor menu bar. 

~lornll>1stnbut10n . ~, · 

n 

" 

n 
t 

. 9 

-• 
- ? 

-· 
-s 

-· 
- 3 

- 2 

. l 

' . 0 0 

Tome Ratn :l - uoooo I 0.0933 0.011 0 

U1667 0.0180 

0.2500 0.0230 

0.3333 U0280 

0.41 67 0.0320 

0.5000 U0460 

0.5933 0.0710 •J 
. 8 1 LZ 1.4 1. 6 1. 8 

Time (hr s) 

The RAINDAT file has just been created. Click OK and exit the 
Rain Editor dialog box. 

RAIN.DAT file ho• boon ,.ved 

Return to the GDS and click Yes to load the rain data table. 

128 1 Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

FL0-2D Model Lessons 

II 0 )I) f,rid Devek>per "" 

If you edted the rafifal data outsl:le GDS, \YOUt1 you Ike to rebad t? 

Yes No 

r eeJ-TrmeRoinfol r Depth-Area Reduc:ton Values r Movmg Storm 

TotolStormRamfoll ~ RamfoJIAbstrectlon ~ 

Assrgn drstnblrtton. mOVIng storm ond spotiollyvonoble ramlo.!l Ro.Jnfall Orstnbutron 

RaJn Time ond Drstnbutlon 

0 0 
Add 0.0833 0.011 

0.1667 0.016 
0.25 0.023 

0.3333 0.028 
0.4161 0.032 

0.5 0.0"16 

n~A :n nn71 

-~ - --' - ----' 

(' 

(' (' 

OK Cancel 

The data is loaded into the table click OK. 

Step 4: Save the data files and run the model 

Save the FL0-2D data files . To run the FL0-2D flood simulation, use 
the Run FL0-2D ... command in the File menu . 

New PrOJect 

Open . TOP P!o)ect .. . 

Open Ex!stnq Ft0-20 Project., , 

~ve . TOP Pro)ect .•• 

S.ve Ft(}-20 Fles ... 

Rll'l Mapper 

Rll'lPROFILES 
Rll'l RAIN 
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Make sure all the correct component switches are turned on (Rain). In
put the Simulation Time = 5 hr, Output Interval = 0.1 hr for more output 
intervals, select the Detailed Graphics option and enter an Update Time 
Interval of 0.1 hours as shown. 

II 0 JU ( ontrol Vdfldbb :.;.Tj·~.f. 

Simu!e.tJon Time(hrs) ~ 

Output Interval (tus) ro.;--
GHiphrcs Orsplay ~ ~=~~~:~;aphrcs 

r r Becl<.up Frle 

System Component Switches 

Global Ooto Modfficction 

n-velue Adjustment· ro--
A~~:::,f~~~ ro--

BulklngConcsnbotJon ro--
lv"eo Redudlon Fodor ro--

Aoodploin Disploy Options 

Aoodpla~n 
Umrtrng Froude 

Shallow A ow 
n-vo.lue 

r Mom Channel r Area Reduction Fodors {AAF) Prmt Opllons r:jo~e=te7ile:-:d:::O:-:ut::-p=ut _ _ _ __ 3'~ 

r Streets 

r levees 

r Muhrp!e C.honnels 
fRill and Gulhe<J' 

Physrcol Proce.ss-es SWitdles 

I P" Romfoll I r Mud/Debns 

r n~ltro.tJo r SedrmentTro.nspot1 

r Evaporotion 
r None 

r MODA...o-20 Modelling 

Conveyonce Structure Swrtches 

r Hydrauhc.Structures 

r Floodwcy Anolysrs 

r Oebns Bosrn 

Numenct~l Strsbrlrty Paremeters 

SurfeceOerentron ~ 

PercentChongernRowDepth ~ 

r Anrmote Aowwrthrn GOS 
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r Create Supercnttcol Output File 

Check "Mom Ctuinnet• to actJve.te "Chcnnel Pnnl Opbons• 

Time Lopse Output 

P" Time Lapse Output Output lnterve.l(hrs) ·~ 

Grophrcs Drsploy 

Sated •Derailed Grophrcs• rn "'Time Control ond ptot 
Vonobles• frame 

Updole Trme lntetval (hrs) jo.1 

DtnomrcWave Ste.br1rty Coefhaent p
CourentNumber (rMge 0 l to 1 0) ~ 

Qose 
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Click Run FL0-2D and observe the floodwave progression over the pro
ject area. The rainfall hydrograph will be plotted and volume conserva
tion is reported during the simulation. Close the GDS . 

M a xim um 
Flow D epths 

Depth Legend 
< DEPTH 
< DEPTH < 10. 
< DEPTH < 9 .5 

-.-:"-:-""~~~~o;-'~~ilr!'~~~--~---------.,,--,-! < DEPTH < 9 .0 

GREEN-AMPT GLOBAL INFILTRATION 

Step 5: Create a new project folder 

8 .0 < DEPTH < 8 .S 
7 .5 < DEPTH < 8 .0 
7 .0 < DEPTH < 7 .5 
6 .5 < DEPTH < 7 .0 
6 .0 < DEPTI-J < 6 .5 
S . S < DEPTH < 6 .0 
S.O < DEPTH < 5 .5 
4 . 5 < DEPTH < S.O 
4 . 0 < DEPTH < 4 .5 
3 . 5 < DEPTH < 4 .0 
3 . 0 < DEPTH < 3 .5 
2 . S < DEPTH < 3 .0 
2 .0 < DEPTH < 2 .5 
1.5 < DEPTH < 2 .0 
1 0 < DEPTH < 1.5 
0 . 5 < DEPTH < LO 
TOL < DEPTH < O.S -

DEPTH <TOL 

In Explorer, copy the folder C:\Program Files\FL0-2D\Example Pro
jects\Lesson 7 and rename it to Lesson 7 Rain. Open the GDS and load 
the Lesson 7 project. 

Step 6: Create the infiltration data file 

To set up the global infiltration values double-click any grid element 
within the computational boundary to bring up the grid element attrib
utes editor. Click the Infiltration button . 
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floocbilln elevalion [feet~ J2389.99 

M.,.,;,g coolfK:ierl: J0.04 

Element oize (feet). 
DeiaX: poo 
Dela Y J"'300=-- --

B. eduction Fact en .. . 

.Levee .. 

IJLJnliRcatoon. 
MODFLD-20 . . 

QK 

Fill out the Infiltration editor box as shown in the following image. 
Click OK twice to exit the editor boxes. Check the Grid element infiltra
tion box. This action will cause the global infiltration values to be writ
ten to the INFILDAT file along with the values for grid element 492. 

tnfittr.thon (llement 49J) --~ 

lnfiltrahon Method 

1.--P'- G-re-en_Am_ pt..,, r SCS Curve Number 

The seleded IO!tltro.IJon me!hod(s} Wlll be the scm~e for all gnd elements 

Globalperarneters .-·--....., 

lmtlol Abstradlo ~ lnrtro.l Saturabo ~ 
Sotl Porost ~ FmaJ Soturatio ~ 

Aoodplo.m Hydrcuh 
~ Soil Suctio ~ Conduct. Onlhr 

Chonnet Hydrouh 
~ I Conduct.tin/hr 

J7 Gnd elemenltn dtrction 

r. Floodpletn Element 

r Olonnel Element 

Hydraulic Conduct (tn/M ~ 

Copllonty Suctlon Un} r:o-
Sotl Moisture Oefiat. ro.r-

Rotnfci i Abstrocton (rn) ~ 1 

lmpeMouslvee.. ~ 

QK D>ncel 

Turn off the infiltration for specific nodes by creating impervious ele
ments. Click the Select element by element _!._ button and select a group 
of neighboring grid elements. Click Grid/Assign Parameters to Selec
tion/Infiltration . 

132 1 Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

Interpolate ElevatDo Poilts 

Interpolate from ~ Elevatilrl Fles. .• 

Green-Ampt Parameters 

Compute ManrWlQ Coefftaents. .• 
Compute SCS curve Number 
Compute W'rtt:h and Area ReductJJn Factors 

Compute l.intng Froude Numbers. .. 

Defne Boundary Gnl ~ 

Setup ComputaiJOrlal Area 

er-eat. Goo Layer 

FL0-2D Model Lessons 

Area and Wd:t1 ReduelX>n Fact~ 

No D&tlarge Exchange 
Trne-Vamnt Groundwater Head 
RgilBedEiemerlt 
Lrrb1g Froude Number 

Turn on the impervious area switch by entering the number 1 in the Im
pervious Area box and click OK. 

Infiltration Method 

p- Green Ampl r SCS Curve Number 

The seleded infillrotion method(s) 'Mil be the some for oJI grid elements i 

Global pe.re.meters 

lnifloiAbstrec:tJon ro.o-- lnitioiSoturotion ~ 

Sari Porostty ~ FmoJSoturation .~ 

Roodt:,~~~(,:~~ ~ sorr Su01on ~ 

Cho~~~~;~~~~~: ~ r 

17 Grid element mflttrotion 

Ci Floodplom Element 
Hydrou1icConduct On/hr)· ro:;--

Co.prloritySuctionC!n) ru--
SOJI Moisture Deficit ~ 

Remfe.llAbstroctmn (tn) ~ 
lmeervious Areo: , I 

r Chcnnel Element p--

r-
QK Cancel 

Note in the following image that while the global infiltration is turned 
on, only the spatially variable infiltration is shown on the grid system. 
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Step 7: Save the FL0-20 Files and run the model 

Save the FL0-2D data files and run the Model. Click File/Run FL0-
2D ... and note the Infiltration switch is checked. Click Run FL0-2D 
(Save Files) . 

II C. /f)(OIIIroiVdfldbk~ ~> 

T ime Control ond Plot Vottables 

Stmulo~on Time (hrs) rs-
Output lntervel(hrs) ~ 

Graphics Otsplay r Text Screen 
(i OetOJied Grophtcs 

r I Bod<up File 

System Component Swrtches 

Globt~;l Dolo Modificotion 

n-velueAdjustment ~ 

Ao;~:~~~~~ ~ 
Bulkmg Concentrotton ~ 

AreoRedudJonFoctor ~ 

Floodplorn Display Options 

Aoodplom 
l.Jmrtmg Froude 

ShaiiOWAO'W 
n-volue 

r Mom Olannel r lveo ReductiOn Foctors (AAf) Pnnt Opt10ns r:io::-.::-,.,:-.,e-cd:::O:-..t:-p,-,t-----i:J-. 
I Streets 

I Levees 

f Mud,IDebn$ 

I Evaporotion 

f SedtmentTronsporl 

r None 

I MOOFL0·20 Modellmg 

Conveyence Structure SWitches 

r Hydre.uhcS1nJctures 

r Floodwey Anolysts 

r Debns 8e.s1n 

Numencel Ste.b1h1y Pert~meters 

Sulfo.ce Detention· ro:;-
Percent Change 1n Row Depth ro.z--

r Amm,te FlowWlthin GDS 
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r Ctecte Supercntlce.J Output File 

Check "Mom Channel" to aCJvo.ta "Channel Pnnt Options" 

Ttme lapse Output 

,-;' Time Lepse Oulpul Outputln1ervol (hrs)· ro.;---

Graphics Orsploy 

Seled "Dele.1led Graphics" 1n "Time Control ond ptot 
VMt~bles• freme 

Updt~le T1me lntervo.J (hrs) ro.;--

Oynam•cWt:NB Stt~br l it;{ Coeffiaent ~ 

CoUJan!Number(re.nge· OltalO) ~ 

Qose 
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Ma x imum 
Flow D epths 

Depth Legend 
... -..---,..,....,~---..... ""!"---,_;:r"~-:""c--~.....,.-~.....,-,--·---------,.,-.,n < DEPTH < 9.0 

8 .0 < DEPTH < 8 . 5 
7., < DEPTH < 8.0 
7 .0 < DEPTH < 7 .5 
6 .5 < DEPTH< 7.0 
6 .0 <DEPTH < 6. ~ 
5 .5 < DEPTH < 6 .0 
5 .0 < DEPTH < 5 .5 
4 .5 < D EPTH < 5 .0 
4 .0 < DEPTH < 4 .5 
3 .5 < DEPTH < 4 .0 
3 .0 < D EPTH < 3 . :5 
2 .5 < DEPTH < 3 .0 
2 .0 < D E PTH < 2 .5 
1 .5 < D EPTH < 2 .0 
1 .0 < DEPTH < 1.5 
0 .5 < DEPTH < 1.0 
TOL < DEPTH < 0 .5 -

DEPTH < TOL 

A revtew of the SUMMARY. OUT file shows that the total infiltration 
loss is 1446.36 Acre-ft. Close the GDS . 

*"' * OUTFLOW (ACRE - FT ) """ 

OVERLAND INFL TRATED AND INTERCEPTED WATER 0 . 62 I NCHES 

OVERLA..t<D FLON WATER 

TO I NFILTRATION & I NTERCEPTION 1~~6 . 36 

FLOODPLAIN STORAGE 5134.93 

FLOODPLAIN OUTFLOI~ HYDROGRAPH 42 3 . 82 

FLOODPLAIN OUTFLOW, IN FILTRATI ON & STORAGE 7005.1 1 
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GREEN-AMPT INFILTRATION FROM SHAPE FILE 

Step 8: Create a new project folder 

In Explorer, copy the folder C: \Program Files \FL0-2D\Example Pro
jects\Lesson 7 and rename it to Lesson 7 Global Green-Ampt. Open the 
GDS and load the Lesson 7 project. 

Step 9: Load Landuse and Soil shape files 

Click File/Import Shape File .. . 

New Pro)ett 

Open .TOP Project .. 

Open Exl!ting FL<>-20 Project .• 

save .TOP Project .. 

save FL0·2D Fles ... 
Run fLQ-20.
RunMapper 
Run PROFD.ES 

Run RAIN 

Create Fl'lain.DIIT and Cadi'TS.DIIT 
Create l£\IEEOIESTS.DAT 

Import Image 
Import ElevatDn Perot> 

Import Ran Arcinfo ASCII Gnd Fie. •. 
Import HEC·RAS Channels. .. 
Import OD Grapl*: Elernert..-
Import Levees... 

save ElevatDn POOls. •. 

Elcport. .• 

Elct 

Load the Landuse shape file found in Lesson 7 and repeat the process for 
Soil shape fi le. 

Ra:n 

Test 

:; • 11 • 

h"" I! 
Si 13/(0 t3 8:4 LAM Mle fnder 

Si t3~t3 8:4 1AM Fie folder 

Sil2/tiJlJ 12:42 PM ~-e fu!der 

~----------;===========~~;=~==~---~ Fife n• me: )landUse.shp 3 JesRI Shapefileo; r.o;hp) 3 
Open •I Cancol I 

/! 

The shape files are shown in the following image. 
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Step 10: Load Landuse and Soil tables; 

Click Grid/Green-Ampt Parameters/Compute Green-Ampt Parameters ... 

Create Gfil 

Select 
Assign P""""""" to SEiectX>n 

~e Elevati:Jo f'ods 
~efrom M~ Elevatnn Fles. .. 

compute Manrrog coeff1oem_. 'Jie\v t.and use Jnte><Ctlons 
compute scs cur-.e Number • W!w Sol lllte><Ctlons 
compute wtJth and Area Reducoon Factors 
Computl! l.lnb1g Froude Numbers. .. 

Defile Boundafy Gfil Elements 

SellJp Computational Area 

Create Gill Layer 

Load the Landuse table by clicking the Import Land Use Tables 
lmport LondUse Table I button. Repeat the process for the Soil table lmport so,IIoble I. 

The landuse and soil tables are found in the Lesson 7 folder. 

) } 

"'"""" . --
S/tJ/2Dt38 :4 l .\.~ ~ fo.'Oe' 

5/13/201J6:4 1 AM Fiefo:der 
,.,, 5/12/20lJ lZ:4ZPM Fle ~ 

_ Sol ...... &/ !9/2002 2:46 PM 9-P F'e 

~------~========~====~~~ Filo-IL•ndU,~,hp ::J jESRISh..,.r.le,(".,.,p) iJ 
Open •I Conc<l J 

4 
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Land Use I Soil 

Seled Shapefile 

('" FromFile 

Click the From Imported Shape file radio button and select the shape file 
LANDUSE.SHP. Select LDUSE _ID as the field. Repeat the procedure 
for the Soil tab. Select SOIL.SHP as the shape file and SOIL_LID as the 
field. Click the Compute Green-Amp! button. 

SeledField 

(i From Imported Shapefile I II LDUSE_LID ~I 
.J 

C:\Users\Karen OBrien\Desktop\FL0-20 v2009 Docs\Webinars\Rainfall and lnfiltration\Lesson 7\LandUseT able.tbl 

Compute Qreen-Ampt ~an eel 

Step 11: Save the FL0-2D Files and run the model 
Save the FL0-2D data files and run the Model. Click File/Run FL0-
2D ... and note the Infiltration switch is checked. Click Run FL0-2D 
(Save Files) . 
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II o JUt nnlrol Vdn.Jbk>s ""':"i,,~ 

Time Control and Plot Vanebles 

Simul!l.tlon Time (hrs)· rs-
OutputlnleTVe.l (hrs) ~ 

GraphiCS Otsploy: r Text Screen 
('i Deta~led Gre.phtcs 

r r Be.ckup File 

System Component Switches 

,-Global Dolo. Modiflc:etion 

ll"'v'CiueAdtustmenl ~ 

Fl~~:r!'~~: ~ 
BulkingConcentn!ltion ~ 

1 
Area RedudJon Fedor ~ 

Roodple.in Display Options 

Shalla;~: ~ 

r--

r Mam Dionne/ r Area Reduction Factors (ARF) Prmt Options ,--lo-• .,-.c-le_d_O_utp_ut ______ iJ-. • 
r Sbeets 

r Levees 

r Mutt1ple Cho.nnels 
rR.llle.ndGulhesl 

(" Mud/Debris 

r Evaporation 

r Sed1mentTronsport 

r None 

r MODFL0-20 Modelling 

Conveyance Structure SWT1ches 

r Hydraulic Strudures 

r floodwe.yAnelysiS 

r Debus 8os1n 

Numancal Stebihty Pcremetars 

SurfeceDetantion ~ 

Percent Chenge in Flow Depth ~ 

r Ammcte FlowWithm GDS 

r Oeate SuperartJce.l Output File 

Check "Mem ChMnel" to ecrrvate "Chcnnel Pnnt Opbons" 

Time Lapse Output 

P' Time Lapse Output Output lnteNo.l (hrs) ~ 

Grephrcs Disploy 

Select "Oeto1fed Grcphtcs" m rrtme Contol o.nd Plot 
Venables• frame 

UpdeteT1melnterval(hrs) ~ 

Dynam•cWove Slob1lity Coaffioent p--
CourantNumber(renge· O.l to 1 0). ro.s--

Qose 
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NoAcion Necess:ary 
AtianNecen ary 

oAc1ion Nocessary 

Maxin1um 
F low D ep ths 

-..r~~~~~~~~~~~~-----------r--------------~~ 
Depth Legen d 

7 5 < DEPTH < 8 .0 
7 0 < D E PTH < 7 S 
6 .5 < D EPTH < 7 .0 
60 < 0 E PT H < 65 
5 S < DEPTH < 6 0 
5.0 < D EPTH < S.S 
4 .5 < DEPTH < S.O 
4 .0 < DE PTH < 4 . 5 
3 .5 < DEPTH < 4 .0 
3 .0 < DEPTH < 3 .5 
2 S < DEPTH < 3 .0 
2 .0 < DEPTH < 2 .5 
1 S < DEPTH < 2 .0 
1 0 < D E PTH < l. S 
0 . 5 < DEPTH < 1.0 
TOL < DEPTH < 0 S 

D E PTH < TOL 

A review of the SUMMARY.OUT file shows that the total infiltration 
loss is 2298.57 Acre-ft. Close the GDS. 

• •·•· OUT FLO!~ (ACRE- IT ) 

OVERLAND I NFILTRATED AND I NT=RCEPTED WATER 1 . 10 I NCHES 

OVE RLA..l!l'D F ~OW l~ATER 

TO I NFILTRP.TION & I NTERCEPTI ON 2296 . 57 

STORAGE 4B5. 56 

FLOODPLAIN OUTF~OW HYDROGRAPH 264 . 66 

FLOODPLAI N OUTFLOW , I NFI LTRATI ON & STORAGE 6998 . 81 

140 I Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

FL0-2D Model Lessons 

SCS Curve Number Spatially Variable Infiltration 

Step 12: Open the GDS and load proj ect 
***NOTE*** Using an Explorer window, make a new folder in the Les
son 7/SCS folder named "TEST". Copy all the Lesson 7/SCS files to this 
folder and perform the lesson in the TEST folder. ***NOTE*** 

From the GDS File menu click Open Existing FL0-2D Project ... 

New Project 

Open • TOP Project ••• 

save .TOP Project .. . 

Save FLQ-20 Fies .. . 

Locate the folder Lesson 7/SCS and open the FPLAIN.DAT file. Click 
Open and OK to load the project. 

Test S/ 12j 20!3 12:41 PM File fu!:ler 

0 ·~.\f/'.ollfal '>v't.'l'l.:\'iv-1 lAt-k' 

~----~~========~~~==~~~ 
File nome: \FPLAIN.DAT ::J j(FP LAJN.DAT) iJ 

I Open ~I Cancel I 

Step 13: Assign a global SCS curve number 

Double click any grid element to load the Attributes Editor window and 
click Infiltration . 
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Allnhut• .... nl Grid llement Numbet 2S3 ~ 

Floodplom elevot1on (meters) ~0 

Monmng coeftloent lo.04 

l.Jmrtmg Froude """jo.,-o ---

DehaX p ooo 
Element stze (meters) Delte y ~p o""oo=-----

QK ~011ce l 

Turn off the Green-Ampt global infiltration by clicking the check box 
and turn on the SCS Curve Number global values by clicking the SCS 
check box. Click the Grid Element Infiltration for element 492. Fill in 
the Global SCS Curve Number and Global SCS Abstraction if necessary. 

lufdtrdtlon (lle.mcnt 492) .. 

lnflttrobonM';'!elh::!:!o!!..d ---------. I r Green Ampt ~ scs Curve Number I 
The selected tnfillrollon melhod(s) """U be the some for ell gnd elements 

GJobol porometers 

r-- p;-
r- p;--

r-- ~ 
p::-- r 

Giebel s~u~;:r ~ ~::!;~ ro.o--
1 ~ Grid e~ement tnfilttotiodl 

~ 
~ 

~ 

~ 

I SCS Ctnve Number iss 0 

.QK I _ .COncel 

Click OK and click File/Save FL0-2D Files ... The INFIL.DAT file is 
now located in the project folder. 

Step 14: Load infiltration shape files 

Click the File menu and select Import Shape File .. . 
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New Project 

Open .TOP Project. .. 

Open EXl5IJng FL0.2D Project. .• 

save .TOP Project. .. 

save FL0·20 Fles. •• 
Run FL0.2D .•. 

Run Mapper 
RunPROfD..£5 

Run RAIN 

Create FPI*l.DAT and cadPTS.OAT 
create I..E\'EECRESTS.OAT 

Import Image 

Import ElevatiJn Pools 

Import Rail 1\rc:lnfo A5CII Gill Fie ... 
Import HEC·RAS Channds. .. 

Import OD Graphic Elemeot>. •• 
Import Levees. •. 

save ElevatiJn POOts. •. 

Export .. 

Ext 

FL0-2D Model Lessons 

Select the lmperv.shp file and click Open. Repeat the process for the 
Land.shp and Soil.shp . 

.II •• ,, 
Ja, res: 
• "fl>< 1l• " • AI~ , , ,,., 

6/12/20077:SOAM 51-f>Fi'e 

5/ l1/20072:41PM 51-F'i'/e 

The project should look like this: 
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Step 15: Assign a SCS curve number from a single shape file 

Click Grid/Compute SCS Curve Number/From Single Shape File ... 

o.ate Grtl 

Interpolate Elevatlao Pollt> 

ln~e from M~ Eleva!Dn Fles ... 

compute Man'*'9 Coeffidents. .. 

compute Wi:lth and Area Reduction Factors From M~ Shape Fles 
compute Urblg Froude Numbers. .• 

Defue Boundary Grtl Elements 

S<tup computalbnal Area 

create Grtl t.ayor 

Set the SCS Curve Number shape file to LAND.SHP and the field to 
curven and click OK. 

~·lt"t t S< s c urve Number shape tie 

SCS Cll~h~~~~~~ jLANO SHP 

SCS O:.uve Number 
field 

-------

QK ~ncel j 

Click File/Save FL0-2D Files ... The INFIL.DAT file now has spatially 
variable curve number data. The project should look like this : 

Step 16: Assign a SCS curve number from a multiple shape files 
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Click Grid/Compute SCS Curve Number from Multiple Shape Files . Se
lect the shape files and fields as shown below and click OK. 

< ompu1 P SCS Curve Number '' 

So1l Shope File -

Lo.nd Cover Shape File 

Seleoshopefile ll?. rjlAN~~D.,..-.S~H-P~~~~~-:_--~""'11•. , 
Select cover densrty field L.lcov _ _ de_n ____ ___;~ • 

lmpeMous Cover Shope Firrlole- - iiiiiiiiiiiiiiii3j 
Select shope file · I :~ I 

SeledlmpeMousfleld L..fiM_P_"'---'------iJ=: 1 

.QK Ctlncel 

Twn off the infiltration view by clicking View/Components/Infiltration . 
Click File/RunFL0-2D ... Assign the FL0-2D Control Variables as 
shown in the dialog box and click Run FL0-2D (Save Files) . 
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Summary 

110 JDt o ntroJV,uldbb 

T rme Control and Plot Vet~ab les -

S•mul!!.bon T ime (Ius) Ji 
Outputlntervol(hrs) ~ 

GrophiCS Dlspley. r Text Screen 
(i' Oeta~le d Grophrcs 

r '·I«· r Bockup File 

System Component 8'-Nitches 

I • 

Glob!!! De.te. Mod•ficction 

n-wlueAdfustment. r-
Fl~~:~f~~~ r-

Bulkmg Concentration r
j Area Redudion Fedor r-

Aoodplom Oisple:yOpbons 

Floodplom 
Llmrtmg Froude 

Shallow flow 
n-volue 

r Mom Ole.t~ne l r Areo Reduction Factors (ARF) Pnnt Opbons J rNc--oc=Ac-oo-d,--pl-oi,-n ""outp_u_t - --3 
r Streets 

r Levees 

r Mud/Oebns 

r Create Supercntlccl Output File 

Check "Mom Chonnel" to adtva.te "Channel Pnnt Opbons" 

Time lapse Output 
r Evaporation 

r Sedtme n\Tronsport i 
r None 

Output lnlervol(hrs) ~ r MOOFLQ-20 Modelling 

Conveyance Structure Switdles 

r Hydraulic Structures 

r Fl oodwey Analysrs 

r Debns Bostn 

Numer1cel Stability Perametars 

Surfece Oetenhon· ro.;-
PercentCho.nge mflowOepth v-

r Arumete Flowwrttun GOS 

r Time Lapse Output 

Grophrcs Oisploy 

Seiad "Detotled Grophrcs"rn ornme ConVol ond Ptot 
Vanebles• fume 

Updete Time lntervo.l (hrs) lo.l 

Dynarrnc W eve Steb1hty Coeffiaenl p-
Courant Number tronge 0 1 to 1 0) ro.s--

Qose 

This lesson demonstrated that a watershed rainfall runoff and infiltration 
model can be quickly developed with the GDS. The simplicity of this 
process enables FL0-2D to be a valuable tool for watershed and urban 
rainfall-runoff simulations. A more detailed storm analysis can be per
formed with the spatially variable rainfall tool, moving storm or 
NEXRAD real time rainfall simulation. 
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Review Questions 

1. How many rainfall distributions are available as automatic input in FL0-2D? 

2. True or False? It is necessary to use the rainfall distributions provided by FL0-2D? 

3. Which infiltration configuration can be used with FL0-2D? Check all that apply . 

D Green-Ampt 

D SCS Curve 

D Combination ofGreen-Ampt and SCS Curve 

4. If a combination ofGreen-Ampt and SCS curve infiltration is used, which method takes 
precedence? _________________ _______ _ 

5. True or False? Green-Ampt infiltration method removes the volume from the rainfall? 

6. Two *.tbl files are needed to compute Green-Ampt infiltration data. List the data catego
ries recorded in the two files . 

7. Briefly describe when to use the 3 variations of infiltration . 

8. Rainfall and infiltration help documentation is found in which locations? Check all that 
apply . 

D 
D 
D 

ODS Manual 

Data Input Manual 

Reference Manual 

D PowerPoint Presentation 

D Pocket Guide 

D Workshop Lesson Book 

9. List 3 ways to assign SCS Curve infiltration in the ODS . 
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FL0-2D Model Lessons 

LESSON 8 - HEC-RAS TO FL0-20 CONVERSION 

Overview 

Required Data 

Content 

Many FL0-2D projects require improving existing flood maps created 
from a HEC-RAS model by using an integrated channel and floodplain 
flood routing analysis. This lesson will demonstrate how to load a HEC
RAS channel into the GDS and convert it into a FL0-2D channel. The 
HEC-RAS data provided with this lesson was edited to a shorter river 
reach. The channel was trimmed to just 15 cross sections and each cross 
section was trimmed to the top-of-bank stations. It may be necessary to 
edit cross section and channel data in HEC-RAS prior to importing the 
data to FL0-2D . 

The FL0-2D grid system files and a Geo-referenced HEC-RAS project 
file are needed for this lesson . 

Location* 
BoiseCrk.p1j HEC-RAS Project Example Projects\Lesson 8 
6 *.DATfiles FL0-2D data files 

*Typically these folders are in installed under C:\Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

To create a FL0-2D channel from HEC-RAS data using the GDS, follow 
these steps: 

• Open the GDS program and load Lesson 8; 
• Import the HEC-RAS channel; 
• Create a FL0-2D channel segment; 
• Load aerial image; 
• Adjust the channel; 
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• Assign the cross section data to the channel; 
• Interpolate the cross sections; 
• Calculate the right bank elements; . 
• Realign the right bank elements; 
• Create a channel outflow node; 
• Save and run the model. 

Step 1: Open the Grid Developer System and load Lesson 8 

• F?LAIN.OAT 

***NOTE*** Using an Explorer window, make a new folder in the Les
son 8 folder named "TEST". Copy all the Lesson 8 files to this folder 
and perform the lesson in the TEST folder. ***NOTE*** 

From the GDS File menu click Open Existing FL0-2D Project ... 

New Protect 

Open . TOP Project .. , 

Save . TOP Project . .. 

Save FL0 -20 Fies ... 

Locate the folder Lesson 8 and open the FPLAIN.DAT file. Click 
Open and OK to load the project. 

110 lOCornponents ·...;: 

Is The loU OWing components Will be lo~ed: 

5i lli20 ll 9:42 AM F~e folder r r 
9/24i 20 10 9: 20AM DATFie r r 

r r· 

r r 

r r 

r 

r r 

~----------~============~========--~~ File nam"' IFPLA!N.DAT ::J I(FPLAJN.DAl] ::J 
, , .. 

Open •J C.oncol I QK --~' Q. 
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Step 2: Import the HEC-RAS channel 

Click File I Import HEC-RAS channels ... 

Ne\' ProjEct 

Open .TOP Project. .. 

Open Existi1g FL0-20 Project. •. 

save . TOP Project. .. 

save FL0·2D Fles ... 
Run FL0 -20 ... 

R.unMapper 

Run PRORl..ES 
Run RAIN 

create FPilOl.DI\T and cadPTS.DI\T 

Import: !mage 

Import: Elevatbn Ponts 
Import: Shape Fie ... 
Import Ran Ar1:lnfo ASCli Gnd Fte ... 

Import: CAD Graptl: Element5. .. 
Import: Levees. .. 

sa.e El>vatbn Poots ... 

Export. .. 

Ext 

In the Lesson 8 folder, open the BoiseCrk.prj file . 

{' Selectall[C .. AASI\letoopen n . 
- ~ -~~----- -- -

) • E>ca~TPe Projects • Lesson 8 • I Se~rdt L~8 · I 
.,, • !I tl 

lrwe - ,, 
tEs t 

Bo:seCrlc.pr; 

5/ 13/20 13 9:42AM F""e fo~der 

5/ 13/ 20 13 9:41AM LttraEd;tDocument ( .... 

~----~~========~~~~~~~ 
FilE name: lsoise( rk.plj ::::J jHEC-RAS Project File-.; ('•.prJ) 3 

Opon •J C•ncel I 
a 

The GDS will automatically convert the HEC-RAS cross section 
data to into a FL0-20 cross section file XSEC.DAT. Click Yes and 
Save to complete the cross section conversion . 

t I ~ t , 

\Y~ you lice to 54ve cross~ from 
C:'j.Jsers'/'lbic\poa.monts 'fL0-20 Bosic Doc\Jment.o tion'Exem;>le 
Projects\j.esson 6\test'llotseCrk.P<J o:s • FL0·2D xscc f.o? 

Yes No 
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The left bank line of the HEC-RAS channel and the cross lines will 
be loaded in the GDS. These are reference lines to be used to cre
ate the channel features. They do not represent FL0-2D channel 
data. That data will be created in the remainder of the lesson. 

Step 3: Convert the HEC-RAS channel to a FL0-2D channel 

On the Tools menu click Convert HEC-RAS Channels to FL0-2D Chan
nel Segments . 

Opllons 

Measure Olstarce along l.i1e 

<:ompute Average Poilt Rai1fal Depth 

J:nterpolotoVanable Rai1fal 

Levee Express Edtor 

fbatlng Varnbles E<press EdiDr 

cre.te Channel Segment wth a Polytle 
cre.te a 005> 5edlon 
Asggn a HEC-AAS cross sectiln to a Chamol a..r
Auto Asggn HEC -AAS cross s.ctbns to Channel E!elnem 
Convert HEC·RAS Xsec \<> R.0 ·20 

Click Yes to create a grid layer and OK to close the dialog box. 

f I 11 ? f) fond Oevdopt~r ~ 1111 /0 Gr1d Developer 'Jt 

Yes I No 01< 
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Step 4: Load aerial image 
Click File I Import Image I Individual Image .. . In the Lesson 8 folder 
open the *. bmp image . 

.,dt ct lnldgec; to 1mport lS 

Step 5: Realign the channel segment 
Zoom in on the channel. 

I Standard inage h:vmal:s 

r Open as read-only 

Open 

Cancel 

The image below shows that the channel segment does not always align 
to the left bank (Green Line). It is necessary to realign the channel seg
ment to the left bank. Left click anywhere along the channel and click 
Realign Channel . 

E.-: Channel segment p~ 
~ Channel5egmeot 
Delel1! Channel segment 
Invert Channel Segment onctlln 

~nEmmiJns 
PtltCm5s5ec!Dn 

f<s3gn Cm5s 5edtJn Number 
PtJt 30 Channel 

Oear-Rgtt-
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Realign the remaining channel elements using the background image and 
Green Line to help determine the left banlc 

The align channel tools are shown below. After using pan or zoom out, 
start editing again by clicking the Edit Channel button. Click the insert 
channel node button to add a channel element. 

Edit Channel 
Pan Node 

Note: To remove a channel node, 
drag it into a neighboring node. 100%View <D~ ' e~J~I ~ 4i~J ~ Insert Channel 

Node 

Previous 
View 

Activate 
Zoom 

To realign the channel, click and drag the blue dots to the desired grid el
ements. Once the channel alignment is finished, click the Apply button. 

r Realtgl Channel 

I Apply j Cancel I 

The following dialog box will appear as a reminder to add new channel 
element data such as channel (e.g. width and depth for rectangular geom
etry or cross section data for natural channels) and to recalculate the right 
banks. Click OK. 

II 0 ! 0 Gnd Developer · r.: 

l•) After re~ent:, channel segment rM'y have ne~ elements. Please edd d¥.!1 to new elements. 
For N type elemerts, nterpolation d ooss sections may need to be performed. 

You also need to rec-"cUate the til:jlt banks. 
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The interpolation and the right bank assignment will be completed later 
in this lesson . 

Step 6: Assign the cross section data to the channel 
Save the FL0-20 data files by clicking File/Save FL0-2D Files . Click 
View/Cross Section Numbers . 

.... ...... 
Zoom OI.C: Prevloos 'h!\v 
zoom out 10% 

Pan 

i..ayer.l.l5t. .. 

DTM Prnt Elevatt>ns Rendemg ..• 

Track Elevation POOts 

Grt1 Eenent Numbers 
Goo Element Bevatnn vakles 
Goo Element Manntlg's n·Vakles 
Gnd Element Curve Number.> 

Gnd ..• 

Components 

~ ElevatDn P<rlts 

Manntlg's n-Vakles Rendemg 

GOO Elemert Elevati>n Rendemg 

H9i'A9ht Grtl-Number ... 

eels wtf1oi.C: Cross Sectt>n Numbers 

Redraw 

From the Tools menu, select Auto Assign HEC-RAS cross sections to 
Channel Elements and click OK. 

HeiiSlR Oistilfl<l' along U1e 

COmpure Aver.qe Pol1t R.arial Depth 

lritefpolatl! Vanable R.arial 

LeVee Express Edlnr 
Fl>aOOg v.- Express EdiJJr 

. -
create Olannet Segmentwlh a~ 
Create a Cross SectiOn 

A<51gn a HEC-IIAS Cross sectDn to a Channel Element 
\ I ' ,, I • ( • ,:, < • ' • , I ' • ' I ~ • I , 

COnvert HEC·RAS Xsec to R.0 -20 

~ .. ~~-~r;:." toR.0·2~..!l"'(~~~-

II 0 JU c,rld Oevebper 

15 HEC-RA5 cross sectbns \'Vere ~ned to channel elements 

OK 

Once all HEC-RAS cross sections have been assigned click a channel el
ement and click Edit Channel Segment Parameters . 
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Segment conllol 

Modty Chlllllel 5~ 
Delete Chame1Se!jlll8rt 
Invert ~ Segment Direction 

Reoion Channel 
Realign Extensklns 

Pk:t Cross Section 

Ass1gn Cross Section f\Mnber 

Plot JDChomel 
Clea- Problematic Right Banks 

Review the list of cross sections for mistakes such as assigning the same 
cross section twice. Fix any potential cross section problems by chang
ing the Cross section number. Click OK and Yes to Validate the table. 

MaMrnun Froude runber ro-- RotJQrtl= acjustrnert ~ Compute scour/deposition with r--- I 
coel~cient 10 sedment transport routile: 10 

lnrliol flow depth 
lnirol How depth for all chamef etemerts jo 

h 't cr--.. 
l I ~r, 

r- CMmel geomelly 

Interpolate C10ss Sections 

Calculate R~hl Blinks 

A 

_j 

A~~s~~~~~pe r Total channel 
segment length: 14441.073 

~ ... h r-' < 

[ 

r- ro- ro- ~ 
r:;-- r- ru- r-~ I r-

ro---- l_· ro- r- ~ ro-
Right Bank Cell ro----

.O.K l:ancel 

Step 7: Interpolate the cross sections 
Only 15 channel elements have cross sections assigned so far. It is nec
essary to interpolate these cross sections to the intermediate channel ele
ments without cross sections to complete the channel geometry. Left 
click anywhere on the channel and click Edit Channel Segment Parame
ters . 
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Mocify ChanneiSegnent 

Delete Charnel Segmort 

Invert Channel Segment Owectlon 
R.,..gn Chonnel 
Rea5gn E"tensbls 
Plot Cross Section 
Assign Cross Section 1\k.smber 
PlotDChornel 
Clear Problematic Rii'lt Banks 

FL0-2D Model Lessons 

Click the Interpolate Cross Sections button on the Channel Segment dia
log box . 

lntetpolate DOR: Sedtons I 

A series of message boxes will appear. Click OK through all of them. 

. ~I 
Do not Interpolate the cross section sk:lpe. cn::l geometr: · ~ ....... ............. ~• ... -......... .. ·-....~ 
aDcrosssections havebeenprep~ed lnXSEC . DATarll • - • • 
have been ~sir;Jled to channel elements h the GOS Cl 

WARNING: there are 1 chamel se!JOOf\tS ..othW; outflow element . 
OK n IS recommended that al cllannel segments have oc.tftow cord ions. 

II 0 2D Grad Developer OK 

j } Intetpolat:ion was performed . 
f' Channel SOIJTl<'Ot dialoo wl be loaded a<Jaln to update the vai.Jes . 

OK I 0 

i,) Press OK to continue 

.Q.K J;ancel OK 

Now each channel element has an assigned or interpolated cross section 
and the XSEC.DAT file has been updated. Note that the original cross 
section names are now preceded by X- in the XSEC.DAT file . 

Once all the cross sections have been interpolated, a cross section plot 
for each channel element can be viewed. Left click the channel and click 
Plot Cross Section . On the cross section plot, the Previous and Next but
ton options can be used to move upstream and downstream through the 
channel elements . 

Edit Channel Segment Parameters 

Modify Channel Segment 

01!!:/ete Channel Segment 

Invert Channel Segment Direction 

Realign Ch1nnel 

Realrgn Extemaons 

Plot Cross Section 

Assign Cross Section Numbe1 

Plot 30 Channel 

Clear Problematic Right Blinks 
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013 

so I 
I __ --

J Q 

_ _:_ _ _j 

Step 8: Calculate the right bank elements 
Click the Calculate Right Banks button on the Channel Segment dialog 
box. Click Save and Recalculate. 

Calcul~e Right Blinks 

~c c.JI<ulate Rrght Sanks \ 

When rec8c~eti'lg the right ba-lks Fl02D file$ may need 
lo be saved WoUdyou like to save the fkt? 

Click OK through the series of dialog message boxes. Note the last col
umn of channel right banks in the Channel Segment dialog box is now 
filled. 

Step 9: Fill in missing right bank elements and realign right banks 
It may now be necessary to manually adjust the right bank elements. In 
some cases, the right bank element is not calculated an must be input 
manually. 

II() Jl) (Jild l>eveloper ": 

WAANUIG: the lubvilg chanoo griJ elements have o rqht bank. 
5 142 

OK 

Zoom in on a missing right bank. Choose a right bank element that fol
lows the general line of the right bank. Write down the grid element 
number of the desired right bank element. 
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Left click the channel and select Edit Channel Segment Parameters . 

Modify Chomel S"'J1l0f1t 
Delete Charnel Segment 

Invert Chamel Segment Direction 
Realion Cl'w!nel 
Reaion Extensions 
Plot Cross Section 
Assign Cross Section r-.l.lmber 
Plot 3D Chomel 
d ear Problematic Right Banks 

On the channel geometry dialog box, click the Edit button . 

- Chonnel geometry -
CEJ] Element oeoth X Sea left Slooe RJoht Slope Right Benk s ~ 

Numbe~~:~~;~~ r--- 48 5613 ~ ~1 

~\f 49 5495 49 5493 
50 5377 50 5375 

I 51 5259 51 5257 
Interpolate Cross Sections 52 5142 52 0 

I 
53 5143 53 I 4905 

Co.!culo.te Right BMks 54 ljH~ 54 4906'"' ;' _j 
55 5026 55 4]67 

Examme R1ght Bonki I l..!J 56 5027 56 47Ba:El=.J 

I 
Ass1gn ttus Shepe jf 

to Selection s~o::r~~~ ~ 
~,...._.,___ __ 

_ J ,~~-~-----

Select the missing right bank element by clicking on the cell with a zero 
in it. Enter the desired right bank element in the Assign this Value to Se
lection dialog entry and click the button. When finished, click OK to 
close the Channel Geometry dialog box and OK to close the Channel 
Segment dialog box and Yes to Validate the Channel Variables . 
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C11dnnel Caeometry ... • • 

49 
50 
51 
52 
53 
54 
55 
56 
57 

" 
OJtand Paste 

.Copy O.ment Row I .Eoste to S eleded 
Rows 

QK C:oncel 

Zoom in on the upstream section of the channel and pan downstream un
til a right bank adjustment is desired. Click on the channel and click Re
align Extensions. 

Edtt ChoY'fleJ Segnent: P~r.!lllleters 

Mod1fy Chomol ~t 
Delete Chamel Segment 
Invert Cham~ Segment Dltection 

Realion Clwlnel 

Plot Cross Section 
Assign Cross Section ~mber 

Plot :J:>Chomel 
Clear P<oblematic R;;# Banks 

:f .. I 
·--! ~ . . '. ! 

A-,' 
....,_ I 

J
·.l .. ! .,--,. 
' ,_ 1 

I I 
i I 

\. 

Once the right bank elements are aligned save the FL0-2D files. 

Step 10: Create a channel inflow and outflow node 

Inflow Node 

Right click on the first channel element and click In/Out Condition for 
Element ****. 

160 I Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

In/Out Condition for Element9819 

R~oir Water EI~NatJon fo r El~ent 9819 

FL0-2D Model Lessons 

Fill out the In/Out Condition dialog box as shown below and click Read . 

ln/<)ut <- undltton rorCrid Element 1382 

('i jnftowelement with hydrogro.ph 

r Outllowelement(nobydrograph) 

r Outtlow elementwith hydrogroph (dNSrston) 

r Q.u1!1ow element wrth stage-tame relationship 

r Outflow element Wllh stage-time end ftee 
ftoodple.rn and dlonnel 

r. Floodplain 1 (' 

t Qlonnel outflow element(WIIh stage-dtscherge) 

r .Mo mllow/outflow condtiiOn 

Hydrograph (F20_TO_GDS_ 1 H'ttl) 

lc:::JE:l 
Save I 
J;;drt 1 

',';awGraph J ~ p-
lnme.l lime Fmol time 

QK J. ~.cnce l _j 
- - -- ---

Select the HYD file and click OK. 

ttydroqraph fie .-~ 

Select ~rogu~ph fi le type 

t t:!EC-1fite 

r JAPE21 fi le 

.. ffiij]jgJ 

r e,3Cll 1tle 

QK Cancel 

Load the file F2D _TO_ GDS _l .HYD. Click the View Graph button . 

Hydrogroph(F20_TO_GDS_1 H'ttl) 

r- Mud hydrogro.ph 

I~ 

',';ew Graph J F-- r-
lnrtJcl llme Ftncl time 

161 I Lesson 8 



FL0-2D Model Lessons 

llydruqroph (I Jll _lO_GDS_ !.H~) _ 

100 

" 

" 

" 

0. ~5 0.59 0 . 75 1.00 1 . 25 1. 50 1 .75 ~ . 0~ 

Ti::"e 

Click OK to close the plot and then click OK to accept the inflow hydro
graph. 

Outflow Node 

Right click on the last channel element and click In/Out Condition for 
Element ****. 

Reservoir Water Elevation for Elemert 3881 I 
Fill out the In/Out Condition dialog box as shown below and click OK. 
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In/Out ( ontJ1hon tor Grid Element 4350 

r Jnftow element \lrl'lth hydrogroph 

I (i P utflowelement(nobydrogrophij l 

r Outflow element with hydrogroph (drverSIOn) 

( QutHow element. With ste.gEHlme relationship 

r OUiftow element With stage-tme and free 
noodplom and channel 

r Aoodplom r Olo.nnel 

r Qlannel outflow element (With stoge-d•scherge) 

I tiD lnfiOW/OutiiOWOJOdrtiOO 

r 

QK !;oncel 

In this case, the outflow node is higher than one of its neighboring grid 
elements . 

11 o Jll ~rid Developer 11· 

WARNING: The outfb.v element 4350 shoukj have a b\ver elevaiX>n than the 
upstream conti)uous non-outro.·o~ elements . 

OK 
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796.11 

195.11 

196.ot 

795.87 

1952) 

The outflow cannot be calculated correctly unless there is a negative 
slope. Create a negative slope by lowering the grid element elevation at 
the outflow node to just less than the lowest neighboring grid element. 
In this case the lowest elevation is 79 3. 65 . Double click the outflow grid 
element near the red oval to activate the Attributes of Grid Element 
Number****. Lower the elevation and select OK. 

.,., .. ns.n 795 .. 1 

l'IUI 115.10 

Aoodplem elevation ~eeQ ~ 793 .62 

Mennmg coeffioenl <,::j o .~02::::7 == 
l.Jmftlng Froude jo.o 

Delto X r.;l20;---

Dello Y J20 

Seduction Fodors I Multiple Chonnel 

_ _c::..Leve_e _ ___,j -----::--:--' 
lnlittrotJOn I r Do not shore discharge 'W'rth 

-----'· the noodpiOJn 

I MODFL0.20 

.QK (;ancel 

1'11.17 m.n rn.n 

Inflow and outflow parameters are defined and the model is ready to run. 

Step 11: Save and Run 

Summary 

Click File/Run FL0-2D ... Make sure the FL0-2D Control Variables di
alog box is filled in like the one below. Click Run FL0-2D (Save Files) . 

This GDS lesson demonstrates the steps required to create a natural 
channel from a HEC-RAS channel. The HEC-RAS data used in this les
son was edited to fit FL0-2D top-of-bank stations. All cross sections 
were trimmed to the bank stations and the channel was trimmed to just 
15 cross sections. The lesson also illustrates the channel editing tools 
available in the Basic GDS. 
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Review Questions 

1. Identify three types of channels that can be used in FL0-2D? 

2. True or False It is necessary to have a Geo-referenced HEC-RAS project to import 
channel into the GDS? 

3. Which bank is the channel segment assigned to? 

D Right bank looking downstream 

D Left bank looking downstream 

D Channel thalweg 

4. Which tool is used to convert HEC-RAS cross section data when the project is not geo
referenced? --------------------------------------------------

5. True or False It is recommended to align the left bank prior to entering the channel seg
ment attribute data? 

6. Which program is used to view and edit channel bed slope and cross section data? 

7. The right bank assignment in the following image is incorrect. Explain how to fix it. 

8. If a channel outflow node is assigned to the last channel element of a segment and the 
slope is negative the model will terminate with an error. Explain how to fix this problem . 

9. Channel help documentation is found in which locations? Check all that apply . 

D 
D 
D 

License Documentation 

Data Input Manual 

Reference Manual 

D PowerPoint Presentation 

D Pocket Guide 

D Workshop Lesson Book 
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LESSON 9- HYDRAULIC STRUCTURES 

Overview 

Required Data 

Content 

Discharge is controlled by hydraulic structures using either rating curves 
or rating table data in FL0-2D. A rating curve or table can be made for 
bridges, weirs, culverts and other hydraulic structures using HEC-RAS, 
weir equations, culvert equations/tables or various hydraulic structure 
software programs. Hydraulic structure data is entered using the GDS. 
This lesson details the process of creating hydraulic structure data files . 

The FL0-2D grid system files and a hydraulic structure rating table data 
file are needed for this lesson . 

Location* 
6 *.DATfiles FL0-2D data files \Example Projects\Lesson 9 
Rating table ... Rating table data \Example Projects\Lesson 9 

*Typically these folders are in installed under C: \Users \Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

To create a FL0-2D channel from HEC-RAS data using the GDS, follow 
these steps: 

• Open the GDS program and load Lesson 9; 
• Load aerial image; 
• Locate and create all hydraulic structures; 
• Enter rating table data for the detention basin outlet works; 
• Save the project; 
• Manually enter the rating table data; 
• Reload project in GDS and run the model. 
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Step 1: Open the Grid Developer System and load Lesson 9 
***NOTE*** Using an Explorer window, make a new folder in the Les
son 9 folder named "TEST". Copy all the lesson 9 files to this folder and 
perform the lesson in the TEST folder. ***NOTE*** 

Double click the GDS Basic icon from the desktop. 

From the GDS File menu click Open Existing FL0-2D Project ... 

New Protect 

Open . TOP Project ... 

Save . TOP Pto]Cct ... 

Save FLo-20 Fies .. . 

Locate the folder Lesson 9/TEST and open the FPLAIN.DAT file. Click 
Open and OK to load the project. 

\. 1 ) Y FL0·2D Y Example Projects Y l"""" 9 Y !Est I search test 

o rgaroze y New - -~' y t) 

FL0·2D v20 =.] Name • j Date modlled I Type 
--~----------------~------~~-----1 

Documents 

FL0 -20 

J Musi: 

.. Pctures 

VIdeos 

·~ Homegroup 

&. Computer 

HP (C:) 

W FPLAIN.DAT 2/14/20118:45 PM DATFie 

v FACTORY _II' ..:J ..:.'J__-;;;;;;;:;;;;:;;:::======;-;:::=:::;::'------,~ 
Filename:!- :.:J jCFPlAIN.DAT) :.:J 

I Open . •I Cancel I 
.,( 

11 o lU Components ·:: 

The loiiOW1ng componenls Will be loaded 

~ Channels P' lnf1lrro.tlon 

r;- Reduction fo.ctors r 
r;: Streets r 
P" Outflowelements r 
P" lnflowelements r ~ 

P' Levees 

r r 

r 

QK ,Ccncel 

Step 2: Importing aerial images (see Lesson 1 - Step 4) 
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Step 3: Locate and create all five hydraulic structures 

Use the following image to locate and enter 5 hydraulic structures . 
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The first hydraulic structure is the outlet works for a detention basin. 
Click Tools/ Hydraulic Structures/Create New Inlet and Outlet Grid El
ement. 

Options 

Measure DIIID""" abng l.l1e 

Compute Average Poilt Rarlfal Depth 

Irterpobte Vanable Rar1fal 

Levee Express: Edtor 
Fbatng vambles Express ~ 

Create ChannEl segment wth a Polylne 

Create a ooss Sectbn 
Assign a HEC·RAS Cross Sectbn to a Channel Element 

Auto Assign HEC·RAS Cross SectiJns 1D ChannEl Elements 
COnvert HEC·RAS Xsec to Fl0·2D 
COnvert HEC·RAS Channels to R.0·2D Olanne segments 

Delete HEC RAS Olannels 
Delete HEC RAS Cross 5edlons 

create - segme<t 
Create street 5egmert v.«h a Polylne 

Create Levee segment v.«h a Polylne 

Create Detention Basil 
Mud and Sedinert Tr.msport 
Evaporation 

MODFL0·2D 5mul!too 

Rar1 
Breach 
NOFLOCS 

FrodW.w.hed 

create fbodplail cross SectiJns 

Levee Profle 
stre<tProfte 

1. • 1l• 1,,..,. J ,. l 1 • I I • 1 <, •I ~ • 1 t " 

Select Extsti:lg Hydraulc structure 

Click OK then click the two grid elements in the order shown in the fol
lowing image: 

I I 0 J() ~rid Ocvek>per ,~ 

Ckk on the 1111et gl1:l element fi"st. Then on the Outlet g!lj element 

OK 
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Once the outlet element is clicked, the Hydraulic Structures dialog box 
will appear. The Change button in the Hydraulic System Structures 
group allows the user to enter the data as shown in the Add Hydraulic 
Structure dialog box. All structures are presented in the following im
age. Use it for reference . 

Hydrauhc Structures • !i . 

Warning: Do not enter spaces in the 
Name field. 

Hint: The rating table data is found 
in the Rating Table Data.xls file in 
the Lesson 9 folder. 

r· ,. "' "'· 
I 

•. j.~ ~~t ~ - -----

OK C.ncel 

~ 
la&@d 

~ 
~ 
~ 

___j 
__::j 

~ 

The Change button in the Structure Rating Table group is used to enter 
the rating table data using the Rating Table dialog box. Enter a rating ta
ble of 0,0 and 1,1 for all structures. Data will be filled in for all tables at 
once later . 

StnJcttMe Nome: IPetBo~n 

Flood SouctUJe , 
r Floodpto;n r Chamet r. ~.;,to 

r Struch.re Aaling 

Hint: The Headwater Depth is only 
used when the structure doesn't turn 
on until the water surface elevation 
must reach a specified value . 

(" StnJdtAe Ratilg O..ve (; Strudure Aal:i'lg T;,ble 
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OuttetNode· ~ 

TOiiWote<Effect r 
Aefe~erc~;~==: ~ 

Cllvert 01 c~ Length: ro----
CIIvert or Cord.i Wldllr ro-----

OK Close 

Ratmg Table 

OK Close 

Depth:,-

Oiocilorge<~ 

,-----
OK Close 
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Zoom in on the second group of hydraulic structures and assign the inlet 
and outlet node for each structure. Click Tools/ Hydraulic Struc
tures/Create New Inlet and Outlet Grid Element. Enter the Hydraulic 
Structure control data and 0,0 1, 1 rating table data. The rating table data 
will be filled for all structures in Step 5. 

Str~.Cture Name lwc<Jver~ 

Flood Struc:tue 

l r Ftoodolon r. Channel r Floodploin to 
Chomel __ j 

Structue Aatng 

r Structure Aati1g Curve r. Structure Aaling Table 

lrletNode: ~ 

OuUetNode. ~ 

ToiiWett:! Effect r 
Reterenc~;:~-: ob;~ ro--

Cut.lert"' Con<klit Length· ro-
Cut.lert 01 CorniJrtWrdth ro--

OK Close 

Str~.Cture Name IE Culver~ 

Flood Structure 

r Floodplan r. chennel r ~=.f" to 

I-
; StructureRal~ 

r SlruclUJe Rating Curve r. Structure Rating Table 

lrletNodO"~ 

OutfetNode ~ 

ToiiWett:!EIIect r 
Referent~;:= Q~~ ro--

Cut.lert"' CorniJrt Length· ro-
Cut.lert 0! ConrUWidth ro--

OK Close 

Zoom in on the final group of hydraulic structures and assign the inlet 
and outlet node for each. Click Tools/ Hydraulic Structures/Create New 
Inlet and Outlet Grid Element. Enter the Hydraulic Structure control da
ta but do not enter the rating table data. 
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Fie 

5 

5 

Add Hydrcmhc <;truc-turP ? •"' 

Stn.o:t.-e Name_ JH26Ciw' 

I F~od Struct.-:_ r._ c~~l . -; ~~i ;~ · J 
• Stn.rcture Ratng -

1 r Structure Ratir-19 Curve {. Structure Aatr.g Table 

lnlotNodo:~ 

Outlet Node. rme-
Toi1Wete1 Ellect r 

Relerenc~~-= =~ ro----
Culvert or Coodlit Length· ro---
Culvert or CondJI Width ro----

OK ~•e 

Add Hydrc1uhc c;tructurf" _, 

Struct.-e Nome Jjj26CE 

I 
Flood Stroctue - · 

r Flood,Jai1 r. Channel r Floodploin to 
Chomel 

r Struct.-eRati1g 

r StnJCtwe Aati1g Cusve r. Structufe Ratng Table 

lnlotNode ~ 

OulletNode· ~ 

TeiWete~ Elfect r 
Referent~==~ ro----

Culvert or CondJil Length· ro---
Culve~t or Conrut Width ro---

OK ~•e 

Step 4: Save the FL0-2D data files . 
Click File/Save the FL0-2D Data Files to the Lesson 9 Test folder. 
Click OK to select an inflow hydrograph for the graphic display. Click 
Save NOFLOCs List . 

1 nnuw Lrid l Jen~ents : 

QK ~ -~ 

NOf iO< -. ··. 

The following ctu~nnel elements are porentle.l NOFLOCs 
(contiguous channel elements that perhaps should not 
share discharge) Remove any a pmr of NOFLOCs thet 
consbtute the conneded dumnel How polh 

4558 46t2 
4559 461t 
4559 4612 
4559 4613 

S.eve 
NOFLOCs list 

lijostoro FLOCs us~ 

--·Qonc:_j 

Step 5: Fill out the hydraulic structure rating table data 
Open the HYSTRUC.DAT file in the Lesson 9/Test folder using Word
Pad©, UltraEdit©, TextPad© or NotePad© . 

Edt Formot "'"' Heb 
oetsasin 2 1 1429 14 28 0 4 703 

T 0 0 
T 1 1 
wcul vert 1 1 2241 2276 0 0 0 0 

T 0 0 
T 1 1 

Ec ul vert 1 1 2498 2 537 0 0 0 0 
T 0 0 
T 1 1 

H260'.; 1 1 4 559 4558 0 0 0 0 
T 0 0 
T 1 1 

H260E 1 1 4665 4664 0 0 0 0 
T 0 0 
T 1 1 

~ 
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Cut and paste from the Excel file to complete the HYSTRUC.DAT file. 
It may be necessary to replace tabs with spaces if using NotePad or 
WordPad. 

AIJ HYSTRUC.OAT · ltotepad "__ 

Fie Eat Rlrrna!t View He\:> 
5 oet Bas in 2 1 1429 1428 0 4703 0 0 
T 0 0 
T 0 . 1 3 
T 0.2 5 
T 0 .3 8 
T 0 . 5 10 
T 0 .7 1 5 
T 1. 0 20 Note: Use the same data for High-
5 wc ul vert 1 1 224 1 227 6 0 0 0 0 

way 260 W and E. T 0 . 00 0 
T 0 . 9 5 10 
T 1. 62 30 
T 2.43 70 
T 2. 77 95 
T 2. 94 109 
T 4 .4 4 220 
T 5. 33 322 Hint: Replace all Tabs with Spaces T 6 . 52 54 7 
T 6 . 91 659 when copying data from Excel. 
T 7 . 52 865 
T 8 . 95 1427 
5 Ec ul vert 1 1 24 98 25 37 0 0 0 0 
T 0.00 0 
T 0. 6 3 10 
T 1. 18 30 
T 1. 87 70 
T 2.25 100 
T 2.64 136 
T 3. 74 27 5 
T 5. 20 40 3 
T 7.21 683 
T 7. 81 823 
T 8. 65 1081 
T 10 . 36 1784 
5 H260W 1 1 4559 4 558 0 0 0 0 
T 0 .67 6 
T 1. 43 19 
T 1. 71 30 
T 1. 88 4 2 
T 1. 99 53 
T 2.1164 
T 2 . 22 75 
T 2 . 36 87 

~ 

Step 6: Reload the project in GDS and run the model 

The project data files were edited outside the GDS. Reload the project 
by clicking File/Open Existing FL0-2D Project ... 
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New Pro)l!d: 

Open .TOP Pro)ect. .. 

save .TOP Project ... 

save R.O·ZD Fles. .. 
Run R.0·2D ... 
Run Mapper 

Run PROm ES 
Run RAIN cr- f'Pml.DAT and cadPTS.DAT 
C~ LEVEECRESTS.OAT 

\.. J • R.0 -20 • Exampe PrO)ects • Lesson 9 • test 

Orgarire ... New fctier 

FL0·2Dv2o~_Name..:.._=·=------~---=:'j=oate=-modted....::..:.===--LI Type::"::=-- -=/ 

lbranes C II ,\ J' ' ' 'I• II I 1\ ",~ \1 t 

Documents j FL0-20 

J Music 

• Pictures 
Vkleos 

·~ Homegroup 

'-Computer 

HP(C:) 

v FACTORY_ll ~ < 

f i-le~n~a-m-e~: j;FP=~==IN:.d:a:I :::::::::::::::::::~~~~;FP=~==IN=.D=A=D~ 
I Open ,•I 

Click File/Run FL0-20 and fill out the Control Variables dialog box as 
shown below. Click Run (Save Files) . 

II o )f> < ontrol Vc~ti.ablt'!"i .... ··~ • 

1 Time Control and Plot Veriebles 

SimulotionTtme(hrs). rs-
Outputln1eNcl (hiS) ~ 

GraphlcsDtsplay (' Text Saeen 
r. Oeto1led Grophtcs 

r r Backup Ftle 

System Component Swrtches 

Giebel Data Modificotion 

n-velueAdjustment ro-- l.Jmrb~~~~~~~: ro:as-
Fl~~::f~~~~ ro--

Bulkmg Concentration ro-
Areo ReductJon Foetor ro--

Aoodpfom Oisplo:y Options 

ShoUo~: v-
r--

J7 Mom Channel P' :Alec Reduction Foct01s ARE)} Pnnt Options r.jN-;:o-;Fl:;-o-od7p71c7in-;0:;-u:-:1p--;u1----:iJ~• 

17 Streets 

P" l evees 

r MuH1ple Chonnels 
!Rill and Gullies) 

Phys1cal Processes Switches 

,- Reinfalf (" Mud,/Oebns 

P" lnfiltrallon 

r Evaporo tJon 

r Sed1mentTronspol1 

(" None 

r MOOFLD-20 Modelling 

Conveyance Strudure SWitches 

~ Hydraulic Suuctures 

r- AoodwayAn~1S 

r Oebns Bosm 

Numenco.J Stobllrty Parameters 

SurfaceOetentJon ~ 

Percenl Chonge 1n FlD'III' Depth ~ 

r Arumota Flowwittun GOS 

r Create SupercntJcel Output F1le 

Channel D1spley Options 

Oteck "Me.1n Chtumel" to odJVOie 'Channel Pnrrt Options• 

Cho.n~e~t:"n~ j No Cttonnet Output 

Time Lapse Output 

r Time l.cpse Output Output lntervot (hrs)· ro--
GraphiCS 0 1splo.y 

Seled "Oete.JiedGraphiCS"In "T1me Conbol and Plot 
Vcmr:~b les " home 

UpdeteT1me lntervel {hrs) ~ 

[}ynomlcWf:NS Stt.bllrtyCoetlla ent ~ 

Cowont Number (range 01 to 1 0) ro.s---
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rr==== ==== = ================= ========n NodeSpxioa (ft)· so.oo 

~ammmmmmE==~ ~~ 
Inflow ycrograph (cfs ) 

,, ~ , 1 . ') ., . ~ ' J t ~ ~ :. 

11felhrc) 
--------- -·--

Review Questions 

1. Name 3 sources of rating table data? 

Simulation Tim e · I 90 
Cun...ai/A v e TiP> ~t:.p l 0702 l OS 

Volu 121e Coas.erval i OD 
acre-fi v. of inflow 
0 000000 0 00000 5 

Dep1h Lege n d 
9 5 < DEPTH c 10 
9.0 < DEPTH < 9.5 
8 5 < DEPTH < 9 0 
8.0 < DEPTH < 8.5 
7 5 < DEPTH < 8 .0 
7 0 c: DEPTH < 7 5 
6 .5 < DEPTH < 7 .0 
6 0 < DEPTH < 6 .5 
5 5 < DEPTH < 6 .0 
5 0 < DEPTH < 5.5 
4 5 < DEPTH < 5.0 
4 0 < DEPTH < 4 .5 
3 .5 < DEPTH < 4 .0 
3 .0 < DEPTH < 3 .5 
2 5 < DEPTH < 3.0 
2 0 < DEPTH < 2.5 
1 5 < DEPTH < 2.0 
1 0 < DEPTH < 1 5 
0 5 < DEPTH < 1 0 
TOL < DEPTH < 0 5 

DEPTH< TOL 

2. True or False? A hydraulic structure can transfer flow from a channel to the floodplain? 

3. True or False? A hydraulic structure can transfer flow both upstream and downstream? 

4. How many cross sections are needed to create a hydraulic structure rating table in HEC
RAS? 

5. True or False? A channel hydraulic structure cannot have any channel elements in be
tween the upstream and downstream nodes? 

6. Which output file reports hydraulic structure flow data? 

7. Name 5 different hydraulic structures that can be modeled with a rating table : 
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8. Briefly explain how the head reference elevation works for a hydraulic structure : 

9. Hydraulic structure help documentation is found in which locations? Check all that ap
ply: 

D License Documentation 

D Data Input Manual 

D Reference Manual 
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D PowerPoint Presentation 

D Pocket Guide 
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File 

FL0-2D Model Lessons 

LESSON 10- LEVEES, WALLS AND BERMS 

Overview 

Required Data 

Content 

This lesson outlines the procedure for creating and editing levee data us
ing the GDS. The FL0-2D levee component can be used to simulate any 
embankment feature including berms, roadway and railroad embank
ments, floodwalls, sound walls, and privacy walls . 

The FL0-2D grid system files are needed for this lesson . 

Location* 
6 *.DAT.files FL0-2D data files \Example Projects\Lesson 10 
Levee Points.xyz Levee Polyline Data \Example Projects\Lesson I 0 
LeveePolyGoat.xyz Levee Polyline Data \Example Projects\Lesson 10 

*Typically these folders are in installed under C: \Users \Public \Documents \FL0-2D Basic Documentation 

Step-by-Step Procedure 

To create a embankment structure using the FL0-2D levee component in 
the GDS, follow these steps: 

• Open the GDS program and load Lesson 10; 
• Load aerial image; 
• Create berm around detention basin; 
• Build a levee along channel using the polyline tool; 
• Create a sound wall with a polyline; 
• Create a levee from an imported 3-D polyline; 
• Import levee along levee crest points; 
• Save and run . 
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Step 1: Open the Grid Developer System and load Lesson 10 
***NOTE*** Using an Explorer window, make a new folder in the Les
son 10 folder named "TEST". Copy all the Lesson 10 files to this folder 
and perform the lesson in the TEST folder. ***NOTE*** 

Double click the GDS Basic icon from the desktop. 

From the GDS File menu click Open Existing FL0-2D Project ... 

New Project 

Open .TOP Project. .. 

Save .TOP ProJect .•. 

Save FL0-20 Ales . .. 

Locate the fo lder Lesson 10/TEST and open the FPLAIN.DAT file. 
Click Open and OK to load the project. 

:@_; ~·~'f I .1 11'1 AIN.IM I flk• to open ' ~. 2!.1 
J • Fl0·2D • Example Projects • Lesson 10 • Test • • r:l sec-a-:rcll-::Test-:----

Orgal"'re • Ne\.V~ 

FL0·2D v20~ _.:.:Name:=_· ________ J..:I Da:.:.:t::_:_"::.::_'!Odti::.:ied::.__Ljlyc:.!pe::__ __ 
1 

Ubrai1es 

Documents 

FL0·2D 

• Music 

- Pictures 

VkJeos 

•?. Homegroup 

'Computer 
HP{C:) 

w FPLAIN.OAT 2/23/2011 12 :46 PM DATFie 

~ FACTORY_If.~_.U__;=:========;-;:::==~----,~ 
File name: IFPlAI~.DAT ::J I(FPLAIN.DAT) :o:J 

Step 2: Importing aerial images (see Lesson 1 - Step 4) 

178 I Workshop Lessons 

Open •I Cancel I 
k 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

FL0-2D Model Lessons 

Step 3: Create a berm around the detention basin . 

Zoom in on the detention basin. This detention basin was created by low
ering the grid element elevations. The berm (using the levee component) 
will increase the detention basin storage . 

The elevation of each cell within the detention basin was lowered to 
4702 ft . Click View/Grid Element Elevation Rendering . 

Zoom out Previ:>u5 '1/tf!tf 

Zoom OUt LO% 
Pan 

l.ayef>l.l5t. .• 

DTM Pool: Elev~ Rendemg._ 

Track El<vatiln Poi1ts 

Goo Element Numbers 
Goo Element ElevatiJn VaiJes 
Gnd Element Man!WlQ's n·VaiJes 
Gnd Elment CUrve Numbers 

Gnd •.. 

components 
o1 Elevafun Pot't3 

Non·ln1:et]lolatod Goo Elements 

ManrWlQ's n·VaiJes Rendemg 

~light Gnd Element Number •.• 

Cross 5ecti>n Numbers 

Use the Select Element by Element _!.1 button to select the grid elements 
surrounding the detention basin . 
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Turn off the elevation rendering by clicking View/Grid Element Eleva
tion Rendering. Click Grid/Assign Parameters to Selection/Levee. 

Create GOO 

Inteq>olate Elevatbn 1'00!5 
Interpolate from ~ Elevi!Uon f1es. .. 

Gr<en·Ampt Parameter. 

Compute Hanni1g coeftl;;ents. .. 

Compute SCS OJrve Number 

compute Wilth and Area ReductDn Fact"" 
Compute L.mli1g Froude Numbers. .. 

Dell'le lloundary Gr>:l Element. 

Setup ComputatJonal Area 

create Gril U!Yer 

Elevatbns 
Manni1g Coeft'dents 
Area and Wdth Reduction Facroo 

~Channel; 
lnltllv/outftow COndlb1 In-No Dtlcl>3rge Exchange 
T'rne-Varlant Groundwater Head 
Rigid Bed Element 
Limng Froude Number 

Assign a levee crest elevation of 4713.00 ft to the north cutoff direction 
and click OK. 

Levee d~to 
Minimum Floodplo.m elevotion (lee~ (of selected gnd elements) 

Flow ditedlon cutoff e.nd levee crest elevation 

r NorthWest P" North 

~ 
r west 
~ 

r SoU1hWest r SoU1h 

Ass1gn levee crest etevol10n 

Asstgntooll J r--
Ass•gn to seleded J 

r Levee la~lure for thiS dnection (North) 

r NorthEost 

r Eost 

r SouthEaS1 

Seled d•rectrons 

Selectl!/1 

Unselect a!l 

QK .C:encel 
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Hide the hydraulic structures by clicking View/Components/Hydraulic 
Structures . 

VEWAI 
Zoom Out Prevbus Vle\v 

Zoom OUt 10% 

Pan 

Layen; IJst... 

DTM POOt Elevatt>ns Rendemg.
Tradc EJevatjoo Poolt5 

Goo Element Numbers 
GOO Element Elevaoon Valles 
Goo Element Mannng's n-vatJes 
Grkf Bement CUrve Numbers 

•G!tl!!ii.-~~······ ,; Channels ., ~vatbn Poilts o.1 R.educti>n Factors 
Non-Intetpollted Goo Elements "' stre<ls 

,; outftolv Elements 
Mannng's n·Vatles Rendemg , Inflow Elemert:s 
Gnd ~Elevation~ _ "' Levees 

HoghlghtGoo Element Number.-

O"oss Sedbn Numbers 
eels wtrout Cross 5ectx>o Numbers 

ol Detentbn 8aSi'lS 

,; ~Channels 
,; InftraOOn 
,; No Exchange Channel-flood~ Elements 

"' flood~ cross 5edi>ns 

,; No Exchange Channel Elements 
., R.eserVar Water 8evatt>ns 

Watersheds 

Watercourse Drectnns 

Click the Levee Express Editor .QI button and build a levee around the 
detention basin. Double click an element with a levee in it to activate the 
levee express editor . 

L~eD~o·--~G~nd~•~le=m~en~te~l~=o~bo=ns=on=ro~lo=,.~d7bo=,.=,---------
Max.PlEtev 

ClmentGnd Element~ 
Ave H•gh(O) Pis ,-----

~ ~ 

r NorthWest j7 Nor1h 

~ 
[47oi"89' rwe-st 

~ 
r SouthWest r South 

1<7011< - -

Assrgn levee crest elevation 

Assrgnto all 
drrections 

[4702--

~ 

r NorthEast 

r East 
~ 

r SouthEo.sl 

Select duedlons ~ 

Seledoll 

Unselectall 

Qose 

Grid elements that do not have a levee assigned can also be edited with 
the Levee Express Editor. Select the element and click the Activate but
ton . 

181 I Lesson 10 



FL0-2D Model Lessons 

The following images represent the before and after pictures for creating 
the detention basin berm. Note that the levee does not go through the 
channel. Some grid elements do have both channel and levee compo
nents which is acceptable. 

There is no natural inflow feature into this detention basin so it is acts 
more like a water tank. Opening a gap in the levee on the upstream side 
would create a proper detention basin. Deleting the levee in between the 
blue lines in the image on the right would open the detention basin to 
natural inflow. The blue lines are not part of the GDS. Save the FL0-
2D Files . A lateral weir along the channel using a hydraulic structure 
could be used for detention basin inflow. 

Step 4: Build a levee along the channel using a polyline. 

Polyline drawn near the right 
side of the grid elements. 

- I 

When building a levee with a polyline, the cutoff direction of the levee is 
set by the proximity of the polyline to the side of the grid element. Test 
this process. 

t- . -1-- -t-
1 - f -
I 

L 1- l -
Jr------L---------------. 

·~ Polyline drawn near the top of 
the grid elements. 

Polyline near the bottom of the 
grid elements. 

Polyline drawn near the 
right side of the grid ele
ments. 
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Zoom in on the central lateral section of channel north of the small de
velopment. Click Tools/Create Levee with a Polyline. Click along verti
ces to draw a polyline matching the red arrow in the following image . 
Double click the last vertex to finish the polyline. Keep the polyline near 
the bottom of the grid elements to block the south portion of the grid el
ement. 

OpiDns 

Measure Distance ak>ng Lne 

Compm, Average P<*1t Rai1fal Deplll 

Interp<Ete Variable R.lilfal 

Levee Express Edtor 

FbatJng Variables Express Edtor 

Create O>.anne! segment will a Poiytle 
O'eate a Qoss. SecOOn 

""'fln a HEC-RAS eros. SEcti>n to a 0\anne! Element 
Auto Assign t-EC·RAS Ooss sections to OlanneiBements 

convert HEC·RAS )(sec to FL0·20 
convert HEC·RAS Channet5 ro R.o-20 Olannel Segmero 

Delete HEC RAS Channels 
Delete HEC RAS Cross 5ectDns 

Great< street segment 
Create street segment- a Poiytle 

Create Detention BaSin 
'1ud and Sedl"nent TraJSpOft 

Evaporattlo 

MOOR.0-20 Sinliatiln 
Hydratii:: structures 
Rarl 

Breach 
NOA.OCS 

Levee.,_ 
street Pralle 
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- --- ----

Fill out the Levee Elevation dialog box as shown below. 

I t'Vl't' I k•vdtion ~ 

Elev~IJon AJgorithm 

r Unrfonn 
1<695 EIB\I'otion 1 

(i lnterpolote 

. r Use DTM pornls 
Elevation 2 

Ok Cancel 

Click Tools/Levee Profile and note that the levee profile follows the 
slope of the topographic relief at a height of approximately 8 feet. De
tails can be added to the levee manually by using the Levee Express Edi
tor. Save the FL0-2D Files . 

OptX>ns 

Measore Dlst!nce abng Lhe 

Compute Aver..ge POOt Railr.l Depth 

Intl!fpolate vamble Rallfal 

Levee Expn!SS Edlor 

fbatng Varial:les Expn!SS Edl:of 

create <llannet Segrrert- • Pot,tne 
Create a Cross Sectbn 
A.Wgn a t·E<>RAS Ooss Sectbn to a ChanneJ Eement 
Auto 1\Wgn HEC-RAS Cross Secti>ns to <llannel Elements 
Convert HEC-RAS ~ ro FL0-20 
COnvert HEC-RAS <llannels ro FL0-20 <llannel Segmerts 

Delete HEC RAS Channels 
Delete HEC RAS cross 5e<:tl0ns 

create street Segment 

create street Segment wth a Pot,tne 

cr- Levee Segment 1-.th a Pot,tne 
Create DetentiJn Basin 

Mud ar<l5e<lrnent Transpo!t 
EvaporatDn 
MODFLQ-20 SlruAati>n 
Hydr;!ljc: struc:tures 

Ran 

Breach 
NOFLOCS 

Lev~-=- Cr~s t: and Gr: ound El <?vatl <:~ f! s 

·------ . 
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Step 5: Create a sound wall with a polyline . 

Zoom in on the housing development south of the highway. Use the 
Tools/Create Levee with a Polyline tool to draw the levee from South to 
North and East to West. 

Interpolate the levee crest elevation from 4670 ft to 4675 ft . 

l i'Vl"t ' f k•Vdtion • ~ 

Elevo.bon AJgorithrn 

r Unrfotm 
' 14670 Elevo.bon l 

r. lnterpolote 

r U~eOTM points 
Elevcbon2 

Ok Cancel 

------·----------' 

Use the Levee Express Editor to adjust the levee placement to better 
match the wall. Save the FL0-2D Files . Use the Levee Express Editor 
to finalize the levee placement. 

1851 Lesson 10 



FL0-2D Model Lessons 

Step 6: Import a levee from a polyline. 

The GDS can create a levee from a 3-D polyline. The polyline is repre
sented by a set of data points that represent the x- andy-coordinate and 
crest elevation of the levee. These files can be set up manually or with a 
GIS tool that captures the point elevation data from LiDAR data. The 
format is x y z and can be space or comma delimited. The following fig
ure shows an example of two data files . The top figure contains two pol
ylines with the end points and elevation data. The bottom file is a pol
yline with numerous vertices. 

The GDS uses the point data and elevation to create a levee with an in
terpolated crest elevation for each grid element boundary. GDS also 
takes into account the position of the crest elevation points within the 
grid element so that the levee placement will align with the actual em
bankment feature. 

LeveePotyGoat.xyz levee Poilts.xyz x 

~ ·.. .. ru 
9 ! I ! ! I I 1,0, ! I I I I I I "2,0, I I I I I I I 3,0, I ! I 4.0 t 1 t ! 1 1 1 S,O. 1 1 t j 1 1 t 6,0, 1 1 1 j 1 t ?JJ 

1 J63:9o, :lesg:s, sooo 
4 369~ .. :.11!!5010,5050 
3 
4 363190, :. .. ~152:5, 5000 
s 369~"7:,::~S3:0,SOSO 

I ! . . o 
366'720.90 
366"'1'7:. 03 
JE6e2:.9 o 
366!"7: . 21: 
366922. :s 
3669"1 0 . 15 
36 "1 02:.62 
3611)"72 .53 
367:2:..:1 

:.1 !!5:>4!..!7 11'725 
: 1 :!:5050 .50 •1725 
l:!SO'I -!.e:.7 '1725 
::&.!S:H!.!1 '1 1' 2i.S 
::!50'1~. ! 1 172'l.5 
:.1!!50'1 7 .31 ·P2'1 . S 
::eso49.62 47H 
::.!!5;)4 <j,6 2 'i724 
: : es:>so .so 4"~:2'i 

36 1:"~'3.53 : l !SJS:.2s '1123.5 
367222.12 ::es:He.!! 1 4'l2J.s 
3672E0.09 :l~so9:.s o 472J.s 
367320.:~ :.::!5099.'"15 41'23 
Jen;o . : : :les:o:. 3: 4'723 
3614 19.56 11 :!5099.'75 41;1:3 
36"74 '7 0.~3 : le5l '1 S . 3 1 '1 "7Z2 • .s 
367522 . ~~ :"-!!S'-i!!.J< •nn . .s 

lO 

·----·----' 

I 
.·.~ 

40 S.Q •o 70 

Click File/Import Levee and import the text file LeveePolyGoat.xyz . The 
GDS will automatically assign a levee to the grid element boundaries. 
Save the FL0-2D Data files . 

186 1 Workshop Lessons 



• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

Open .TOP Project •.• 

Open Exlltng FLQ-20 Pro)OCL • 

Save .TOP Project . 

Save FL0-20 Fles-
R.un R.0-20_. 

Run Napper 
RUn PROFILES 
Run RAIN 

a-eate R'llnDAT and CadPl5.DAT 

Impo<t Image 

Impo<t Elevation Pools 
lmpo<t Shape Fie • • 

lmpo<t Ral Ardnfo ASCII Gril Fie .• 

Impo<t HEC-RAS O>ilnrels. .. 
lmpo<t CN) Gr.lpl-0:: Elements... 

Save Ei!vatfon Ponts. .• 

Export. . 

Ext 

• R.0·2D • Exam~ Projects • lesson 10 • Test 

Orgar1ze • --

FL0-2D Model Lessons 

2!.1 
• ' lr-se_a_rd1_T_est __ _ 

g . ~ 

FL0-20 v2o~_Na_me_· ___ ___ _ _ __,_! Date __ "'o_dllled _ _ '-I1Y.:.:pe _ __ 
1 

Ubranes 

Dccurnents 

FL0-20 

• Mu.t: 

• Pictures 

II 1/kJeos 

•.'!. Homegroup 

·&. Computer 

HP{C:) 

» levee Point3. xyz 3/22/20119:18AM XYZFie 

[l l• ,,. 'J: t•~•l 'i ' I l 1 \' 1 r •I). 

~ FACTORY _II' ..=J < __j .!.] 

Ft1 e name: jLeveePolyGoat.xyz ::J jLevee Files (•.xyzl :::J 
Open ... J Cancel I 

H. 

Repeat the procedure for the Levee Points.xyz file . 

This levee assignment method does not take into account other FL0-2D 
components . The levee will cross street elements, channel elements and 
buildings and therefore must be edited for those features . The following 
image show imported levees that were edited for the street. 

• -i-r ·ri -±+- ··+ · --:·· !+ -H- -H- t ++- -:. . ... -H-

............ --! -'-
+t-- If, i:_ - f:t_ -:.t - ··t- .,-L 

-~ r' r· -- +f+t-+ · ' ·+· 
-- , ·- rn: 

H-

tH · -1-H-- ·· 

1-H+- + ;
rt++ 
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Review Questions 

1. List five features that can be modeled with the levee component. 

2. True or False? A levee can share a grid element with a street or channel? 

3. True or False? A levee can cross a street or channel? 

4. The message "Levee crest elevation is lower than adjacent grid element elevation" ap
pears. Describe how to fix this condition? 

5. True or False? Flow overtopping levee is calculated using the weir equation? 

6. Which output file reports if a levee was overtopped? ____________ _ 

7. Name five different methods to input or edit levees. 

8. Explain the output data in the LEVEEDEFICIT.OUT file. (Hint: see Data Input Manual) 

9. Levee help documentation is found in which locations? Check all that apply. 

0 
0 
0 

License Documentation 

Data Input Manual 

Reference Manual 
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LESSON 11- STREETS AND BUILDINGS 

Overview 

Required Data 

File Content 
6 *.DAT files FL0-2D data files 
Buildings.shp Building shape file 
Streets.shp Streets shape file 
Honolulu.jpg Image file 

This lesson outlines the procedure for creating and editing streets and 
buildings in the GDS. It shows the user how to create steets with a pol
yline and how to define intersections. The automatic computation of 
arf/wrf factors using building polygons is also covered . 

The FL0-20 grid system files are needed for this lesson . 

Location* 
\Example Projects \Lesson 11 
\Example Projects\Lesson 11 
\Example Projects\Lesson 11 
\Example Projects\Lesson 11 

*Typically these folders are in installed under C:\Users\Public\Documents\FL0-2D Basic Documentation 

Step-by-Step Procedure 

To create streets and buildings using the GDS, follow these steps: 

• Open the GDS program and load Lesson 11 ; 
• Load aerial image; 
• Load shape files; 
• Edit layer properties; 
• Review street data; 
• Build and edit streets; 
• Compute buildings from shape file; 
• Review building data; 
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• Save and run. 

Step 1: Open the Grid Developer System and load Lesson 11 
***NOTE*** Using an Explorer window, make a new folder in the Les
son ll folder named "TEST". Copy all the lesson ll files to this folder 
and perform the lesson in the TEST folder. ***NOTE*** 

Double click the GDS Basic icon from the desktop. 

From the GDS File menu click Open Existing FL0-2D Project ... 

New Project 

Open . TOP Project .. . 

Save .TOP ProJect ... 

Save Flo-20 ~es ... 

Locate the folder Lesson 11/TEST and select the FPLAIN.DAT file . 
Click Open to load the project. 

{; St•hl d IPIAIN.l>Al fie to open : ' ~ 

J ~ Fl0·2D ~ E>ample ProjeCt> ~ Lesson II ~ Te>t ~ en, Jr:se-arc-:-h.,-Te<t-,-----,.. 

Orgar&Ze ,. Ne\V fctier 

FL0-20 v20~----".Na:::::me.::.._· ________ .LJ Dat:..::.=..:e rr;.;.:rodll.::.._led.:.:. _ __._J TvPe...:..c.::_ ___ 
1 

Ubrane. 

Documentsj FL0 -20 

• Mr&: 

· Prtures 

VIdeos 

·~ Homegroup 

' Computer 

HP (c:) 

C •1'!/', ', (\fl 'I •' 11 • l"l 1111 t 

, FACTORY_IJo~~'L--;:::::========::;-;===~-----,_!j 
File name: JFPLAIN.DAT ::J J(FPLAIN.DAn ::J 

I Open •I Cancel I 

Step 2: Importing aerial images 
To import a background aerial photo use Import Image/Individual Im
age ... in the File menu. 
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New Project 

Open .TOP Project. .• 

Open ExiSblg FL0.2D Project. .. 

save .TOP PrOject. •• 

Save FLo-20 Fees. .. 
Run A.0·20 ... 

Run Mapper 
RUn PROFilES 

Run RAIN 

Oeate FI'IWl.DAT ar<l cadPTS.DAT 
Create LfVEECRESTS.DAT 

Import Elevaoon Pot1ts G<oop d Images. .. 

Import Shape Fie... l 
I rmnn.t Ran Art:Jnfo ASCII Goo FJe_ 
~-. -~ ~"'-~.......,..,... 

The image for this example project is located in the subdirectory 
C: \ProgramFiles \FL0-2D\Example Projects\Lesson 11 . Images can be 
selected one by one or several at a time using the Shift-click or Ctrl-click 
on the files . 

..) j , • FL0-20 • Example Projects • Lesson 11 • Test 

Favortes 

Desktop 

Fl0·2D 

Pro)€ct> 

FL0 -20 v2Q 

Ubrar1e'5 

Documents 

FLO·ZD 

"' Must 
~ Ptlures 

Vldeo> 

,.). Hnmf"''lrrM Jn ...:J 
File name: jHonolulu.jpg 

Step 3: Importing shape files 

::::J !standard image fonnats ~ 

Open .,..I Cancel J 

Q. 

To import the building and street shape files use Import Shape File ... m 
the File menu . 

Nei'I Pro)ect 

Open .TOP Project. •• 

Open ExiSb1g FLO·ZD Project. .• 

save .TOP Project. .. 

save FL0 ·2D Fles.. . 
Run FLO·ZD ... 

Run Mapper 

Run PROfll£5 

Run RAIN 

Create Fl\ln.DAT and cadPJ>.DAT 

~~~-~OAT -·· 
Import Image 

Import B!Ya!Dn-

Import Ran- ASCII Gr<l Fle •.. 

Import HEC-RAS Olannels. .. •-
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The shape files for this example project are located in the subdirectory 
C:\ProgramFiles \FL0-2D\Example Projects \Lesson 11. Shape files must 
be loaded one at a time. Click OK to load the shape files . 

~~~ .. V<' t ik· Cok>ur and vc:we Selectiofl 

~IJIIIII!II!IIII!I!IIIJID·······~;-] Shape Fil e Nome. ~ Bulldmg s shp 

\ JJ y FlO·ZD y Example Pro)eds Y Lesson 11 • Test 

Numeric Field :::J OrgarCze ... New f~ 

FL0 ·2Dv20~ D 
l..lbrarles 

:u2~ents j 
J Must: 

.... Pk:ture-s 

II VIdeo<; 

•-?. HOmegroup 

L Computer 

strerts.shp 

Hint: The numeric field establishes 
the color scheme of the plot. 

Mox..Vtl!ue 16345 

Mm Value 1 

Number of Colors j10 

jESRI Shapefiies {".shpJ i] 
Open -..1 Cancel J 

,+ 

II 0 JO (,rid Devek)per ,. 

Shape fle has no numert: fieij . No cob< renderilg wl be appled 

OK 

~h.Jtx' I k Cok>ur .and Value Selecdon 
Shope Frle Nome 

Numenc Freid 

Mox.Vo.lue 

Mm Value 

Number of Colors 

QK tancel 

The grid system and and imported files are shown in the following im
age. 
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Step 4: Edit layer properties 

Click View/Layers List ... 

-AI 

Zoom OUt 10% 
Pan 

Grd 8P!ment Numbe"s 
Grd8ementErv_, Vai.Jes 
GOO Element ManfW'lg'S n-vat.oes 
Gtd 8ement CUrve Numbers 

The arrow buttons l!f ~ are used to position the layers. Highlight a 
layer to move it up or down in the list. This determines the layer's hei
rachy . 

BUILOINGS.SHP 
Honolulu.jpg 

~ f ~SibieJ r Q.elete 

Make the Honolulujpg and Buildings.shp layers invisible by deselecting 
the Visible check box for each and click Apply. Double click the 
Streets.shp layer to access the Symbol properties dialog box. Select the 
Std. Labels tab and click Apply . 

Layer n~e ~STREETS SHP 

Shepe Frle Type ~ne 

Number of Records ffi474 

The Slondotd labels dosslflcetlon drews.teld: tore speafled field 

Smgle J Un1que _l Ot~sses ) :Std laberifJ Advlebel 

Tm lield 

j/NAME 3 J P" Drew teetures 
r AIID"fduphcotes 

onzont~ 1gnme 
P" Sphnedtex'l jeenter 3 r Alp 

\lertlc:al alignment 

jCenter 3 
Rotebon 0 Fom 

jMS SensSeri1 ~ .ill ~ 

XOflsetfield YOffsetfield 

I 3 I 3 

~ ~ 
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Step 5: Review street data 

Position the mouse over any street intersection and click the left mouse 
button . The following image show the intersection of Kuhio and Sea
side. 

Edrt: Street Parameters 

Modfy Street 
Delete Street 
Reafgn Street 

Click the Edit Street Parmeters option. The dialog box shows the 
global variables for the street segment. A curb height, n-value and 
elevation can be assigned for each street element and that value 
superceeds the global value. 

Street intersections are defmed using the Flow direction from center 
and width editor. When you click on an intersection, that location 
is loaded in the dialog box. Click Cancel to exit the window. 

Street global pe.re.meters 

Globe/n-vclue fmstreetftow ~ 

GlobolstreetWidth ~ 

Mex~mum s1Jeet Froude number~ 

Global Clltb herghl ~ 

r lntlow hydrogre.ph Will enter street mstead offloodplorn element 

Street loco/ porometers 

Street name Kuhio 

Numberofelements p---
rn street ~ 

~ Element Curb heraht n-vclue Elew~on 

11 3452 0 
Aow diredlon from center of element ond .stteet W'ldth 18 3529 0 0 
r Northwest r North r Nonheost 19 3601 0 0 

20 3685 0 0 
21 3164 0 0 

P" West P" East 
22 384< 0 0 

ro- ro- 23 3925 0 0 
24 4001 0 0 
25 4089 0 0 

r Southwest r SoUth P" Southeast 26 "1172 0 0 

0 1~~ ~ 
0 
0 LJ 0 

m~: 
: ~~ 

lo . Remember to odd the stJeettlowdrred.Jons bvdleckma the direc:tJon boxes to the left 

II' the street width is assigned zerovolue the global 
stteet 'Width is used os o detaun 
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Step 6: Create street segments 

I I I 

Click Tools/Create Street Segment with a Polyline . 

L Ex 

Fbati)Q v ... ~ Express Edlor 

Cr~e OlanneiSegmert v.ti1 a Polytle 
create a Ooss 5ectbl 
Assign a HEC-RAS cross SedDn to a Olannel Element 
AUto As>lgn HEC-MS Cross Sedilns to Olannel Elements 
COnvert HEC-MSXsec to R.Q-20 

COnvert HEC-RAS Olannet; to R.Q-20 Channel Segments 

Delete HEC RAS Olannet; 

Delete HEC RAS cross SectDns 

cr~e street Segment 

create Lev.e Segment- a Polytle 

Create a street segment for Lewers, Liliuokalani and Uluniu streets . 
Break the streets into segments at the side streets. Identify each 
street with a name such as LewersSeaSide, LewersMiddle and Lew
ersCitySide. The following image shows the 3 street segments that 
represent Lewers . These segments are raw data with no intersec
tions 

=L ~ ~ --1+\--l--+-+-+ --1!--+--:'>f.rt-1---1 
I I 
I 

-~-~-r-

' I r --- 1 --1- '-

~l tr_-

+ 
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~~0 

~~ \Ytz 
..,__ 

Edit the street data by clicking the seaside Lewers segment and click
ing Edit Street Parameters . Enter a Street name. Highlight the last 
grid element and select the North flow direction to define the inter
section. 

r Street global p01ometers 

Global n-volueforstreetflow ~ 

Giebel street Width· ro--
MCXJmum street Froude number~ 

Global curb herght ~ 

r Inflow hydrogroph Will enter street Instead otlloodplain element 

f Street loceJ perameters I S~eetnome I Lewers SeaSide 

Flow dtrecfion from center of element and street Width· 

r Northwest I Fo !:§i] I r Northeast 

!West 

P" Southwest I South 

lo 

I Eost 

I Southeast 

It the streetwtdth ts osstgned zero value the globcl 
street Width IS used as a default 

II 0 )f) Grid ~OOper ' 

Woukt you W<e to vakjate the street varBt:Aes now? 

Remember to add the streetfla Yes No 

QK !;oncel 

Click OK and Yes to validate the table. 

Finish the intersection by clicking on the Kalakaua street segment 
and clicking Edit Segment Parameters . Select the south flow directon 
and enter a value of 20ft. Click OK and Yes to validate the table. 
Repeat this process for the next two segments. 

Flow dnedlon ffom center of element end street wtdth: 

r Northwest 17 North r Norlheosl 

~ 

I West r Eost 

-- / P" Southeast _,, 

)~ 
·9--t:::J 

I Southwest I f7 South I 
~ jo 
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Warning: Water will not flow freely 
down streets with high elevation 
spikes. 

FL0-2D Model Lessons 

To see an elevation profile ofthe street click Tools/Street Profile . 

Cr ..... street segment 
Create street segment wtf1 a P<llyt1e 

Create Lev«! segment wtfla P<llyt1e 
Create Det..-. llast1 
Mud and Sedinent Tr.>"lSpO!t 

Evaporatbn 

M00FLo-2o Smoomn 
"''d""-*' structures 
Rat1 

Breach 
NOflOCS 
ffldWatershed 

Create Fbodpi!Ol Cross Sectbns 

Levee~ 

, ~ r 1 'flo ' 

--- - ~ ------ ~-- ----- --- -

Click the LewersSeaSide street segment. 

6 . :. 

6 . 0 

§ S . 5 

~ 

; 
~ s.o 
;.,..:; 

S t raa t C.ra•t •nd Gr ound !:lav .a t i o :u 

2 0 so 7 5 100 1 25 150 175 200 225 

Apr o }C ir.\.a. ta St ree t Di ;; e.anca ( ! t ) 

g, " .. "l @:ound 

S~ree t .!n d Qr o•.J nd ele v a tion!! are th'l! .s &r.'.e un le.s.s u .ser specified street !! l ev ation~ 

The street elevation is determined by the grid element elevation 
unless an elevation is assigned to each street element. Two meth
ods are used to edit a street elevation: 

1. Edit the floodplain element elevation 

2. Enter a street element elevation 

The elevation data used for Waikiki in this project was inadequate 
representation of the ground data. The street profile does not 
reflect the actual street elevations but an average value can be met 
by comparing the grid element elevations surrounding the streets 
and intersections . 
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5.34 

6.32 6.5~ 

5.53 6 .02 

Click View/Grid Element Elevation Values 

. Zoom Ot.t Prewlus vtew 

ZoomOLt10% 
Pan 

l.ayer>U5t. •• 

DTM P<rt ElevatDos Rendemg ... 

Tradt Elevaoon Poots 

GrrlEielrentNumbers 

GrrlEielrentManrw1g'sn·Vilkles 
Goo Element curve Numbers 

Grrl ... 
Components 

U::~./".Bw.,....all>..:.rn,.._., - ..,.__.,.._,_....__-"'"\v.A-"-./"'-· -

The grid elements underlined in red have an elevation that is high
er than the mean. These elevations can be manually adjusted to 
more closely represent an actual elevation condition. 

Editing the elevations corresponding to the streets will also make 
the street profile more realistic. 

5.64 5.6 

r 

I , ~/,~ ' ~ 
-1--I r-

5.89 1 5.79 

5.85 5.83 5.80 

I 

5.04 ~ ~M 
- r 

I 
I 

I 
I 

I 
1----

5.10 

r 

I 
7.17 

- ----- -- -r·-
1 I 

I 
J ·--
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I 5.Jt 
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Click the Select Element by Element button ~. Select all the grid 
elements whose elevation can be lowered 0.5 ft. Click Grid/Assign 
Parameters to Selection/Elevations . 

Create GOO 

Select 

Green-Ampt Parameters 

Compute scs CUrve Number 
COmpute Wt!th and Area Reduction Factoo 
COmpute l.lmlrlg Froode Numb<= .. 

Deil1e Boondaly Qtj Elements 

s.tup COmputatDnal Nea 

create GOO 1..ayer 

.I 
Man'*'Q Coef!Dents 
Area and Wt!th Reductnn Factoo 
Levee 

• M~Olanne!s 
In1bw/~·• CoodiDn 

In1tratx>o 
No Discharge Exchange 
lme.Yanant Groundwater Head 
RJgt1 Bed Element 

• l.lmlrlg Froude Number 

Enter the value -0.50 in the Assign Elevation dialog box and select 
the Add to Existing Elevation check box . 

5.&t 

5.83 

Roodplain elevation 1-o.s 
~set) 

P' \A.dd to Existin Elevatio~ 

Qencel 

5.% 

5-H 

5.9t 

5.83 

5.77 

1----
5.~ 

Perform this proceedure for the entire Lewers Street as well as the 
Liliuokalani and Uluniu streets to be built. Keep in mind that the 
overall objective is to make a realistic street profile by making 
small adjustments to the elevation data that better represent the ac
tual elevation along the streets . 

Save the project by clicking File/Save FL0-2D Files ... 
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Step 7: Compute building data from shape file 

Click View/Layers List. Select the buildings layer and check the Vis
ible check box. Select the Streets shape fi le and uncheck the Visible 
check box. Click Apply and OK. 

STREETS.SHP 

Honolulu.jpg 

~ ~ P" ' "'bl r Qelete 

Click Grid/Compute Width and Area Reduction Factors . 

Create Grti 

Sd!ct 
Assign Parameters to Setectbn 

Interpclate EleiatDn Pof1ts 
Interpolate from ~ Elevat>oo Fies. .. 

Green-Ampt Parameters 

Comptn Mannng COeffldents. .. 
Comptn scs curve Number 

Compute Unlng Froude Numbers. .. 

Define Boundary Grd Element> 

S<tlJp eomputltDnal Area 

create Grd Lilyof 

Use the default setting with no correction factors and click OK and 
OK to select the Buildings shape file. 

Note: If a correction factor were 
used, each ARF or WRF value 
computed would be mulitplied by 
the correction factor. For exam
ple, if a correction factor of0.20 
was selected the ARF or WRF 
value would be reduced by 20 
percent. 

( orr('(110n ractors 

ARF Calculobon 

I ARF conectlon ledOi ln rMge 

~FCclculehon 

(i No conection lector for 'NRF 

(" VYRF correc:tJon lector m range 

OK Ce.ncel 
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Reduchon Faders 
sh epe lile. 

I BUILDINGS.SHP 

Redudlon Faders '"liiilliiiilliiiilliiiilliiiilliiiilliiiEJ 
field I• 
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Create Gn1 

In~ Elevati>n I'Oilt:s 
inll!rpa&lte from......,.. Elevatnn Fles. .. 

Green·A.mpt Paral'l'lE'm"s 

COmpth Mannilg coetllderts. .. 
CDmpth SCS Qlrve Number 

FL0-2D Model Lessons 

If it can be avoided, grid elements should not share components. It 
is advised to remove ARF and WRF components from street ele
ments . 

Select the elements along the streets that share an ARF/WRF com
ponent. 

Click Grid/Assign Parameters to Selection/Area and Width Reduc
tion/Factors . To remove the reduction factors from the selected 
grid elements, click the OK button with all values = 0. 0 . 

.I 

An ·.t .uut Width Redurtion Factors 

r !COmpletely Blocked Gr1d Element 

Areo Reduction Fodor (ARF) 
(70% surfoce areo.loss AAF· 0 7) 

Wn:tth reduct•on lo.dor (YvRF) 

comp<M Wltth and Area Reducoon Factors 
com,x.te LmtJng Froude Number> .•• 

No Discharge Exchange 
nne-vamntGrou- Head 
~Bed-

SE 

Deline IIO<Jndary GrrJ Elements • IJmbng FrOlde Number 

SEI>Jp Gomputltilnal Area 
QK ,C:oncel 

creat< GrrJ Layer 

Apply the same technique for the outflow nodes . 
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Step 8: Review and validate building data 

The GDS computes the building data based on the colocation of 
the building polygon and the grid element. For example, if a grid 
element is covered by 50 percent of a polygon, the ARF value will 
be 50 Percent. 

Floodploin elevation ffeet~ !P.93 

Moming coefficient !o.065 
LinlngFroodenurrt>er r.:-loo::----

Elerrent sizeffeetl 
OeHa X: jloo 
De~oY: lr,-:100;;----

~on Facl:or3 .. I Muliple Channel. 

.Levee... I --'-'-" -' ' _ ___, 
lnrdtration__j r ' I '! "\ f I 

·~e co ~ 

MODFL0·20... I 
QK J;;ancel 
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RPdU(tlon Factors (Element 2398} 

Elerrent Nurrber: j2398 

r [C Jete! Blocked Grid Element 

Area A e<Lction Factor IAR Fl 
(70%. suface afea lou ARF= 0 71 

Width reci>ction factor (WAF) 

N NE 

ID.933ro:ss-3 
[0:783 E 

[0:96"3 
SE 

l!K ,Cancel 
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Review Questions 

1. List five attributes of the street data . 

2. True or False? A street segment name can contain spaces? 

3. True or False? A street segment can cross a levee? 

4. Describe how to delete a street segment? 

5. True or False? Streets are represented as rectangular channels? 

6. Can a street and a channel share a grid element? _____________ _ 

7. Name three types of roadways that would NOT be modeled with a street component and 
explain why . 

8. Explain how to view and edit street profile elevation. (Hint: see Data Input Manual) 

9. Can two street segments share a grid element? _____________ _ 
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